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GFL-002
Warnings, Cautions, and Notes

as Used in this Publication

Warning

Warning noticesare used in thispublication to emphasize that hazar dous
voltages, currents, temperatures, or other conditionsthat could cause
personal injury exist in thisequipment or may be associated with itsuse.

In situations wher e inattention could cause either personal injury or
damage to equipment, a War ning notice isused.

Caution
Caution notices ar e used wher e equipment might be damaged if careisnot
taken.
Note: Notes merely call attention to information that is especially significant to

understanding and operating the equi pment.

This document is based on information available at the time of its publication. While efforts have
been made to be accurate, the information contained herein does not purport to cover al details or
variationsin hardware or software, nor to provide for every possible contingency in connection
with installation, operation, or maintenance. Features may be described herein which are not
present in al hardware and software systems. GE Fanuc Automation assumes no obligation of
notice to holders of this document with respect to changes subsequently made.

GE Fanuc Automation makes no representation or warranty, expressed, implied, or statutory with

respect to, and assumes no responsibility for the accuracy, completeness, sufficiency, or usefulness of
the information contained herein. No warranties of merchantability or fitness for purpose shall apply.
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Preface

Thismanua describes the features that are used to program Series 90™-30, Series 90-70,
VersaMax™, VersaMax Nano/Micro, and Series 90 Micro PLCs using the VersaPro™ programming
software, Version 2.00.

Revisions to This Manual

Thismanua and the product online help have been updated to reflect the new features provided by
Version 2.00. New features include:

Support for Series 90-70 PLCs, including Genius redundancy and CPU redundancy over Genius.
(Refer to the Important Product Information document, GFK-1671K or later, for acomplete list of
features supported.)

Support for additional VersaMax 1/0 modules and Series 90-30 power supply modules. (Refer to
GFK-1671K or later for aligt.)

Usability enhancements:

- SNF/VCD Import able to swap variable names

- Multiple instances of VersaPro on the same computer simultaneously communicating to PLCs.
- Minimum supported Firmware Revisions / Unsupported CPU mode's
- Warn if Storeto PLC with LM90 folder

- Block Locking/Unlocking (other than via an import or 1oad)

- Online Use Tables

- Print Header / Footer

- Auto-backup

- Find local scope variables

- Size of block reported to the Information Window

- %R upper limit change

- Serial number provided in Help About box

- Sitelicensing
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Related Information

Manuals

GFK-1645 VersaMax™ Micro PLCs User’s Manual
GFK-1504 VersaMax™ Modules, Power Supplies and Carriers
GFK-1503 VersaMax™ PLC User's Manual

GFK-1873 VersaMax™ Station Manager Manual

GFK-1411 Series 90™-30 System Manual

GFK-1065 Series 90™-30 Micro PLC User’s Manual

GFK-0356 Series 90™-30 Programmable Controller I nstallation Manual

GFK-1742 Motion Mate™ DSM 314 for Series 90™-30 PLCs User’s Manual
GFK-1192 Series 90™-70 System Manual

GFK-1527 Series 90™-70 Enhanced Hot Standby CPU Redundancy User's Guide
GFK-0827 Series 90™-70 Hot Standby CPU Redundancy User's Guide

GFK-0646 C Programmer's Toolkit for the Series 90™ PLCs User's Manual
GFK-1541 TCP/IP Ethernet Communications for the Series90™ PLC User’s Manual
GFK-0582 Series 90 PLC Serial Communications User's Manual

Other

GE Fanuc http://www.gefanuc.com

GE Fanuc PLC Hotline Fax on Demand System (FaxLink) 804-978-5824
GE Fanuc PLC Hotline Telephone Number 1-800-GE Fanuc (1-800-433-2682)
International Customers direct dial: 804-978-6036
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| ntroduction

Welcometo VersaPro

Welcome to VersaPro™, GE Fanuc's Windows®-based programming software for the
Series 90™-70, Series 90-30 and VersaMax™ PLCs. VersaPro isdesigned to install and
run under Windows 95, Windows 98, and Windows NT® 4.0, and Windows 2000.

With VersaPro, you can:

Create PLC logic and information associated with that logic in afolder
Configure PLC Hardware

Create and edit variables

Creste, edit, and monitor the execution of Ladder or Instruction List logic

Create Motion, Local Logic, and Cam programs for the 90-30 DSM314 Motion
module

Chapter Contents
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Overview of the VersaPro Programming Software components

The Workbench Window

Configuring Workbench Options (setting editor and target hardware)
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Installing VersaPro Software

o &~ 0w D

Note: VersaPro mugt beinstalled on ahard drive in your computer. Do not
attempt to ingtall VersaPro on removable media such as Jaz® or Zip®
drives.

It is recommended that you close all applications including virus checking, Internet
Explorer, and CIMPLICITY HMI software that might be running in the background.
Y ou may need to check the task manager to determine if other applicationsare
running.

Put the VersaPro CD in the CD-ROM Drive.
Select the CD drive from Windows Explorer.
Double click Setup.exe

Follow the user promptsto complete theinstallation. |f you have a previous version
of VersaPro installed, theingtallation tool will first uningtall the previous version.
During this uninstall process, you may be asked whether you would like remove
shared files. It isrecommended that you always answer “No to All” to ensure that no
files are deleted that might be needed by another application.

Note: When you upgrade from previous versions to VersaPro 2.00, your user
screen settings and the directory location for program fileswill be lost.
You will need to re-establish these settings after completing the

upgrade.

Note: For procedures to transfer your VersaPro license to another computer,
refer to Appendix C.

Note: If you are installing on a computer with the Windows NT operating

system, you must be logged in with administrator privileges. If you do
not have administrator privileges, VersaPro will not install properly.
Contact your company | ST department for assistance if thisisthe
case.

Starting VersaPro Software

1-2

The VersaPro application isinstalled in the GE Fanuc Software Program group. The
application can be started by selecting Start->Programs->GE Fanuc Software->VersaPro.
Itisaso possible to create a shortcut to the VersaPro application and place the shortcut on
the desktop, or to click on afile created by VersaPro (thefilein the VersaPro folder with a
fld extension), and start the application in the context of the selected folder. VersaPro
may a so be started using CTRL-ALT-V.
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Multiple Instances of VersaPro

Four VersaPro sessions or instances of VersaPro are supported.

If you are using a seria connection, two instances of VersaPro can be connected to

the PLC. Each connection would use a unique communication port on your PC. For
example, one connection would use COM 1 while the other would use COM2. With
two sessions connected you can have two additional sessions offline or not connected.

If you are connecting to the PLC via Ethernet, you can have four instances of

VersaPro. VersaPro supports only one Ethernet adapter in your PC but allows up to
four connections viathis adapter.

Using VersaPro — Overview

Folder Browser

Hardware
Configuration

Logic Editors

Motion Editors

Syntax Checking

PLC
Communications

Online
Monitoring

Fault System

Information
Window

VersaPro provides a single programming interface to configure your PLC hardware, create
and edit PLC logic, and monitor the execution of the PLC program.

Component Description
al

Displays atree-like structure that provides an overview of the current folder

VersaPro's default hardware platformisthe VersaMax PLC. You can
change the hardware platform to create programs and hardware
configuration for Series 90-70, Series 90-30, VersaMax, VersaMax
Nano/Micro, and Series 90 Micro PLCs.

There aretwo editorsfor creating PLC logic: the Instruction List editor and
the Relay Ladder Diagram (RLD) editor. Y ou can convert programs and
blocks from IL to RLD.

A Motion editor and aLocal Logic editor are provided for creating Local
Logic and Mation programs for the Motion Mate DSM 314 mation control
module. A Cam editor is provided for creating cam profiles. If the Cam
editor isingdled, it can be used with DSM 314 rdease 2.0 or | ater.

VersaPro provides atool to check that your program is syntacticaly valid
before storing to the PLC.

VersaPro supports serial and Ethernet connections to the Series 90-70, Series
90-30, and VersaMax PLCs.

Online monitoring and control is supported in logic editors, and Reference
View Tables, and Variable View Tables.

The fault system provides the ability to view PLC and I/O fault tablesin the
PLC.

The Information Window displays the results of actions performed in
VersaPro.

GFK-1670D
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The following abbreviations are used in VersaPro:

Abbreviation Component Abbreviation Component

IL Instruction List VVT Variable View Table

RLD Relay Ladder Diagram LL Local Logic

RVT Reference View Table LLVT Local Logic Variable Table
VDT Variable Declaration Table
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The Workbench Window

When you first start VersaPro, the workbench is displayed. Y ou can perform the following
tasks from the workbench:

Create and Open Folders
Backup and Restore VersaPro folders

Customize Workbench Options

Setting Workbench Options

GFK-1670D

Setup communications parameters, Connect to the PLC and view Fault Tables

VersaPro allows you to customize editor and window options. It isimportant to confirm

the default language and hardware configuration before creating anew folder. Other
options may be customized before opening afolder, or after the folder is opened.

General Options

VersaPro's default hardware configuration isthe VersaMax PLC. The default block

language is Ladder Diagram. To changethe default configuration so that you can create
programs and hardware configuration for the target devices, or to customize display and
editing options, select the Tools menu and choose Options.

General |Disp|ay| Ladderl CDmmunicatiDnsl kP SLL Editursl

Default Block Language

Default Hardware Configuration

Ladder - IVersaMax j
—Rung/Row Comments———— — Syntax Checlk
& i
Brief Comments [T Turn off wamings
¢ Full Comments
1 Enable SNF Auto-Export
Filenarme: File Lock Tirmeout:
=
| Use Falder Hame
MNumber of undoable modifications per window: I1 I
¥ Enable auto backup with a limit of |3 files.
oK I Cancel | Help

Chapter 1 Introduction
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Setting Block Language: The default language is Ladder Diagram. To change
the default block language to Ingruction List, select the General tab. Click the
Default Block Language and select Instruction List

Changing Har dwar e Configuration default: VersaPro's default hardware
platform isthe VersaMax PLC. Y ou can create programs and hardware
configuration for Series 90-70, Series 90-30, VersaMax, VersaMax Nano/Micro,
and Series 90 Micro PLCs. To change the default hardware configuration, select
the General tab and set the Default Hardware Configuration field.

Setting Full or Brief comments: IntheLD and IL Editors, comments can be
configured to be viewed in full or brief mode. The default isto view comments
in brief mode. To change the default, select the General Tab and check the Full
Comments button.

Setting Syntax Check (Turn off Warnings): By default, when VersaPro
performs syntax checking on logic, multiple coil usage warnings are displayed
in the information window. To suppress the warnings, select the General tab and
check the Turn Off Warnings box.

Enable SNF Auto-Export: Thisoption causes variables to be automatically
exported in SNF format when you create or edit variables and then save the
VDT. Only variablesin the VDT with the EXT checkbox selected will be auto-
exported. The .snf file will be exported to the current folder; any existing .snf
file with the same name will be overwritten.

Filename: If Use Folder Name isnot selected, afilenameisrequired. Thisname
follows the same naming rules as VersaPro folder names.

Use Folder Name (default): If this box is checked, the exported filename will
be foldername.snf.

FileLock Timeout: A *.Ick (lock) fileis generated at the sametime asthe *.anf
file. The*.Ick file isused to prevent reading or writing of the *.snf file whileit
isin use. VersaPro will attempt to access the *.Ick file for the number of seconds
specified in thisfidd. Valid values are from 1 to 60 seconds.

Setting the number of undoable actions. VersaPro allows you to configure the
number of undo/redo operations available during editing sessions. The default
number is 10. Thevalid rangeis 1 to 100.

Setting Auto Backup options: If Auto Backup isenabled, VersaPro
automatically creates a backup copy (*.flb) of afolder when it isbeing saved.
Y ou can specify the number of backup files, from 1 to 100, that will be kept
(default is 3). Auto Backup isenabled by default.

VersaPro™ Programming Software User's Guide — November 2004 GFK-1670D
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Setting Display Options

VersaPro allows you to set text font, size and color separately for the L, LD, Local Logic,
and Motion Editors, for the VDT, and for Variable View, Reference View, and Local
Logic Variable tables.

Perform these steps to set display options:

1. Choose Options from the Tools menu, or from the LD or IL Editor context sensitive
menu (CSM).

2. TheOptionsdialog box appears.
3. Sdlect the Display tab.

Options
General Display | Ladderl Communicaticmsl MPLL Editorsl

Category: —Colors

Backoground

Comments
Local Lagic Constants
totion Prograrm Lahels
BT - Instructions
ST =l Inputs
Eont: [MS Seri =] | [Duteuts [
see 5 [ -
Sample:

AaBbYyZz

Ok I Cancel Help

4. From the Category list, select the editor or table whaose display options you wish to
configure.

5. TheColorslist displays the items you can configure for the selected editor or table.

6. Select the color to be used for each configurable area of the selected editor or table.

Thelist of configurable areas differs based on the window whose display you are
configuring.

Note: Certain combinations of colors and backgrounds can be difficult
to read.
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7. Select the font name and font size to be used to display text in the selected editor or
table. Click OK

Note: Y ou cannot change the font used for Column and Row headings.

The selected colors are applied to selected areas of the selected editor or table. The
selected font isapplied to al text within the selected editor or table. If the selected editor
or tableisvisible, it appears with its changed colors, font and size.

Note: Selected fonts are used when you print your program.

Setting Communications Options

Y ou can configure VersaPro to connect to a particular device immediately upon startup
and to open the folder associated with that PLC.

Setting Wait Time
To specify the delay in the amount of time before a server busy call will be recognized
when you have closed and re-opened the application:

1. Choose Options from the Tools menu, or from the Editor CSM. The Options dia og
box appears.

2. Sdect the Communications tab.
3. Enter avauein the Wait Time box. Vdid rangeis 8 to 2147483646 seconds.
4. Click OK.

Configuring Autoconnect

Note: The Wait Time parameter on the Communications tab has no effect on
the operation of Autoconnect. Thelength of timethat VersaPro triesto
connect on startup is determined by the Connect Timeout parameter in
the CCU. To set Connect Timeout, go to the Tools menu, and select
Communications Setup. In the CCU, choose the Global Parameters tab.

If you want VersaPro to connect to a particular device immediately upon startup and to
open the folder associated with that PLC:

1. Choose Options from the Tools menu, or from the Editor CSM.

2. TheOptionsdialog box appears.

3. Sdect the Communications tab.
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General | Display | Ladder Communications | MP/LL Editors |

YWait Time;  |120 Seconds

—I~ Enahle Autaconnect

Device: I j
Location: I El

— PLC Firmware Revision Checking

& Mo firrmware revision checking during stare.
 “Warn during store i firmware revision is incompatible.

 Prevent store to incompatible firmware resision.

Warn and allow to quit if store will owvenarite a program stored by &
programmer other than YersaFro.

(0] | Cancel Hela

4. Click the Enable Autoconnect checkbox.

5. IntheDevicefield, select the Device to which you wish to connect automatically
upon startup.

6. IntheLocation field, enter the starting search path for the folder associated with this

PLC, or click the Browse for Folder button L= and select the location from the
Browse for Folder dialog box. This specifies the location where VersaPro will start to
search for the VersaPro folder that is stored in the PLC.

VersaPro uses the PLC Folder Nickname (PLC program name) to determine what
folder to open. By default, the Nickname isthe last seven characters of the folder
name. The Nickname may be viewed and set in the Folder Properties dialog box.
(Choose Properties from the Edit menu or the folder root node CSM..)

7. Click OK.

Note: To turn off Autoconnect, select the Communicationstab in the Options
dialog and uncheck the Enable Autoconnect button.
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Setting PLC Firmware Revision Checking

To select the level of firmware revision checking to be performed before a Store
operation:

1.

2.
3.

Choose Options from the Tools menu, or from the Editor CSM. The Options didog
box appears.

Select the Communications tab.

Choose thelevel of revision checking that you want to use:

No firmwarerevision checking during | The store process proceeds without checking.

store

Warn during storeif firmwarerevision | If the PLC' s firmware is not compatible with VersaPro, a
isincompatible warning dia og box appears when you attempt to store. You

may choose to continue the store process or cancel it.

Prevent store toincompatible firmware | (Default selection) If the PLC' sfirmwareis not compeatible

revisons with VersaPro, an error messageis displayed and the storeis
cancelled.
4. Click OK.
Note: For alist of compatible CPU firmware versions, see "PLC Firmware

Compatibility List" in the online help index or the readme.txt file
provided on the VersaPro CD_ROM.

Program Overwrite Warning

1-10

By default, if you attempt to store from VersaPro to a PLC that contains a program created
by another programmer (Logicmaster 90 or Control), awarning messageis displayed. You
may choose to continue the store process or cancdl it.

To disable (or enable) this feature:

1.

Choose Options from the Tools menu, or from the Editor CSM. The Options didog
box appears.

Select the Communications tab.

To disable the warning remove the check from the box labeled “Warn and allow to
quit if storewill overwrite a program stored by a programmer other than VersaPro.”
(To enable the warning, place a check in the box.)

Click OK.
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Setting Ladder Options

VersaPro allows you to specify the types of information displayed about LD Editor
symbols, and the width of LD Editor grid cells. Y ou can also zoom in or out in order to
proportionally enlarge or decrease the display size information in cells.

To specify the types of information displayed about LD Editor symbols:

1. Choose Options from the Tools menu, or from the LD Editor CSM. The Options

diaog box appears.
2. Select the Ladder tab.

Generall Display Ladder | Cemmunieatienel hAF L Editersl

— Sshow fhide field
Mode
Reference address = Brief
[WDescription o« Full
—Grid Cell ‘Width
Wi Mex
|

¥ Cailf Jump Justification Calumn: IW
¥ Show Bx10 Bung Indicator

DE. I Cancel Help

3. Choose whether to show or hide the variable name, reference address, and
description. Each of the checked items appearsin the LD Editor.

4. Determine whether variable names and descriptions should be displayed in part or full
by selecting Brief or Full for each.

5. Thevariable description and/or reference address display in the bottom portion of

each cell according to the current cell width. Text that exceeds the available spaceis
replaced with "..."

GFK-1670D Chapter 1 Introduction 1-11



To set LD Editor grid cell width:

VersaPro allows you to change the width of LD Editor grid cells, to make more text
visble. Only the width of the cells changes: cell height and font size remain unchanged.

1. Choose Options from the Tools menu, or from the LD Editor CSM. The Options
diaog box appears.

2. Sdect the Ladder tab.

3. Under Grid Cdl Width, drag the slider to theright to increase the grid cell size, or to
the | eft to decrease the size.

4. Click OK. ThelLD Editor grid changesto the new size.
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Setting Motion Program/Local Logic Editor Options
1. Choose Options from the Tools menu, or from the Editor CSM. The Options diaog

box appears.
2. Sdectthe MP/LL Editors Tab.
Generall Displayl Ladderl Communications MF/LL Editars |
Tabs Auto Indent
Tah Size: r " Mone
" Insert Spaces = Default
* Keep Tahs " Use Previous Line

(0] | Cancel Help

Tab Size Setsthe number of spacesthat isequad to onetab. Vaid
values areintegers 1 to 64.

Insert Spaces Converts the tabs to the number of spaces specifiedin
Tab Size.

Keep Tabs Saves thetabs as tab characters.

None No automatic indenting of code.

Default Indent code using the Tab Size. The indent is based on
the scope words.

Use PreviousLine Indents the current line the same asthe line directly
above it.

3. Sdlect thetab and auto-indent options you want.
4. Click OK.
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Synchronizing VersaPro with HWC

1-14

The VersaPro user interface displays only features that are appropriate to the current
hardware configuration (HWC). For example, if HWC containsa Series 90-30 CPU,
the Function Toolbar does not display functionsthat are used only on the 90-70.
When you change to a different CPU in hardware configuration, you will need to
synchronize VersaPro with HWC by performing one of the following operations:

Open the Block Properties/New Block Dialog
Check All or Check Block(s)

Load from PLC

Import SNF variables

Export SNF variables

Storeto PLC

Verify with PLC

Convert Block

Save Folder (Save ALL)

Connect toPLC
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Working With Folders

A folder containsall of the components required to program, configure and monitor your
Series 90-70, Series 90-30, VersaMax, VersaMax Nano/Micro, and Series 90 Micro PLCs.
The components include Hardware Configuration, Variable Declaration Table, View
Tables and program blocks. Y ou can also insert other windows-components into the
folder, like user documents and spreadsheets.

VersaPro allows you to have only one folder open at atime. However, you can have
multiple ingances of VersaPro running on your PC.

Chapter Contents

This chapter describes how to create and manage folders using the VersaPro software.
e Creating anew folder

e Creating an empty folder

e Creating afolder, based on an existing VersaPro folder

e Creating anew folder —importing logic from a Logicmaster 90 folder
e Creating a new folder —importing logic from Control

e Working with existing folders (opening, saving, closing, deleting)

e Overview of the folder browser view

e Backing up and Restoring folders

e Protecting folders

e Changing folder properties

e Inserting blocks and objects

e Printing folder logic
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Creating and Opening VersaPro Folders

Creating a New Folder

VersaPro provides several options when creating anew folder. You can create an empty
folder, or create anew folder based on an existing VersaPro folder. VersaPro also
provides an option for you to create afolder by importing content from Logicmaster 90
(Series 90-30, Series 90-70, or Series 90 Micro folders) or Control (Series 90-30, Series
90-70, or VersaMax folders).

To create a new, empty folder:

2-2

The default language for new foldersis Ladder Diagram. The default hardware
configuration is VersaMax. If you want to change the default language or target hardware
for your new folder, select the Tools menu and choose Options. Change the settingsin the
Options dialog box.

To create anew, empty folder from the VersaPro workbench:

1. Click the New Folder button , choose New Folder from the File menu, or press
Ctrl+N. The New Folder Wizard will appear.

Mew Folder Wizard

Falder Mame:

Ivm_flu:lrl

Location:
II::'\F'ru:ugram FileshGE Farnuc Autarn E.-"'l

Folder D ezcription

"YerzaPro folder for Werzabd ax
PLCz. Default langauge: LD

% Black I Meut > I Finizh LCancel |

¢ IntheFolder Namefied, type a name for the new folder. A folder nameis
required. (See "Rules for Folder Names and Nicknames' on page 2-11.)
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o If you want to save the new folder to alocation different from the default,
click on the Browse button opposite the Location field.

e Enter afolder description in the Folder Description field. Y ou may enter up
to 64 characters. Thisfield isoptional.

2. Click the Next button. The next screen of the New Folder Wizard will appear.

Mew Folder Wizard

— Chooze One

" Bazed on Existing YerzaPro Folder
" Import Logicmaster 90
" |mport Contral

|melude SHE _—
- .

Framm:

IC:'\EIMF'LIEITY\EDntruI\chan#dir_ n

¢ Back I = Finizh | LCancel

3. The Empty Folder (Default) button is automatically selected. Click Finish to create
the new, empty folder.

The Folder Browser appears, displaying the new folder. The _MAIN block will appear in
the default language' s editor.
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To create a new folder based on an existing VersaPro folder:

To create anew folder based on an existing VersaPro folder, launch VersaPro and perform
the following steps:

1. Click the New Folder button , choose New Folder from the File menu, or press
Ctrl+N. The New Folder Wizard will appear.

Mew Folder Wizard

Falder Mame:

Ivm_fldri

Location:
IE:'\F‘IDgram Files\GE Fanuc Sutam |j"|

Folder Dezcription

"ferzaPro folder for Yersabd ax
FLCsz Default langauge: LD

< Bask I Mewut » I Finish | LCancel |

¢ IntheFolder Namefied, type a name for the new folder. A folder nameis
required.

¢ If you want to save the new folder to alocation different from the defaullt,
click on the Browse button opposite the Location field.

e Enter afolder description in the Folder Description field. Y ou may enter up
to 64 characters. Thisfield isoptional.

2. Click the Next button. The next screen of the New Folder Wizard will appear.
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Mew Folder Wizard

— Chooze One

" Empty Folder [Default]

¢ B azed on Existing YersaPro Faolder

' Import Logicmaster 30

£~ |mport Control
|hElude SHE:

Frarm:

[C:tethladchand El

¢ Back I i [ Einizh | LCancel

3. Click the Based on Existing VersaPro Folder button, then click the Browse button for
the From field and, in the Browse dialog box that appears, |ocate the VersaPro fol der
upon which you wish to base this new folder.

4. Click Finish. Theexisting folder's structure and contents (blocks, VDT, etc) are
duplicated in the new folder.

The Folder Browser appears, displaying the new folder. The _MAIN block will appear.
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To create a new folder, importing a Logicmaster 90 Folder:

2-6

Notes: Series 90-70 folders created in earlier versions of Logicmaster 90
(before release 6) will need to be converted to release 6 before
importing. For details, see "Importing Logicmaster Folders Earlier than
Release 6.0" on page 2-7.

VersaPro imports the hardware configuration before it importsthe
logic. VersaPro imports locked Control or Logicmaster 90 blocks.

A program originally created with the HHP cannot be imported from
Logicmaster to VersaPro when configured with a VersaMax, Series 90-
70, or high end Series 90-30 CPU. You must first import the low end
90-30 Logicmaster program to VersaPro and then convert to the high
end 90-30 CPU within VersaPro.

1. Click the New Folder button , choose New Folder from the File menu, or press
Ctrl+N. The New Folder Wizard will appear.

Mew Folder Wizard

Falder Mame:

Ichan

Location:
II::'\F'ru:ugram FileshGE Farnuc Autarn E.-"'l

Folder D ezcription
Impaort from LM30 folder Chand]

4 Black I Meut > I Finizh LCancel

¢ IntheFolder Namefied, type a name for the new folder. A folder nameis
required.

¢ If you want to save the new folder to alocation different from the defaullt,
click on the Browse button opposite the Location field.

e Enter afolder description in the Folder Description field. Y ou may enter up
to 64 characters. Thisfield isoptional.
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Hew Folder Wizard |

— Choose One
" Empty Folder [Default]
i~ Baszed on Esisting YersaPro Folder
& |mport Logicmaster 90

" |mport Contral
[helude Sk

Frarm:

C:heth-lad'chand ﬁl

< Back [HEnt Einizh | LCancel

2. Click the Next button. The next screen of the New Folder Wizard will appear.

3. Click the Import Logicmaster 90 button, then click the Browse button for the From
field and, in the Browse dialog box that appears, locate the Logicmaster 90 folder
upon which you wish upon which you wish to base this new folder.

4. Click Finish. The content of the Logicmaster 90 folder isimported into the new
folder. Thelogicis checked for correct syntax.

o If any syntax errorsare found, they are reported in the Information Window, and
the processis aborted. The new folder isnot created.

e If no syntax errorsare found, the folder is populated with the logic and hardware
configuration from the Logicmaster 90 folder.

Importing Logicmaster Folders Earlier than Release 6.0

If you have a Logicmaster 90-70 folder created before release 6 of Logicmaster, you
should use the following procedure to import your Logicmaster folders into
VersaPro:

1. Open Logicmaster 90-70 release 6 or later.
2. PressF1 to enter programming mode and select any folder.

3. PressF8 (Program Folder Functions) and then F1 (Select/Create a Program
Folder)
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4. Select the folder to be imported into VersaPro and press Ctrl+T. You will see
the message "Converting old logic files to new format, please wait ..." followed
by "File conversion complete; press any key to continue'.

5. InVersaPro, create anew folder based on the Logicmaster folder.

6. In some cases, the folder will ill not convert completely because the
declaration file, symbol table, hardware configuration or C Blocks have not been
updated to the LM90-70 release 6 format. The Ctrl+T operation in Logicmaster
only updates thelogic files.

If the declaration fileis not imported, as indicated by the following message in the VersaPro
information window "Unable to import declarationsfile," you should open the folder with
Logicmaster, add a rung with just a coil, and enter %Q, which will force the valueto be the
next highest used and then delete therung. Thiswill force the declaration fileto be
recompiled in the LM 9070 release 6 or greater format.

If the symbol table isnot imported into VersaPro, asindicated by a message "Failure to read
block_name.ste," you should open the folder with Logicmaster 90-70 rel ease 6 or greater, add
avariable to the variable declaration area of the block that will not import, and then delete the
variable to force Logicmaster to recompile the symbol tablein the new format.

If you receive an error message “Invalid iocfg.cfg file; Please select valid iocfg.cfg,” you
should open the folder in the Logicmaster 90-70 Configuration package and edit one of the
configuration items by changing it to another value and then back to the original value.

If your folder has C blocks and the folder was created before LM 9070 release 6, you will need
to re-import the C blocks into Logicmaster 90-70 rel ease 6 or greater before importing the
folder into VersaPro. The Ctrl+T operation does not update C blocks.

When a folder contains a locked block

2-8

Y ou may import a Logicmaster 90 or Control folder or load afolder fromaPLC
containing alocked (protected) block. The following will occur:

When afolder containing alocked block isimported from Logicmaster 90
or Contral, the block name, type and language areretained, but the block
contains no contents.

When a protected block isloaded from a PLC, an empty block is created.

The Folder Browser displays an icon for the block.
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To create a new folder, importing logic from a Control folder:

You can import VersaMax (.F2K) and Series 90-30 (.F3X) folders from Contral.

To create anew folder based on an existing Control folder, launch VersaPro and perform
the following steps:

1. Click the New Folder button , choose New Folder from the File menu, or press
Ctrl+N. The New Folder Wizard will appear.

Mew Folder Wizard

Folder Mame:

Ivm_flu:lrl

Location:
IE:\F'n:ugram FilegGE Fanuc Autom |j"|

Falder Description

ersaPro folder for WVersahd ax
FPLCz. Default langauge: LD

< Bank I Hest = I Einizh LCancel

¢ IntheFolder Namefied, type a name for the new folder. A folder nameis
required.

o If you want to save the new folder to alocation different from the default,
click on the Browse button opposite the Location field.

e Enter afolder description in the Folder Description field. Y ou may enter up
to 64 characters. Thisfield isoptional.

GFK-1670D Chapter 2 Working With Folders 2-9



2. Click the Next button. The next screen of the New Folder Wizard will appear.

Mew Folder Wizard

+ Chooze One
= Empty Folder [Default)
" Bazed on Existing YersaPro Folder
" Import Logicmaster 90

¥ |mport Cantral
v |nclude SHF:

=

From:

I FoldersWbld 161 4 dir_[avbld161 2

< Back HEwt Finish | LCancel

3. Click the Import Control button, then click the Browse button of the From field and,
in the Browse dialog box that appears, |ocate the Control folder upon which you wish

to base this new folder.
Note: Only Control folderswith .f3x and .f2k extensions may be imported.
Note: Your Control folder must be successfully built in Control before
importing, and the hardware configuration must also have been built in
Contral.

4. If you areimporting variables from Control, select the Include SNF checkbox, then
click the Browse button and, in the Browse dialog box that appears, locate the SNF
filethat is associated with the Contral file to be imported. (Thisfield isoptional.)

Note: When importing a Control folder, in order to add variabl e nicknames,
the SNF (shared name format) file associated with the folder to be
imported must first be exported from the Control folder using Control.
Refer to the Control onlinehelp for details on exporting an SNFfile.
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5. Click Finish. The content of the Control folder isimported into the new folder. The
logic is checked for correct syntax.

o If syntax errorsare found, they are reported in the Information Window,
and the processis aborted. The new folder isnot created.

e If nosyntax errorsare found, the folder is populated with the logic and
hardware configuration from the Control folder.

Rules for Folder Names and Nickname

This section describes naming conventions and rules for new folders and folder
nicknames.

Rules for Folder Names

The following rules apply to folder names for new VersaPro folders:
e A folder name may be no longer than 103 characters.

e Thefollowing characters may not be used in afolder name: . (period), \
(backdash), / (forward dash), : (colon), * (asterisk), ? (question mark), <
(lessthan), > (greater than), | (vertical bar), " (quotation mark).

Rules for Folder Nicknames

The Folder Nickname (or Program Name) is the name used when storing the folder to the
PLC. Both the Series 90-30 and VersaMax PLCs will recognize anicknamethat is 7
charactersor less.

e A nicknamemust be 7 characters or less.

e Thefirg character of anickname must be aletter.

e Theremaining characters may be letters, digits, or the underscore character
().

e Anunderscore may not appear directly after an underscore.

e When afolder is created, the Folder Nickname defaultsto thelast 7
characters of the folder name.
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Directory structure and files for a new folder

When anew empty folder is created, the following files are created at the folder's
specified location. For these examples, the folder's name is newfol der.

_MAIN.blk (the_MAIN block)

newfolder.fld (adescription of the folder's contents)
newfolder.vdt (the Variable Declaration Table)
newfol der.hwcfg (Hardware Configurations)
newfolder.ssx (Smart Store Extensions)

For anew folder created based on an LM90 import named, for example, LM90impt, the
folder is created at the specified location incduding these files:

_MAIN.blk (the_MAIN block)

a.blk file for each LM90 block

LM90impt.fld (a description of the folder's contents)
LM90impt.vdt (the Variable Declaration Table)
newfol der.hwcfg (Hardware Configurations)

newfolder.ssx (Smart Store Extensions)

Opening an Existing Folder

2-12

VersaPro allows you to open afolder from alocal drive or floppy disk, or from anetwork
drive. Perform the following stepsto open an existing VersaPro folder.

1. From the File menu, choose Open Folder, or on thetoolbar, click the Open Folder

button.

2. If another folder isaready open, adialog box appears, asking if you wish to close the
open folder.

3. Onceyou have closed the open folder, an Open dialog box appears. Folders have file
type .fld, so you will see"*.fld" in the "Files of type:" list.

4. Select thedrive and folder to open.
5. Click the Open button.

6. Thefolder opens. Its components are displayed according to the properties retained
upon the last Save.
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Using the Folder Browser

After creating anew VersaPro folder or opening an existing folder, the Folder Browser
appears, aong with the default windows (logic editor, information window, etc.).

Menu Bar and Toolbars

2 versaPro - Example - _MAIN blk Provide quick access to _O[=]
Eile Edit “iew Insed Faolder ELC Taools Wind frequently used functions.

FEEEE IR RS =E=n
[x it ololelelele] k@ =] | &G s [FEE 22
g L= M Y I T A

[ Function Grou x| |acos =] £
1 Example =1 [T %I00R1 Q00019
—Hill Hardware Configuration | | [
—F= “ariable Declarations
ii %IUU‘B@% Q00019

& Pro_Ling ~

i Browser View
—4b Simple | Logic Editor Window

L@ Tarque| Displays all components contained - .
L] Trigger| in the folder. To view details for a Displays program or block logic.

@ Trigger component, double-click the item.

—————————— Svntax check summary. ----------
Total srrors: 0O

[
Total warnings: 0O -
Information Window -
b General Find Cros e Displays warnings and error messages »

e Displays results of Load, Store, Verify
MName T{ e Displays results of Find operations
[ ]

Displays results of View Online Cross-Reference

UL N Bit
%Quong |\ Bit . —
%oomnst |\ Bit 1 2000051 0 .
A Glnba,’ \ocal All Svstern i N | 3
ForHelp, pres7 \ |Fun Enabled \L,Elw]ected | 5.9msec|Logic Equal ;
Variable Declaration Table Status Bar
Displays all variables defined in Shows the PLC run/stop state,
the folder. scan time, and equality status.
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The Folder Browser displays atree-like structure, showing al of the components
associated with thefolder. The display includesalist of all blocks included in the folder
(including the _MAIN block), as well asicons providing access to Hardware
Configuration, the Variable Declaration Table and View Tables.

The Folder Browser allows you to navigate through the current folder easily and to create,
arrange, modify or delete blocks and block properties. It also allows you to check the
syntax of blocks within afolder, and to Insert or add additional componentsto the folder.

To open an item in the browser window, double-click the item in the browser.

Information Window

The Information Window's General tab displays error and warning messages (for example,
theresults of checking logic for syntax errors). It also displays the details of searches,
replacements, conversions from one language to another, and the results of the Find
Unused Variables command (from the Folder menu, select Find Unused Variables).

When a compile of an LD, IL, or Motion block is successful, VersaPro writes the size of
the block to the information window.

The Find tab displays the results of the Find in Blocks operation. (Select Find in Blocks
from the Edit menu or the Folder Browser CSM..) Lists block, rung, and ingtruction where
each instance of the item being searched for was found.

The Reports tab displays the results of the View Online Cross Reference and View Online
Use Tables operations from the Tools menu. Online Cross Reference lists all variables
used in the selected block and identifies the rung (or line) and instruction each variableis
used in. The Online Use Tables report provides a table for each reference type used in the
folder. Thetable identifies reference addresses used as explicit, implicit, or both.

Note: When the Information Window is resized to alarger window, the scroll
box becomes too large to be moved in the scroll bar. To scrall the
window, use the arrow buttons at the either end of the scroll bar.
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Context-sensitive Menu

The context-sensitive menu (CSM) isnot on the menu bar. It appears when you click the
secondary (right) mouse button in certain VersaPro windows or on certain elements. The
menu contains alist of frequently-used options appropriate to the given context.

To use the CSM

1. Sdect afolder element (the folder or one of its sub-elements).

2. Click the secondary mouse button on the el ement.

3. A CSM similar to the one shown bel ow appears. Unavailable options appear in gray
text.

4. Click the desired option.

GFK-1670D

& Cut
Copy
Easte

Bf Check Selected Block(s) Ctrl+F7
& Check Al
ta Stare..

Insert Block. ..
Ingert Object...

2 NewBlock...
MNew Reference Yiew Tahle...
Mew Yariahle Wiew Takle..
Open

Yiew Online Cross Reference

¥ Delete

Find In Blocks ..

Froperties...

[ allow docking
Hide
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Working with Windows in the VersaPro Workspace

2-16

All windows in the VersaPro workspace can be moved by dragging and dropping. These
windows can also be resized. To move awindow, click itstitle bar or top border, if it
doesn't have atitle bar, and drag it. To resize awindow, click itsedge or corner and drag.

The Folder Browser, Information Window, Variable Declaration Table, and Local Logic
Variable Table (used in Motion programs) can be docked (fixed) or undocked (floating).
To select or deselect docking, click the secondary mouse button in the window and choose
Allow Docking from the context-sensitive menu.

Note: If you click in an undocked window, you will not be able to select
items from the main menus or other windows in VersaPro until the
window is docked again. These windows can be docked and undocked
by selecting Allow Docking from the CSM.

Y ou should undock these windows only temporarily in order to move
them to anew docked location.

Hiding awindow makes it disappear temporarily. It does not cause the window's datato
be saved. To hide awindow, click the window's button on the View toolbar, or choose the
window's name from the View menu. To hide a dockable window choose Hide from the
CSM.

To display awindow once it has been hidden, click the window's tool bar button, or from
the View menu, choose the window's name.
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Folder Operations

This section describes additional operations and functions which may be performed on
VersaPro folders, including:

e Performing standard file operations (close, save, delete, backup, restore)
e Restricting access to VersaPro folders (enabling password protection)

e Editing folder properties

Closing a VersaPro Folder

Since only one folder can be open at atimein asingle instance of VersaPro, an open
folder must be closed before creating anew folder or opening an existing folder. When
you try to open afolder when afolder is currently open in VersaPro, you will be prompted
to save the currently-open folder before opening the new folder. You can also close a
folder by performing the following steps:

1. Sdect the File menu and choose Close Folder. If any of the folder's components have
changed, you will be prompted to save the changes for each component.

e Click Yesto save changes or No to ignore changes. Clicking Cancel abortsthe
close operation.

2. Thefolder isclosed. Aspart of the folder closing process, the Folder Browser is
automatically saved, the size of the last active block is saved asthe retentive block
state, and the individual size and position of all dockable windows and al columns
are saved asretentive states.

Saving a Folder

VersaPro allows you to save an open folder and folder contentsto its current location.
This operation saves the entire folder, not individua parts.

To save afolder, select the File menu and choose Save All. Y ou can aso click the Save
folder button on the toolbar. The open folder is saved.

The File, Save menu item saves only the selected component.

Deleting a Folder

To delete aVersaPro folder, locate the folder on your hard drive and use Windows
Explorer to delete the folder and its contents.
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Backing Up and Restoring

VersaPro provides commands to back up afolder and to restore afolder from backup.
VersaPro creates backup files with a.flb extension.

Backing Up a Folder

2-18

Backing up ensures that dataisnot lost in any event. It isrecommended that you back up
your folder occasionally to protect your program.

Thefolder isautomatically backed up under the following conditions:

When you sdlect File, Save All

When you respond “Yes’ to the message “The folder has been modified. do you wish
to saveit first?’

When you close a folder in which changes have been made to the folder directory.
These changes includes modifying folder objects (such as Word or Excel documents),
hardware configuration, or any folder subdirectories.

When you save a folder and the Auto Backup option isenabled in the Options dialog
box. The number of folder backup files that VVersaPro will keep is also configured
using the Options dialog. By default, this option is enabled by default and the lagt
three folder backups are kept. For more information, see “ Auto Backup” on page
2-19.

To manually back up your folder:

1

Select the Folder menu and choose Backup. The Backup Folder dialog box will
appear.

In the Source Folder field, enter the path and name of the folder that you want to back
up, or locate it by clicking on the Open Folder button and selecting the folder in the
Browse dialog box that appears.

In the Destination field, enter the name of the backup and the location to which you
wish to save it, or locate the path by clicking on the Open Folder button and selecting
the folder in the Browse dialog box that appesars.

Click OK. A backup of the folder you select is created and saved under the specified
name to the indicated location.
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Restoring a Folder from Backup

VersaPro allows you to restore backed up files as necessary. Compressed backup files are
decompressed and fully restored when arestore is performed. Perform the following steps
to restore afolder from backup.

1. Closeany open folders.

2. Select the Folder menu and choose Restore. The Restore Folder dia og box will
appear.

3. Inthe Source Folder field, enter the path and name of the folder that you want to
restore, or locate it by clicking on the Open Folder button and selecting the folder in
the Browse did og box that appears.

4. IntheDegtination field, enter the location to which you wish to restore the folder, or
locate the path by clicking on the Open Folder button and selecting it in the Browse
diaog box that appears.

5. Click OK. Thefolder that you selected isrestored to the location that you specified.

Auto Backup

By default, VersaPro automatically backs up afolder when you save it and keeps the three
most recent backup copies (*.flb files). To set Auto Backup options, go to the Tools menu
and select Options. On the General tab of the Options dialog box, clear the Enable Auto
Backup with aLimit of ... check box to disable Auto Backup. To enable Auto Backup,
select the check box. Y ou can specify the number of files, from 1 to 100, that will be kept.

Restricting Folder Access

VersaPro allows you to restrict access to a folder by locking it. A locked folder's contents
may be viewed but not changed. A folder may be locked with or without a password. If a
folder islocked with a password, you must enter the password to unlock the folder. A
locked folder is"read-only."

Locking a Folder

Perform the following steps to lock afolder:
1. Open thefolder you want to lock.
2. From the Folder menu, select Lock. The Folder Security dialog box will appear.

e Tolock the folder without a password, click OK.
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e Tolock the folder with password protection, check the Lock with Password
checkbox. Enter the password in both the Enter Password and Verify Password
fields. The password is case sensitive.

e A password must be eight charactersor less.

e Valid password characters are digits (0-9), uppercase (A-Z) and lowercase (a-2)
letters, and the underscore ().

3. Oncethefolder is successfully locked, the folder title bar will display READ_ONLY,
indicating that the folder is protected. Y ou cannot edit any portions of the folder,
except for temporarily adding variables to existing view tables.

Note: Once afolder islocked with a password, that password cannot be

changed. To assign anew password, unlock the folder, then lock it
with anew password.
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Operations permitted on locked folders

Edit existing view tables. Y ou may not create new view tables. Variables already defined
in the Variable Declaration Table may be added to VV Ts for the purposes of monitoring,
but the changes cannot be saved. New variables may not be created in the VVT. Addresses
may be added to RV TS, but cannot be saved.

Open and close windows or blocks

Rearrange windows

Monitor logic execution

Toggle and Override 1/0

Change variable values

Copy blocks and portions of logic from the fol der

Create anew folder based on the locked folder. The new folder will also be locked,
with the old folder's password.

Store and Verify folders

Unlocking a Folder

If afolder isSREAD_ONLY, you must unlock the folder to edit the folder. If passwords
were used when locking the folder, they must be supplied to successfully unlock the
folder. Perform the following stepsto unlock a folder:

1

2
3
4.
5

GFK-1670D

From the Folder menu, select Unlock.

If the folder has a password, the Enter password dial og box appesars.
Type the password.

The phrase"READ ONLY" in the folder'stitle bar disappears.

The old password is cleared. The folder can now be edited.
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Changing Folder Properties

2-22

Folder properties are set when afolder is created. However, you can change the folder
description and nickname. Perform the following steps to change folder properties:

1
2.

L T

Open the folder whose description or nickname you wish to change.

From the Edit menu, choose Properties, Folder. The Folder Properties dialog box will
appear.

Change the description asdesired. A description may be up to 64 characterslong.
Change the nickname as desired. The nickname may be up to 7 characters.

Type header or footer text asdesired.

Click OK. The folder properties are saved, and the Properties did og box closes.
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Printing Your Program

Hardware Configuration is not included in any printed report. If you want to print out
Hardware Configuration, you must do so using the Stand Alone Hardware
Configuration utility.

Reports and printouts can only be generated for the folder that is open.
Printing a Report

The Print Report dialog box allows you to define which components should be printed
when you generate areport. Y ou can print Blocks, a Cross Reference, a Table of Contents,
a Header Page, and Variables. The Print dialog box allows you to choose printers, print
ranges, and the number of copies that you want to print. The Page Setup dialog box allows
you to select paper size, source, orientation, and margins.

Information about which Print Components, which Blocks and which details about blocks,
whether or not a Table of Contents or a Header page, and whether Cross References and
the associated Reference Addresses are to be included in printing, isretained after you
generate your firg report. Y ou can change thisinformation as desired, but you need not
reset the specifications every time you print. All other settings require input each timea
report is generated.

Perform the following steps to customize and print your program:

Note: To add custom header and/or footer text to reports and folder printouts,
edit the Folder Properties. (Go to the Edit menu, choose Properties, and
Folder.) In the Folder Properties dialog box, you can specify a text
string using format switches to control the appearance of the custom
information. For details, see "Custom Header/Footer Formatting."
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1. From the open folder, select the File menu and choose Print Report. The Print Report

dialog box will appear. Use this dialog box to customize your listing as described
bel ow.

Print Report [ x]
— Printer

MName: Tech_‘Wnr_FLC

Where:  YWWCHONTOOVtech_wrt_plc

™ Printta File
I Blocks ——————————— W Tables ————————— T Yaiables
& A ) Eelected  Falder & PerBlock illote i Werislsle
Include: Include: Declaration Tahle:
VLogic (gAY = WGlobal Variables
COFroperties C1%A0 CLocal Variahles
[(arizhle Information kAl [(ISystem YVariakles
120 CTemporary Variables
. %04
ptions %R
™ Print Tahle of Contents 22 =l
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e ToincludeBlocksin your report, click the Blocks checkbox.

Note: When multiple blocks are printed, they are printed in the order they
appear in the Folder Browser.

In the Blocks group, check each block element that you want to include in the
report. You can choose:

O Logic
O Properties

O VariablelInformation (all variables used in thisblock pluslocal variables,
even if they are not used in the block)

Note: To activate the Selected radio button, you must first go to the folder
browser and select the block or blocks that you want to print.

e ToincludeaCross Referencelist in your report, click the Cross References
checkbox, then choose whether you want to include Cross References for
the entire folder, or per block by clicking the appropriate option button.

¢ If you choose to print Cross References per block, and you want to include
identifiers (Jump, Label Names, Calls, and MCR Names) check the
Identifiers box in the Include list.
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Note:  The Cross Reference includes implicit addresses for all variables that use
them. Implicit addresses are enclosed by brackets| ].

e Toinclude Variable Tables in your report, click the Variables checkbox,
then select which variables you want to include by checking the appropriate
checkboxes.

e ToincludeLoca Logic variables, select the Include Local Logic Variables
checkbox.

o Toseect paper size, source, orientation, and margins, choose Page Setup
from the File menu, or click the Page Setup button in the Print Report
diaog. Click the OK button to save your specifications.

e To print contents of thereport, select Print Table of Contents.
e Toprint Folder Properties information, select Print Header Page.

e Tochange the starting page number for the report, type the number you
want in the Starting Page Number box. Maximum is 9999. Default is 1.

2. Click the OK button or press Enter to print.

Printing Logic, Variable Declaration Table, or Information Window Contents

With the window you want to print selected, choose Print from the File menu, click the

=

1. InthePrinter group, use the drop-down list to choose the printer that you want to use
to print thereport. Y ou can also view or alter Printer Properties by clicking the
Properties button, or choose to print to file by clicking in the Print to file checkbox.

Print button or press Ctrl + P. The Print dialog box appears.

2. InthePrint range group, determine whether the current selection, a certain range of
Rows, Rungs or Tabs, or All items should be printed in the report.

3. Inthe Copies group, determine the number of copiesthat you want to print by
entering it manually or by using the arrow buttonsto theright of thefield.

4. Click OK to print, or Cancel to close the diaog box without printing.

Custom Header/Footer Formatting

GFK-1670D

Y ou can specify custom header and footers for printed reports and printouts (except for
the Information window). Thisinformation appearsin addition to the standard VersaPro
header and footer.

Custom header and footer information is created by entering text stringsin the Folder
Properties dialog box (Edit menu, Properties, Folder). Y ou can include format switchesin
the text string to control the appearance of the custom text.

Chapter 2 Working With Folders 2-25



Format Switches

Switch Name M eaning

%n new line Place the following text on anew line.
> arrow Right justify the following text.

A carat Center the following text.

>> doublearrow | Print an arrow: >.

N doublecarat | Print acarat: .

Textisleft justified by default.

The > and " format switches affect dl the text that follows them
until the end of the string or until the next », >, or %n.

Example

Thefollowing string
AThisis my customized footer%nL eft justified>Right justified

resultsin
This is my customized footer
Left justified Right justified
<<<Standard VersaPro footer>>>
Notes

The number of charactersin each entry islimited only by the buffer size of
a standard Windows edit control.

Header and footer strings are archived in the folder.

If aheader string is present, it is printed on the line following the standard
header (datetime/appname/page).

If afooter string ispresent, it is printed on the line before the standard
footer (folder/location/block).

The standard header and footer automatically increase their sizeto two lines
if thereis not enough space on asingle line.

VersaPro does not limit the number of lines present in the header/footer
strings.

If the header and footer will overlap each other or overflow thetop or
bottom of the page (thereisno room for the body of the page), an error
message will indicate this, and the report will not be generated.

No messages will be presented if the formatting sequences are used
erroneoudy, or if they would cause parts of a header/footer lineto overlap
one another or to print off the eft/right side of the page.
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Working With Blocks

The Series 90-70, Series 90-30, and VersaMax PLCs support multiple blocks per
folder (thetotal number of blocks vary, depending on the PLC configured). All
PLCsrequirethat one of the blocksis _MAIN. This block is automaticaly created
when you create anew folder.

This chapter describes how to work with blocks using VersaPro Programming
Software.

Chapter Contents
How to create and open blocks and objects
How to manage blocks and related componentsin the folder browser
How to work with variables associated with folder components.

How to convert blocks between IL and LD

31



Creating, Inserting and Opening Blocks

VersaPro allows you to use multiple blocks per folder, one of which must always be
a_MAIN block. A nameis always required in order for ablock to be created. Note
that each PLC model has a different limit for the number of blocks, excluding
_MAIN, that can be created in afolder. (The Series 90 Micro supportsonly a
_MAIN block.) More than one block can be open at once.

Once ablock has been created, it can be called from within the _MAIN or any other

block. You can also call ablock that does not yet exist, but that you intend to create.

When you compile, a syntax error appears, reminding you that the new block has not
been defined.

The following types of blocks can be created in VersaPro:

Block Type Supported by
Ladder Subroutine All, except Series 90 Micro

Instruction List Subroutine Series 90-30, VersaMax, VersaMax
Nano/Micro

Externd (C Block) Series 90-70
Series 90-30 models 350, 351, 352, 360,
363, and 364

Moation (Local Logic, Motion, and Cam Series 90-30 DSM 314 motion module

programs)

Creating a Subroutine

1

With a folder open, choose New from the File or Context-Sensitive menu. From
the Subroutine submenu, select Ladder or Instruction List. (You can d - eate
a Ladder subroutine by clicking the New Block button on the toolbar.)

The Create New Ladder Diagram or Create New Instruction List dialog box
appears.

On the Basic Properties tab, enter a unique name for the new block.

If you are creating atimed interrupt block for a 90-30 PLC, the block name must
conform to the requirements for Timed Interrupt.

If you wish, enter adescription for the block.

To assign Interrupt parameters to the block, select the Schedule tab. Double
click under the Type column to sdect I/O Interrupt or Timed Interrupt. For
details about the interrupt parameters, click the dialog box Help button.

Note: For a 90-30 timed interrupt block, the block name determines the time base, delay, and

3-2

timeinterval parameters. If you change these values, an error message will appear when
you try to close the dia og.
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5. Toplaceredtrictions on editing or viewing the block, select the Lock tab.
6. Click OK. A new block is created.

If the Folder Browser isopen and ablock is selected, the block is added to the
Folder Browser above the currently selected item. If the Folder Browser is
closed, or the Folder node, Hardware Configuration, or VDT in the browser is
selected, the block is added at the end of the browser.

Creating an External C Block

Note: The C executable file must be created using the C Programmer’s
Toolkit for Series 90 PLCs. Also, it must be created specifically for the
target PLC (90-70 or high-end 90-30). 90-30 C blocks do not use
input/output parameters.

1. With afolder open, choose New, External from the File or Context-Sensitive
menu. The Create New C Block diaog box appears.

2. Onthe Basic Properties tab, enter a unique name for the new block. Restrictions
on name entries.

3. If youwish, enter adescription for the block. Restrictions on Descriptions..

4. Toassociate aC executablefile (.exe) to the block, select the C Binary tab. To
locate the C program that you want to use, click the browser button next to the
Update Using field.

5. Toassign Interrupt parametersto the block, select the Schedule tab. Double
click under the Type column to sdect I/O Interrupt or Timed Interrupt. For
details about the interrupt parameters, click the dialog box Help button. (A C
block can have either Interrupt parameters or Input/Output parameters, not
both.)

6. Toassign Input/Output parameters to the block, select the Parameterstab. Up to
seven parameter pairs can be assigned to an externa C block for 90-70.

7. Click OK. A new block is created.

If the Folder Browser isopen and ablock is selected, the block is added to the
Folder Browser above the currently selected item. If the Folder Browser is
closed, or the Folder node, Hardware Configuration, or VDT in the browser is
selected, the block is added at the end of the browser.
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90-30 Timed Interrupt Block Name Requirements

For the 90-30 PLC, Timed Interrupt blocks are defined and named in the form

If pisl, the Time Baseis.001 seconds, and iiii can range from 0001 to 0010 (with
block names 1T0001 to 1T0010).

If pis2, the Time Baseis.01 seconds, and iiii must be 0001 (with block name

2T0001).

Examples:

Block Name Time Base Initial Delay | Timelnterval
170005 .001 ec. 0 5 msec.
270001 .01 sec. 0 10 msec.

The Timed Interrupt block 1T0005 would be defined asfollows: Time Base =
.001 s; Initial Delay = O; Time Interval =5 (5 msec).

The Timed Interrupt block 2T0001 would be defined asfollows: Time Base =
.01 s; Initid Delay = O; Time Interval = 1 (10 msec).

The Initial Delay for a90-30 PLC Timed Interrupt block isaways 0.

If 290-30 PLC isdeclared in Hardware Configuration and the block is designated as
aTimed Interrupt block, but the name does not match the naming specification, an
error isreported when you click OK to close the Create New Block dialog box.

Name Field Restrictions

e  Only the characters A-Z, a-z, 0-9, and _ (no consecutive“_"s) are permitted.

e Theblock name must start with aletter or underscore. Series 90-30 Timed
Interrupt Blocks follow different rules.

e A block cannot have the same name as another block that existsin the open
folder. An error appearsif you enter arepeated name.

e Theblock name can be no longer than seven characters.

Description Field Restrictions

e Thedescription may be up to 64 characters.

e Thereisno restriction on the type of characters that can be used in a description.
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Inserting a Block from Another Folder

Y ou can copy blocks between folders using the Insert Block option. The name of the
block you are inserting must be unique for the current folder. If the block you want

to insert has the same name as an existing block, an error message will display.

When you add a block, the block's variables are added to the Variable Declaration

Table.

Perform the following steps to insert a block from another folder.

1. Open thefolder into which you wish to insert a block, and go to the Folder
Browser.

2. Sdlect the Insert menu and choose Block, or click the right mouse button and
select Insert Block. The Insert Block dialog box will appesr.

3. IntheLook In box, navigate to the folder containing the block you want to

insert.
Insert Block EE
Look in: |E| Examples j gl I_
[a8] _MAAIN balk
[e#] MuBlock kik
File narme: I o |
Insert as: I Cancel |
Files of type: | Block Files (hlk) =]
[ Insen block with offsets Bz |

4. Select the block type:
*.blk for LD, IL, Local Logic, or Motion blocks
*.exefor C blocks

To change the name of the block, edit the namein the Insert As box.

6. Todefinevariable offsets for the block, or add a prefix or suffix to the variable
names, select the Insert Block With Offsets checkbox, then click the Offsets
button.
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Insert Block
Loak in: IaExamplnc vI ﬁjl F“KI IEEI
Define Variable Offsets I_
8] _bAAIN bk

= NuBlack.blk BitMemary  Waord Memory
“ %Al [0
%0 ID %A0 0 Highest Used |

20 ID %R |0 Cancel |
N ID Help
I— |

%G o

Yariable Rename
& Prefix

File name: INuEiIDck. St |
Inser as: IEIIOCk_1 1

Files oftype: | Block Files (*klk) =

v Inser block with offsets Offsets... |

7. Make the needed changes in the Define Variable Offsets dialog box and click
Accept.

8. Inthelnsert Block dialog box, click Open.

The block is copied to the current folder's directory.

o If theFolder itself, Hardware Configuration, or the Variable Declaration table are
selected in the Folder Browser tree, the block isinserted at the bottom of the tree.

o If ablock or view tableis selected, the block appears above the selected item.
o If theinserted block hasthe same name as an existing block, an error message
appears.

e Adding ablock includes adding the block's variables to the Variable Declaration
Table. If the block being inserted contains variables that conflict with existing
variablesin the folder, the message, "V ariable name/scope already existsin the
variable declaration table" appears. Clicking OK, opens the Variable Resolution
diaog box, which alows you to resolve variable conflicts. (See "Variable Resolution”
in chapter 6.)

o If youareinsertinga“C” block, select the .exefile you created using the C Toolkit.

Opening a Block

Once ablock is part of the Folder Browser, you can open and edit the block at any
time. Multiple blocks may be open at the sametime. To open ablock in the Folder
Browser, select the block you want to open and double-click the block name.

Note: “C” blocks cannot be opened in VersaPro.
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Maximum Block Size

The following table lists maximum sizes for subroutine blocks.

VersaMax 16KB

VersaMax Nano/Micro 18KB

Series 90-30 16 KB for LD blocks
80 KB for C blocks

Series 90-70 32 KB for LD blocks
64 KB for C blocks

Inserting and Editing Objects

GFK-1670D

VersaPro allows you to associate objects with your folder. For example, you can
insert an Excel spreadsheet, Word document, or Access database file into your
folder. Oncethe object isassociated with your folder, you can edit the object by
double-clicking in the Folder Browser.

To insert an object into a folder:

1. Open thefolder into which you wish to insert an object. Go to the Folder
Browser.

2. Select theitem below which you want to insert an object.

3. Sdlect the Insert menu and choose Object, or click the right mouse button and
select Insert Object. The Insert Object diaog box will appear.

4. Select the name and the location of the file you want to insert. VersaPro
component files (files with an extension of .blk, .fld, .hwc, .wvr, .wrt, or .vdt)
may not be inserted.

5. Click Open. The object isinserted.

To launch an inserted object:

1. Openthefolder containing the object that you want to launch. Go to the Folder
Browser.

2. Toopen the object, double-click on the inserted object, or select the object using
the up or down arrow keys and then press Enter, or select the object , click the
right mouse button and choose Open.

If an application is associated with the folder type, the application will start up,
opening the selected object. If no application is associated with the object, the
standard “ Open With” Windows prompt will appear.
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Working with Blocks and Objects in the Folder Browser

VersaPro provides a flexible browser interface to manage the blocks, view tables,
variable declaration tables, and objects associated with the folder.

This section describes how to manage the files and information associated with the
componentsin the Folder Browser.

Arranging Blocks

VersaPro allows you to change the order in which blocks are displayed and printed.
(Blocks are printed in the order they appear in the Folder Browser). To rearrangethe
order, smply select the component you want to move and then drag and drop it to
the new location. Y ou can aso move blocks using standard Windows cut, copy and
paste commands.

Viewing and Modifying Block Properties

Block propertiesare initialized when the block is created. However, you can change
the description of ablock at any time. Depending on the type of block, you can aso
edit other properties:

Block Type Tab Options

LD, IL, C, Basic Modify Block Name and Description.

Mation, Local | Properties

Logic, Cam

LD, IL, C Schedule Define 1/0O Interrupt and Timed Interrupt behavior.
LD, IL, C Lock Lock and unlock view and edit access to block.
Mation, Local | DSM Select DSM module. (The only DSM available at this
Logic timeis selected by default.)

C C Binary Specify the C executabl e fil e associated with the block.
C Parameters Specify input and output parameters for the C block.

Perform the following steps to edit the properties of a block.
1. Fromthe Folder Browser, select the block whose properties you wish to view.

2. Select the Edit menu and choose Properties, Block, or click the right mouse
button on the block and choose Properties. The Properties dia og box will
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Properties E

Basic Properies |Su:hedu|e| Lock |

Marme:

I_MAIN

Block Type: Language:

‘Subruutine Ladder Diagram

Description:

I =
[~

(0] | Cancel | Help |

3. The General Propertiestab, displays the block’ s name, language, type,
description, and description. Y ou can edit the Name and Description.

4. Todefine Timed Interrupts or /O Interrupts, select the Schedule tab.
5. Tolock or unlock the block, select the Lock tab.

Moving Folder Components

GFK-1670D

VersaPro allows you to determine the order in which folder components, including
logic blocks, are displayed and printed by dragging and dropping or cutting/copying
and pasting.

You can cut or copy IL, LD, Mation, and Local Logic blocks, and view tables, and
paste them in the same folder with a unique name or arepeated name with a suffix
number. Y ou can also drag and drop, and rename blocks and view tables. Block
pasting and dropping works within and across folders. (_ MAIN can be copied and
pasted, but not cut.) When you copy or move a block, its properties will be included.

Y ou can copy and paste (or drag and drop) Cam blocks within a folder, but not
between folders.

Y ou can copy and paste Hardware Configuration between folders, but not within the
same folder.
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Cutting Folder Components

Note: To cut ablock, it must be closed.

1. Open the Folder Browser.

2. Sdlect an item or number of items in the Folder Browser. The _MAIN block,
VDT, Hardware Configuration, and Folder node cannot be cut.

3. ‘oe‘ Cut from the Edit or Context-Sensitive menu, click the Cut button
,or press Ctrl + X.

The selected item and its contents are moved to the clipboard. It may now be
pasted within other VersaPro folders or to another application.

Copying Folder Components

Note: To copy ablock, it must be closed.

1. Open the Folder Browser.

2. Sdect an item or number of items in the Folder Browser. The Folder node and
the VDT cannot be copied.

3. fEeepse Copy from the Edit or Context-Sensitive menu, click the Copy button
,or press Ctrl + C.

The selected item and its contents are copied to the clipboard. They may now be
pasted within other VersaPro folders or to another application.

Pasting Folder Components

3-10

1. Cut or copy an item from the Folder Browser.

2. Inthesame or another folder, select an item above which you wish to paste the
cut or copied item.

3. Paste from the Edit or Context-Sendtive menu, click the Paste button
, or press Ctrl + V.

4. |If theitem you are pasting already exists in thefolder, a dialog appears asking
you to provide a new name for the item.

5. Typeanew name for theitem, then click OK.

Theitem is pasted above the selected item in the Folder Browser.
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Dragging and Dropping in the Folder Browser

Y ou can use drag and drop to move or copy components within afolder or between
VersaPro folders. The following drag and drop operations are all owed:

e Moving blocks, Reference View Tables and Variable View Tables within a folder
browser (changing order)

e Copying the _MAIN block to adifferent folder (must rename the copy of _MAIN)

e Moving or copying blocks, Reference View Tables, and Variable View Tables
between folders

e  Copying Hardware Configuration between folders
Note: To drag and drop ablock, it must be closed. Drag and Drop works
only within VersaPro applications. Items are not placed on the

clipboard and are not available to other Windows applications.
Y ou cannot drag and drop the folder’ s root node.

Moving Folder Components
1. Sdect (highlight) an item in the Folder Browser.
2. Click and hold on the selected item. (The selected item is highlighted.)

3. Dragtheimage of the selected item to the desired location in the same or
another folder.

4. Drop theimage by releasing the mouse button. The selected item and its
contents are moved to the new location.

If you are dragging from one instance of VersaPro to ancther, and the drop action
that you are atempting involves a conflict in variables (for ingance, if you are
copying a Reference View Table that contains a variable aready defined in the target
folder's VDT), the Variable Resolution dialog box appears so that you can change
the conflicting variable to diminate the conflict. Y ou can change the variable name,
type, length, or scope, then click OK. Click Cancel to cancel the drag and drop
operation. Y ou can aso have VersaPro resolve the conflict for you.

Copying Folder Components

1. Sdect (highlight) an item in the Folder Browser.

2. Pressand hold the Ctrl key.

3. Click and hold on the selected item. (The selected item is highlighted.)
4

Drag the image of the selected item to the desired location in the same or
another folder.

5. Drop theimage by releasing the mouse button and the Ctrl key. Variable
conflicts are handled the same as for components being moved.
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Deleting a Block

If you decide that a block isno longer desirable within afolder, you can deleteit. If
the block is_MAIN, it will not be removed from the folder, but thelogic will be
cleared from _MAIN. Deleting a block does not delete global variables from the
Variable Declaration Table, but it does delete the block's local variables.

To delete a block or View Table:

1. Open thefolder from which you wish to delete a block. The folder must contain
multiple blocks.

2. Make surethat the block to be deleted is closed.
3. Select any block except _MAIN in the Folder Browser tree.

4. Ch o5 ete from the Edit or the Context-Sensitive menu, click the Delete
button =], or pressthe Delete key.

5. A warning message appears asking if you are sure you want to perform this
operation. If you click OK, the block is deleted from your folder and removed
from the browser tree.

In the future, any reference to the deleted block will produce a warning at syntax
check.

Global variables contained in adeleted block are not deleted from the Variable
Declaration Table, but local variables are.

To delete the contents of the _MAIN block:

3-12

1. Open thefolder from which you wish to delete the contents of _MAIN. Select
_MAIN in the Folder Browser.

2. Pressthe Delete key, or click the delete toolbar button . You will be
prompted that the contents of _MAIN will be cleared.

3. Click OK. _MAIN iscleared of al logic and the Block Description is cleared.
Other blocks in the folder are kept intact and are unaffected by this operation.
Variableslocal to_ MAIN are deleted. Global variables are not deleted from the
Variable Declaration Table.
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Saving a Block

VersaPro allows you to save the sdected block to its current location. If the VDT or
the Folder Browser have changed, they are also saved.

To save a block

1. Sdect the block you wish to save.

2. From the File menu, choose Save. (This option isavailable only if the selected
block has changed since thelast save.) The active block and any changed items
(VDT, folder) are saved.

Closing Blocks

Y ou may wish to close a selected block, or close all open blocks, but |eave other
windows (for example, the VDT and Folder Browser) open.

e Tocloseablock: Sdect the block you want to close. From the File Menu, choose
Close. The sdlected block will close.

e Tocloseall blocks: Select the Window menu and choose Close All. If ablock

contains unsaved changes, you will be prompted to save changes before closing the
block.

e Click Yesto save the changes and close the block.
e Click No to close the block without saving.

e Click Cancdl to leave the block open.
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Using Editing Operations on Folder Components

VersaPro allows you to use any of the standard editing commandsto cut, copy and
paste information. VersaPro also supports undo and redo to manage changes made to
folder components.

Using Undo and Redo

VersaPro allows you to undo or redo certain actions (like placing an element or
deleting arow) in Hardware Configuration, in the Variable Declaration Table, in the
Variable View Table, the Reference View Table, and the IL Editor or LD Editor.

Y ou can undo or redo actions using the standard menu commands, keyboard shortcut
keys, or toolbar buttons.

The number of undo/redo operations supported can be set to a value between 1 and
100 (the default is 10). To adjust the number of undo/redo operations supported by
VersaPro, select the Tools menu and choose Options. |f you are about to perform an
action which, dueto its complexity or the amount of data involved, cannot be
undone, a message box will appear, warning you of this

fact.
e Toundoan action: Click the Undo toolbar button. | , select the Edit menu
and choose Undo, or press Ctrl+Z. The Undo menu option will be grayed out if
there is no previous undo operation to perform.

T
e Toredoan action: click the Redo button |_—I , select the Edit menu and
choose Redo, or press Ctrl+Y . The Redo menu option will be grayed out if there
iSno previous operation to redo.

Working with Variables while Editing Blocks

VersaPro allows you to create variables while you are working with logic. One way
to do thisisto add a block with new variables to your logic. New variables included
in an added block are checked for validity. If they are valid, they are added to the
Variable Declaration Table and are available for use.

Temporary variables must be declared if you are using Instruction List for blocks.

To create a variable when adding a block:
1. Open afolder.
2. Add ablock with defined variables to the folder.

3. Row validation is performed on each variable to check for global scope conflicts
with existing variables.
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4. |If avariablefailsrow validation, an error message appears describing the
problem.

5. Click OK. A dialog box appears alowing you to correct the problem. If the
problem is corrected, row validation continues for other variables. If you click
Cancdl, the variable is not added to the VDT, and the entire process is cancell ed.
When row validation is completed and no conflicts exig, the Variable
Declaration Tableis populated with original data and with data from the added
block.

To assign temporary variables:
1. Open thefolder for which you wish to use temporary variables.

2. Goto the Edit menu and choose Properties, Variable Table. The Properties
diaog box appears.

Select the Temporary Variables (IL) tab.

Click the Temporary Variables (IL) button.

The Boolean Address Start and Integer Address Start fields enable.
Type avalid starting bit address for Boolean temporary variables.

Type avalid starting word address for Integer temporary variables.

© N o 0 > w

The ending addresses for Bool ean temporary variables and for integer temporary
variables are automatically cal cul ated.

9. Click OK.

Note: If at any point you wish to delete the current temporary variables, you
can do so by selecting the No Temporary Variables (IL) radio button.
The memory areas used for Temporary variables may not overlap with
those used for Conversion variables. Temporary variables may not
overlap with program variables.
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Searching and Replacing in VersaPro

VersaPro provides a number of tools to navigate, locate, and search for and replace
datain folder components. This section describes the methods of locating
information and using search and replace in the Folder Browser.

Navigating in VersaPro

There are several methods of finding and going to certain pointsin folder
components:

e GoTo: Thisaction alows you to go to a specific row or rung in language editors (IL
or LD), or to locate and go to the location of a specific variable.

e Find: Thisaction allows you to locate variables, reference addresses, call references,
Jump labels, MCR labels, or instructionsin block logic.

e Edit Variable: Sdecting thiscommand from the IL or LD editor will take you to the
variable definition in the Variable Declaration Table.

Locating and going to a Rung, Row or Variable

Y ou can use the Go To feature to change focus to a specific Rung (LD Editor), Row
(IL Editor) or Variable (Variable Declaration Table).

Follow the steps below to use the Go To feature;
1. Placethe cursor in the LD Editor, IL Editor, or Variable Declaration Table.

2. Select the Edit menu and choose Go To (LD or IL Editor) or choose Go To
Variable (Variable Declaration Table). The Go To dialog box will appear.

Go To Go to Yanable

Go to row number: E nter the waniable name:
g LCancel I i '_'_! Cancel I
Help | Help |

3. Complete the dialog box as described for the LD Editor, IL Editor or Variable
Declaration Table. After entering the rung, row or name, click OK.

LD Editor: Type the number of the rung you want to go to.
IL Editor: Typethe number of therow you want to go to.

Variable Declaration Table: Type the name of the variable you want to go to.
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Locating Names, Instructions, Addresses or Call Statements in Blocks

Y ou can use the Find In Blocks feature to find all occurrences of variable names,
reference addresses, instructions, or call subroutinesin IL and LD blocks.

Note: To havethe “Find In Blocks’ feature search the entire program, you must select the
folder namein the folder browser. (Thisisthetop level itemin the browser) Otherwise,
“Find In Blocks” will only search the selected block.

iy _MAIN - LD

Follow the steps below to use Find In Blocks:

1. Sdect the blocksthat you want the Find In Blocks operation to search. If you

want to search all blocks, make sure that no blocks are selected —or- al blocks
are selected.

2. From the Folder Browser or folder components, select the Edit menu and choose
Find In Blocks. The Find In Blocks dialog box will appesr.

Find in Blocks
Search by

Call_sub |

Address Cancel |
Call_sub

IL Instruction Help |
LD Instruction

Mame

o Al

) Belected

= | Btrnts: mhly
B mplichAdaiesses

3. Complete the dialog box as follows: Click the Find button to start the search.
Sear ch By: Specifies what you are searching for

Address; Select address to search for areference address.
Call Sub: Sdlect Call Sub to search for a cal to a subroutine block.

IL Instruction: Searchesfor an Ingtruction List instruction.
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LD Instruction: Searches for a Ladder Diagram instruction.

Name: Select Nameto search for avariable name. Note that Find by Name
only searches for Global and System variables. All other Search By categories
will search for Local, aswell as Global and System variables.

Search For Sets the address, block name, ingtruction, or variable nameto be
used in the search.

Blocks: Establishes the scope of the search. Choose All blocks or Selected
blocks (searches all blocks currently selected in the Folder Browser)

Outputs Only: Limitsthe scope of the search to references used as outputs only
(cails). To limit the search to outputs only, check this box.

Implicit Addresses. Allows you to locate logic where an addressis used, but is
not referenced explicitly in the function block. To search for implicit addresses,
check this box.

The search is performed, and the results of the search appear in the Information
Window. Found items are listed by block, rung or row, and instruction. Double-
clicking an item in the Information window opens the appropriate block and sdlects
the matching e ement.

Using Search and Replace

VersaPro allows you to search for and replace elementsin block logic. You can
search for variable names, reference addresses and other elementsin block logic and
replace the search item with a new name or address.

Note: Search and Replace only works on aindividual block by block basis. This
feature does not operate across the entire program.

Follow the steps bel ow to use the Find/Repl ace feature.
1. Open theblock you want to modify I

using search and replace. Select the sl 2 SEE
Edit menu and choose Find/Replace. | 3earch By Find/Mesxt
The Find/Repl ace dialog box will | &ddress .
appear Search For: Replace
EITRE =]
2. Completethe dialog box as follows Replace With Replace Al

Search By: Usethisfidd to define |ZMDD115
what you are searching for.

Address: Select address to search for I Outputs Orly Cancel

areference address. ™ Implicit Addresses

Call Sub: Sdlect Call Sub to search
for acall to a subroutine block.

udad.

Help

Name: Select Nameto search for a variable name.
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Jump(n)/L abel(n): Select this choice to search for a Jump or Label in your
program.

MCR(N)/END_M CR(N): Select this choice to search for MCR/ENDMCR
functionsin your program.

Search For: Usethis field to set the address, block name, variable name or |abel
to be used in the search/replace

Replace With: Enter the string, address, label, or variable namethat will be
used in the replace operation.

Outputs Only: To limit the scope of the search to references used as outputs
only (cails), check this box.

Implicit Addresses. To locate addresses that are included, but not named in a
function block (for example, in an array), check this box.

3. Sdlect the action you want to perform:

Find Next: Click this button to find the (next) ingtance of the search string in
your program.

Replace: Click this button to replace the highlighted instance of the search
string in your program.

Replace All Button: Click this button to replace al occurrences of the search
string in your program.

4. To close the Find/Replace dialog box, click the Cancel button.
Note: If a Find and Replace action has been specified during the current edit
session, you can use the Find Next to locate additiona occurrences of

the search string using the Find Next command. To find the next
instance, select the Edit menu and choose Find Next, or press F3.
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Performing Syntax Checks

3-20

VersaPro provides syntax checking for logic blocks. Once you' ve created block
logic, you can check either portions of the folder or the entire folder (all blocks) for
syntax errors.

In a syntax check, ingructions within your logic are compared againg information
about the configured PLC. Any unsupported instructions are flagged.

Syntax checking is automatically performed when you store or verify logic to the
PLC.

To manualy initiate a syntax check perform the following steps:
e ToCheck All Blocks, %to the Folder Browser, click the right mouse button

and select Check All or select the Check All Blocks tool bar button.
e ToCheck Selected Blocks, highlight the blocks you want to check in the Folder

Browser, click the right mouse button and select Check Selected BIocks or
select the Check Sdlected Blocks tool bar button.

The block(s) are checked. All warnings and errors are written to the Information
Window.

If the compileis successful (0 errors), VersaPro writes the block size to the
Information Window, even if the block islarger than the maximum allowed.

Note: Y ou can navigate to the location of the syntax error by double-clicking
on the error in the Information Window.
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Converting Block Logic

VersaPro allows you to convert IL logic to LD, and LD logic to IL. Most, but not
every, formation in one language can be trandated to the other. Certain exceptiona
instructions may lead to errors upon attempted conversion. Therefore, if you intend
your logic to be trandatable, avoiding a particular set of instructions will minimize
the errors you encounter. (See "Rules for Successful Conversion™ on page 3-22.)

Note: Blocks are converted on an instruction by instruction basis, so logic
isnot optimized for the LD language. Series 90-70 and Series 90
Micro PLCs do not support IL programming.

Assigning Conversion Variables
When converting IL logicto LD, conversion variables must first be assigned as
follows:

1. Open afolder.

2. From the Edit menu, choose Properties, Variable Table, or select the Variable
Declarations node and choose Properties from the CSM.

3. TheProperties dialog box appears.

4. Select the Conversion Variables (LD) tab.

5. Select the Conversion Variables (LD) radio button.

6. Thedarting address fields for Boolean and Integer variables become enabled.
Note: If at any point you wish to delete the current conversion variables,

you can do so by selecting the No Variables (IL) radio button.

7. Toassign Boolean variables, enter avalid starting bit address.

¢ Boolean conversion variables can only be assigned in the %M, %Q and %T
Memory areas and mus start on a byte-aligned address (for example: 1, 9, 17,
etc.).

8. Toassign Integer variables, enter avalid starting word address.

¢ Integer conversion variables can only be assigned in the %R, %Al and %AQ
Memory aress.

e Starting and ending address values must bein therange 1 - 99,999
¢ Neither starting address field may be left empty.

As you type each starting address, its ending address is dynamically cal culated
and displayed in the read-only field beneath it.

9. Click OK.
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Converting Block Logic

Once conversion variables have been configured, you can select ablock for
conversion from IL to LD. Be sureto check the block's syntax before converting the
block. (Select Check Block or Check All from the Folder menu.)

1. Sdect ablock in the Folder Browser, or make the block you want to convert the
active block.

2. Sdect the Tools menu and choose Convert Block.

Thelogicin the block you are attempting to convert is checked for syntactical
validity. If thelogicisfound to be syntacticdly valid, thelogic is converted from
one language to the other, and the details of the conversion appear in the Information
Window.

If any syntax errors are found, they are logged in the Information Window and the
conversion is aborted.

Rules for Successful Conversion

The following guidelines are suggested for successful block conversion:
e IL logic containing the following instructions cannot be converted to LD
O XOR, XORN, XOR(
O ANDN(, ORN(, XORN(
o NOT

e Usethe Properties dialog box to define the use of temporary variables, which are
necessary for IL logic, and conversion variables, which are necessary whenever you
convert IL logicto the LD language.
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Converting Non-Nested Instructions

Series 90 Micro and low-end 90-30 PL Cs support non-nested forms of the MCR,
ENDMCR, JUMP, and LABEL instructions. When you import a Logicmaster folder
containing non-nested instructions or convert a Series 90 Micro folder to a
VersaMax Nano/Micro folder, these ingructions will not be automatically converted
to nested forms. To be able to compile your programs after conversion, you will need
to change these ingructions to their nested forms (MCRN, ENDMCRN, JUMPN,
and LABELN).

To convert non-nested ingructions, go to the Tools menu and select Non-Nested to
Nested Conversion. Y ou will be prompted to indicate whether you wish to proceed
with the conversion. To proceed, click OK.

Note: All non-nested instructions will be converted to their nested forms.

This conversion may increase the size of the compiled logic. Also
this conversion cannot be undone.
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GFK-1670D

Working in the LD Editor

The LD Editor window allows you to create, edit, display and monitor programs and
blocks created in ladder logic. This chapter introduces you to the LD Editor window
and how you can customizeits look as well as how to create and edit logic.

Chapter Contents
How to access the LD Editor
An overview of the LD Editor Window

How to customize the LD Editor Window display and set rung editing and cail
checking options

How to enter and edit logic
Converting LD logic between 90-70 and 90-30/V ersaMax

4-1



Overview of the LD Editor

4-2

The Ladder Diagram Editor isused to create programs using the Ladder Diagram

programming language. Ladder Diagram is used to graphically represent the actions
to be performed by a PLC.

The editor window isdivided in to rows (rungs). Each rungisdivided into cells.
Each cell can accept alogic element (function block or relay function.). The LD

Editor allows you to enter ladder logic e ements via keyboard, mouse, or toolbar. All
elements are inserted by overwriting the contents of the selected cell.

The figure below shows some of the commonly-referenced components of the LD

Editor window and browser view.

Active Cell

ok Fle Edit View

Shows active
location for inserting
additional logic.

& VersaPro - chan

Faolder

PLC T

Ladder Toolbar

functions

Provides quick access to
frequently-used LD

/@_indow Help

Example of
comment rung,

Data Table =

b ath

Al s@l [sm=le] <] Sl el o]l mlm
% 1t 1] ol Z{T}I@}I{S}I{R{I EENEENIFRETE
13 re-cne = A!l Functio_n Gro f| ADD_DINT
o s [
Controls DI _DINT
Coreeersion DIV_INT
Comment Rung gz‘t‘:ﬁ';ve Eﬁi&ﬁl_//

e
MUL_DINT

Function
Toolbars
Expanded View
Displays all
instruction
groups and
functions that
can be used in
the LD Editor.

configured for brief Numerical MULTINT
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=1 E Special SCALE_IMT
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- SUB_INT
. . Do SUB_REAL
L b
Rung Number ﬂ J 4
Displays rung
number for each
discrete rung al | Local | Al | S_l,lstern' Tempc-rar_l,ll
MHame | Type | Len | Addresg | Description | Stored Walue | 5
_||sz_FusE [E [t [xmo00p7/ [Fuseblown or Serial Fon| | Gty
_I AT TReT | T T4 y/ | - N = o | T2t
Far Help. press F1 |FurEnabled  [Cornected | 2.0msec |Equal

Variable Declaration Table
Docked at the bottom of the folder
view, provides quick access to global
variables and local variables defined
for the active block.
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Customizing the LD Editor Window

VersaPro allows you to select the format of information displayed in the LD Editor
window and control the grid and display size.

This section describes the e ements of the LD Editor window which can be
customi zed.

Customizing Ladder Display Options

When working in the LD Editor, you may want to customize the fields which display
online. Perform the following stepsto customize Ladder display options:

1. Sdect the Tools menu and choose Options, or click the right mouse button from
the LD Editor and choose Options. The Options dialog box will appear. Select

the Ladder tab.

General | Display Ladder | Communications | tF/LL Editars |

— Sshowefhide field
able name
wiReference address  Brief
WDescription & Eull
— Grid Cell Wyidth
i M
| |

¥ Cail/ Jump Justification Column; |1 0
¥ Show 8x10 Bung Indicator

(0] | Cance| Help
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2. Customizethe display optionsto suit your needs: Click the OK button to accept
changes.

Show/Hide Field: Allows you to set the fields which will display in the LD
Editor window:

Variable Name: You can set the display mode to brief or full by selecting
Variable Name and clicking the appropriate button in mode. checking the
appropriate button. Brief mode displays one line, and full mode displays up to
two lines.

Refer ence Address: To view the reference address associated with variables,
check this box.

Description: To view the variable description, check thisbox. If you want to
see the entire description, you may also need to increase the Grid Cell Width.
You can aso set the display mode to brief or full by checking the appropriate
button. Brief mode displays one line, and full mode displays up to four lines.

Grid Cel Width: Allows you to make the grid for cellswider or narrower. To
increase or decrease the width, dlide the control between Min and Max.

Cail/Jump Justification Column: If this box is checked, when you insert a cail
or Jump ingtruction, it is placed in the column specified (right justified). Vaid
values areintegers 10 to 20. If this box is not checked, coils areinserted in the
next empty column.

Show 8 x 10 Rung Indicator: When selected, displays a border that marks eight
rows and ten columns. If folder’ s hardware configuration is 90-70, thisoption is
always selected. To change the color of the border, select the Display tab,
choose LD from the Category list, and Rung Indicator from the Color list.

Adjusting the Zoom Ratio

Y ou can increase or decrease the zoom ratio for the LD Editor by click the zoom
in/zoom out buttons. To adjust the zoom ratio perform the following steps:

1. Makean LD bhlock active

2. Sdect the View menu and choose Zoom In or Zoom Out Igl You can
also click the toolbar buttons.
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| nstructions and Instruction Parameters

This section describes how to enter and modify instructions and rungsin your ladder
program. Program logic consists of elements such asrelays, timers, math functions
and other functions placed together to form rungs of logic. Variables and constants
are assigned to function parameters asinputs and outputs to the function.

Variable Combo Box
Type a new variable
name, or click the arrow

and select from list \

Typed Instruction

100002 OPCTE ' MOVEWORD |
. | Function | Function
! « Address A/ Data Len
[ ~ |¢Bo0ton 50
{1 E binl —{IN Ol binz

TNl A

/v ¥—_| Function Block Parameters

Constant

The exampl e above highlights some of the features you will encounter when entering
logic in the LD Editor.

e Typed Ingtructions (Functions): In VersaPro, many function blocks are "typed".
Thismeansthat thetype (INT, DINT, REAL) is associated with the function, not the
variable.

¢ Function Data Length: Many functionsrequire adata length, which is associated
with the function, not the variable.

e Function Address: Displaysthe reference addressiif required by the function block.

e Function Block Parameters: Input and Output parameters to function blocks must
be completed. Many function block parametersrequire variables or constant val ues,
like the Add function. Other function blocks require Boolean parameters (like
contacts) to enable or control how the function executes.

e Variable Combo Box: When assigning variables to function block parameters, the
variable combo box allows you to quickly select existing variables or create new
variables.
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Entering Instructions

There are several methods of entering instructionsinto the LD Editor to suit personal
preferences and editing styles. With VersaPro, you can enter instructions using the
Function Toolbar, Ladder Toolbar or through direct keyboard entry (where no mouse
interaction isrequired). This section describes the various ways you can enter
instructionsinto your program.

Entering Instructions using the Function Toolbar

The Function toolbar isused to select and add function blocks to your LD program.
The Function Toolbar can be displayed in either of two forms. The compact form,
which requires less room on the screen and the expanded form, which displays all the
groups and their functions.

Selecting Functions Using the Function Toolbar — Compact

4-6

The Function Toolbar, displayed in compact form, consists of a Group combo box,
an Ingruction combo box, and a Function Drop button. To select Compact form,
select the View Menu, choose Function Toolbars -> Compact. The function tool bar
will appear above the LD Editor window.

Data Move ||k _CLRwORD =

All Function Groups EHLE LLH “WLIHD
Bit Operationz BLEMOW_IMT
Booleans [JBLEMOY_REAL
Controlz BLEMOW WORD

Function Drop Button
Click button to select function,
then click in the editor window

Corversion COrM_REQ N
Colpters MOVE_BOOL to drop the function into your
‘Data Move | {MOVE_INT LD program.
Data Table 4 MOWVE_REAL
Math MOWVE_WORD
Numgrical SHFR_BIT Functions
Relational SHFR_WORD — Shows instructions
Special . .
Timer . available for the active
il Function Groups Function Group.

Click the arrow to select
a specific function
group, or to view all
function groups.
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To select afunction group, click the arrow on the Function Groups box and choose a
function group. Toview all instructions, select All Function Groups.

To sdlect an instruction, click the arrow on the Functions box — use the mouse to scan
through thelist or type thefirst few characters of the function nameto locate in the
list.

To drop the function in the LD Editor window, click the Function Drop Button,
position the cursor at theinsert location in the LD Editor window, and click to drop
the function into your program.

Selecting Functions Using the Function Toolbar — Expanded

GFK-1670D

The Function Toolbar, displayed in expanded form, consists of a Group window and
Ingruction window. To select Expanded form, select the View Menu, choose
Function Toolbars -> Expanded. The Group and Instruction windows will appear to
theright of the LD Editor window.

Al Function Groups f| ADD_DIMT -
Bit Operations ADD_IMT
Boolzans ADD_REAL
Contrals DY _DINT
Corverzion DIy _IMT
Counters DY _REAL
b ovve MO0 _DI
MOD_INT
SN || tALIL_DIMT
- Murmerical PAUL_IMT )
Function Group Relational MUL_REAL Instruction Group
Special SCALE IMT
Tirmer SCALE_WORD
SUB_DINT —
SUB_IMT
SR RFAl LI

To select afunction group, highlight the Function Group name in the Group window.
Toview al ingructions, select All Function Groups.

To select an ingtruction, use the slide control to scan the list of instructions, locating
the instruction you want to add to your program.

To drop the function in the LD Editor window, double click the instruction name
(notice that the cursor changes to afunction block icon), position the cursor at the
insert location in the LD Editor window, and click to drop the function into your
program.
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Entering Instructions using the Ladder Toolbar

Y ou can use the Ladder Toolbar to select commonly-used Bool ean functions,
comments and call instructionsto your LD program.

To select one of the toolbar instructions, smply click the toolbar button, move the
cursor to the insertion point, and click to place theinstruction.

The comment toolbar button places a comment at the current cursor location.

L.
SIS S &I EEF S
11

Note: When afunction or ingruction is seected, an instance of the function
will be inserted into your LD Program each time you click the mouse
button. To de-select the active function, click the Normal Pointer
toolbar button or press the Esc key on your keyboard.
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Entering Instructions using Keyboard Entry

Itis possibleto enter logic directly with the keyboard, rather than using the mouse.
Perform these steps to enter an instruction using keyboard entry:

1. Navigateto the cell where you want to insert an instruction.

2. Press Shift + Enter. A combo box containing the list of al instructions will
appear. (If the cell is empty, smply press Enter.)

|m:|:|:|:u. ;|

WCCON
WE_DINT
NE_INT
NE_EEAL
NEGCOIL
¥OCON
¥OT_WORD
OFLT_HUNDS
OFDT_TEWTHS

3. Tolocate the function, type the first few characters of the instruction name, or
use the arrow keys to scroll through thelist.

4. PressEnter to select the name and insert the instruction into your program.

Completing Address and Length Information

Certain function blocks require you to supply a length (for example, aMove
Ingruction) or an address (for example, a Timer Instruction) for the function to
operate correctly. Functions which require thisinformation will display ?? insidethe
function block.

Perform the following steps to compl ete address or length information:

1. Enter afunction which requires address, length, or other information. Notice the
??fields on the function block.

2. Double-click the function or select the function and press Enter. The Function
Properties dialog box will appear so that you can enter length and/or address, as

appropriate.
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] | Address ; 0K

27 : I j
ﬁ_ength :

—IN a— Im Help

3. Typealength or address, depending on the active parameter in the Function
Properties dialog box. Click OK when the information is complete.

Cancel

4. Thefunction will display the length and/or address supplied in the Function
Properties dialog box.

MOVE INT

40

DATA_INIT Functions

The DATA_INIT (datainitialization) functions supported by Series 90-70 PLCs
require additional parameters, such as Offset and VVaue, which are not displayed on
the function block. The set of parameters required depends on the type of
DATA_INIT function.

To set these parameters, double click the function or select the function and press
Enter. The Function Properties dialog box will appesr.
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Completing Function Block Parameters

After afunction block, coil or contact is added to the program, you need to assign a
variable or constant to each parameter. This section describes how to complete
function block parametersin one of the following ways:

e Assign an exigting variable to a parameter
e Creating anew variable for a parameter

e Assigning aconstant value to a parameter

Assigning Variables to Function Block Parameters

Variables can be assigned to e ements and parametersin ladder logic. Variables may
be Local Scope (local to the block) or Global Scope (Global to al blocksin the
folder). The default scope for variablesis Global Scope.

Y ou may assign an existing variable or create anew variable for the function block
parameter. This section describes how to assign variables to parameters using the
mouse and the keyboard.

Note: Y ou can also drag and drop selected variables from the Variable
Declaration Table to the function block parameter.

Note: Declaration of variables with overlaps will result in conflicts when you
attempt to Storethe stored valuesto the PLC. In order to resolve these
conflicts, you must use the VDT to relocate variables so that they do
not overlap. (For example avariable at %R8 with length 3 and a
variable at %R10 of length 2 have an overlap at %R10.)

To assign an existing variable using keyboard entry:

1. Usethearrow keys to position the cursor on the parameter where you want to
assign avariable.

2. Typeor sdect the variable asfollows:

e Tosdect avariable fromthelist of defined variables, press Enter. The variable
combo-box will appear. Use the up and down arrow keys to display the variables.
When you find the variable you want to use, press Enter to accept.

e Toenter avariable by name, smply type the variable name. Press Enter to accept.
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To assign an existing variable using the mouse:
1. Double-click on the parameter cell where you want to assign avariable. The
variable combo-box will appesr.

2. Toexpandthevariablelist, click the arrow on the combo-box. Usethe dide
control to scroll up and down through the list.

3. Sdlect thevariable from thelist. Press Enter, or click outside the parameter cell
area to accept.

To create a new variable for a function block parameter

1. Sdect the parameter cell using the keyboard or mouse

e Keyboard Select: Usethe arrow keys to position the cursor on the parameter where
you want to assign a variable. Press Enter. The variable combo-box will appear.

e Mouse Select: Double-click the parameter cell. The variable combo-box will appear.

2. Typeavariable name, reference address and scope (optional) into the edit box
using the following guidelines. (Fields must be separated by commas.)

Variable Name, Scope, Reference Address

Enter reference type and addres=
* in following formet: 100F or S%R100

Global: &, Local: L

—® vValid Charadters Include: 4-7, =z 0%, %, _(underscore), +, -, #, (@, =, =, =

e Thefollowing example shows creating avariable "LINE2_COUNT" for parameter
IN2 of the ADDINT Function.

Variable Combo Box: ADDINT

Creating Variable "LINE2_COUNT",
Reference Address %R00300,

Local Scope
\ BATCHL —|IN1

LINEZ COONT,L,200R ;I

i7 INZ
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3. Toaccept the variable, pressthe Enter key — or use the mouse to click off the
active cell.

Note: To edit information for an existing variable, select the variablein the
LD Editor, click the right mouse button and choose Edit Variable. The
variable will be highlighted in the Variable Declaration Table, alowing
you to edit information about the variable.

The exceptionsin changing LD logic involve replacing existing variables. When a
variableis replaced, information about that variableis still retained in the Variable
Declaration Table. If you replace the existing variable with a new variable, the new
variable information is added to the Variable Declaration Table. In some cases, a
constant can be replaced by a variable.

Y ou can replace avariable (or congtant) either with an existing variable, or with a
new variable.

To replace a variable with an existing variable in LD:

1. Sdect the parameter cell using the keyboard or mouse

o Keyboard Select: Use the arrow keys to position the cursor on the parameter where
you want to assign a variable. Press Enter. The variable combo-box will appear. The
current variable or constant will display in the edit field.

e Mouse Select: Double-click the parameter cell. The variable combo-box will appear.
The current variable or constant will display in the edit field.

2. Typethe name of the replacement variable, or enter a constant. Press Enter to
accept.

Assigning Constants to Function Block Parameters

Constants can be assigned to functions and parametersin ladder logic. Constant
values are displayed during monitoring, in the default type format of the element in
which each is used.

To assign a constant using keyboard entry:

1. Usethearrow keysto position the cursor on the parameter where you want to
assign a constant.

2. Typethe constant value. Press the Enter key. |If the constant isnot valid for the
function block an error message will appear.
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To assign a constant using the mouse:

1. Click thearrow button to de-sdlect any active functions. Double-click on
the parameter cell where you want to assign a variable. The variable combo-box

will appear.

2. Typethe constant value. Pressthe Enter key. If the constant isnot valid for the
function block an error message will appear.

Rules on constants

A congtant’ s value may not exceed the capacity of the operand’ stype and must be

entered in a format consistent with the Function Block type:

Format Prefix Example
Decimal (default) | None 43
Real None 43.72
Scientific None 6.93e4
Binary 2# 2#11110000
Octal 8t 8#730
Hexadecimal 16# 16#dcab
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Editing Ladder Logic

Oncelogicisinyour LD program, you may need to edit, copy, or delete sections of
logic. This section describes how to sdect logic in the LD editor, and how to delete,
copy and paste selected logic.

Selecting Logic

Before you can perform editing operations on LD logic, you need to select the logic
you plan to work with. This section describes how to select logic using the mouse
and keyboard.

To set a selection in the Ladder Editor using the mouse:

1. Make sure placement modeis g .: y clicking on the arrow button (normal
pointer) on the Ladder toolbar. -

2. Place the mouse pointer over acell or over the power rail next to arung.

3. Pressand hold the primary mouse button.

4. Drag the mouse to move the selection over the desired cells, or aong the power
rail over the desired rungs.

5. To sdect non-contiguous rungs, hold down the Ctrl key while selecting rungs.
The desired rungs are sel ected.

To set a selection in the Ladder Editor using the keyboard:

1. Make sure placement mode is off by pressing Esc.
2. Sdectcdls
e Tosdect asingle cel, navigate to the desired cell and press the spacebar.

e Tosdect agroup of cdls, navigate to acell, then hold down the Shift key while using
navigation keys to move the selection over the desired area.

e Tosdect asinglerung, navigate to the power rail and press Ctrl + the spacebar.

e Tosdect acontiguous group of rungs, navigate to the power rail. The entirerung is
implicitly selected. To select more rungs, hold down the Shift key and use the up or
down arrow keys to move the selection over contiguous rungs.

e Tosdect non-contiguous rungs, select asingle rung, hold down the Ctrl key, navigate
to another rung, and press the spacebar. Therungs are selected.
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Using Cut, Copy, Paste and Delete in the LD Editor

4-16

In the LD Editor, you can cut or copy rung(s) or cell(s) from one portion of aladder
to another portion, or from one block to another, without removing the variables
included in those rungs or cells from the Variable Declaration Table.

You can also delete selected rungs or cells.

Logic cannot be pasted from LD blocksto IL blocks, nor can you paste LD logic to
applications other than VersaPro. Y ou can, however, copy ladder logic as a bitmap
image.

Y ou can paste a variable from the VDT to the LD Editor.

This section describes the different ways you can perform cut, copy, paste, and drag-
and-drop in the LD Editor window.

To cut or copy in the LD Editor:

1. OpentheLD block you want to edit. Select rung(s) or cell(s) you want to copy
or cut.

2. Choose C Copy from the Edit or right mouse menu, click the Cut or
the Copy button on the Standard tool bar, or press Ctrl+C to Copy or Ctrl+X
to Cut. The selected information is cut or copied to the Clipboard.

To cut or copy in the LD Editor using Drag and Drop:

1. OpentheLD block you want to edit. Select rung(s) or cell(s) you want to copy
or cut.

2. ToCut (using drag and drop), position the mouse arrow over the selected logic,
press down and hold down the primary mouse button.

To Copy (using drag and drop), position the mouse arrow over the selected
logic, press and hold the CTRL key, then press and hold the primary mouse
button.

3. Movethelogic tothe appropriate area. To drop the selection, rel ease the mouse
button and/or the Ctrl key.

To copy as a bitmap in the LD Editor:

1. OpentheLD block you want to edit. Select rung(s) or cell(s) you want to copy.

2. Sdlect the Edit menu and choose Copy As -> Bitmap.

3. Thesdected information is copied to the Clipboard as a bitmap image. This
image may be pasted into any application which recognizes the bitmap image.
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To paste in the LD Editor:

1. OpentheLD block you want to edit. Select rung(s) or cell(s) you want to copy.

2. Sdect the Edit menu and choose Paste , click the Paste toolbar button or
press Cirl+V.

3. Theedementsare pasted into theladder. The paste operation overwrites any
elements previoudly existing in the destination cells. Existing comments, Labels,
or MCRs are shifted down in order to accommodate a pasted € ement(s).

To delete one or more elements:

1. InthelLD Editor, select arow or a group of rows, acell or rectangular group of
cells, or one or more rungs.

2. Select the Edit menu and choose Delete, click the Delete button on the
toolbar, or pressthe Delete key. The sdlection is deleted. Variables defined in
the deleted logic remain in the VDT.

Note: Cut/Copy/Paste/Del ete actions may be undone by sdlecting the Edit
menu and choosing Undo, or by clicking the Undo tool bar button..

Inserting an empty row in the LD Editor

Perform these steps to insert an empty row into the LD Editor.
1. Open the block you want to edit.
2. Seect any ingtruction in the row above which you wish to insert an empty row.

3. Sdlect the Insert menu and choose Row, press the Insert key, or click theright
mouse button and select Insert Row. An empty row is inserted above the
selected row. All subsequent rows move down onerow. The cell in the new row
immediately above theinsertion point isselected. If acel inthefirst row of the
rung is selected, the new row is appended to the previous rung. If acell in the
first row of thefirst rung is selected, anew rung is created above the firg rung.

To go to the next coil:

In the LD Editor, select a contact or cail.
Choose Go to the Next Cail from the Edit menu or the CSM (or press Alt + F3.)

The cursor will go to the next coil that has the same name as the contact or coil you
started from.

GFK-1670D Chapter 4 Working in the LD Editor 4-17



Converting Logic Between PLC Families

Converting Logic from 90-30/VersaMax to 90-70

Tips for Converting 90-30 Logic to 90-70 Logic

4-18

When you are creating a 90-30/VersaMax PLC program that will be converted for
use on a90-70 PLC, adhering to the following rules will minimize the effort

involved in the conversion process.

1

2
3.
4

=RO0O01 —4IM1 O j wERooooi IN1 O

#R0000z —IN2

will be transformed as follows when you replace the 90-30 comparison functions
with their 90-70 counterparts. Note that the Q output on the EQ INT function isno
longer connected to thefirst GE INT function.

Do not extend an LD rung beyond 8 rows and 10 columns.

Put all JUMPsin column 10.

Place all coilsin column 10.

Do not use a vertical wiredirectly next to afunction. Moveit over one column.
Then if you change the 90-30 version of an instruction to its 90-70 counterpart,
therest of your rung remainsthe same. For example, a90-30 origina rung such

asthefollowing

EQ INT

EQ INT
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GEINT

wRooo01 —IN1 OF

wRO0002 —{IHE

" wT00001

.
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=EO0oo — 1M1 O

=Ro000: —{IN2
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wRO0004 —{IH2
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5. Usethe ONDTR function block to simulate the 90-30-only TMR function block.
For example, the following ONDTR and TMR function blocks are roughly

equivalent:
ComInoom ' TOWTTER
|} TENTHS [
CowmIooom " |zeRooom |
1.4 E
500 —| BV
w0000 [ THE
|} TENTHS |
" [zeRooom |
500 BV

6. Simulate a90-30-only END ingtruction by creating an END labdl at the end of
the block and placing a JUMPN to the label END in place of the END
instruction. (This only worksiif the block is_MAIN.)

7. Replace a90-30 WORD_TO_REAL or REAL_TO_WORD function with a 90-
70 UINT_TO_REAL or REAL_TO_UINT.

8. Don’'t make MAIN aC block.

9. UselLDinstead of IL if at al possible. (Since Series 90-70 PLCs do not support
IL, you would need to convert IL logicto LD.)
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Issues in Logic Converted from 90-30 to 90-70

After you have converted a program from 90-30/VersaMax to 90-70, you should
look for and correct the following:

1.  When you replace a 90-30 function such as SHFR_WORD with its 90-70
counterpart that has additional parameters, existing arguments may be out of
place. For example,

SHFE
WORD
i
E O R0
5 —IK
wRo0001 ST
becomes
SHFE
WORD
10
E Of =:Ro000t
5 —H
wRo000 —|IN
—sT

2. Some of the SVCREQ functions are different between the 90-30 and 90-70. For
example, SVCREQ 26 in the 90-30 is “Interrogate 1/0”, while in the 90-70 it is
“Role Switch.” Also, the parameter data format for the same service requests
may be different in the 90-30 and 90-70. Examples are SVCREQ 7, 15, and 23.
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Converting Logic from 90-70 to 90-30/VersaMax

Tips for Converting 90-70 Logic to 90-30 Logic

The Series 90-70 PLC provides many features and functions (such as FOR,
END_FOR, EXIT_FOR) that are not avail able on the Series 90-30 PLC. Some of
them can be simulated on the 90-30 using more basi ¢ language features while others
(such as VME functions, Multiple Standalone C Programs, PSBs, or C blocks with
parameters) cannot. |f your application must use 90-70 features that cannot be
simulated on a 90-30, then you will not be able to convert the application to a 90-30
platform.

The following tips will help minimize the conversion effort in cases where
conversion to 90-30 is possible.

1. Avoid using any 90-70 instruction or function that isnot supported on the 90-30.
See the table describing 90-70 and 90-30 ingtruction differences.

2. Avoid using UINT or BCD8 types of instructions, since these types of
instructions are not available on the 90-30. Instead of UINT instructions, use
INT or DINT instructions.

3. Do not usethe CV output of timer or counter function blocks. Instead reference
the first word of the timer/counter function block memory to access the current
value (CV).

4. Do not use the power flow output of relational functions such asEQ, NE, GT,
€tc.

5. Confinethe Main program to using no more than 64 program blocks plus
_MAIN.

6. Restrict program block sizesto 16K bytes or less.

7. Donot use I/O interrupt blocks, and restrict timed interruptsto 1 (unless
converting to VersaMax, which supportsup to 16 1/0O or timed interrupt blocks).

8. Do not usethe %L, %P, or %GA through %GE memories.
9. Limit MCRN nesting to eight levels.

10. Do not use data flow between functions. Ingtead, storeto a specific variable and
then read that variable.

11. Redtrict LD topologies to conform to the more stringent 90-30 rules. This may
require the use of multiple LD rungsin place of asingle LD rung.

e Do not use power flow around functions.

e When atrangtiona coil is used, it must be the only coil in therung.
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Bool ean subexpressions must be properly nested. Do not branch into or out of a

bool ean subexpression. The following logic provides an example of an
improperly nested subexpression.

100001 =I0000Z  s<I00003
— | { | { |
' STH0605™ =cT00008 |
{ | |
100004 '
_| |—

If arung contains a function, it cannot contain any subpath starting from a

vertical. Thefollowing example shows anillegal subpath from a vertical.

100001 ' [aDDTHT]
N -
111 O wrooom
E00001 —|INZ
= I00002 ' [aODTHT]
N -
2 al :roooot
R00001 —|INZ

There cannot be any contacts after a function. The following rungisillegal in

the 90-30.
' [EDDImT]  Iooood " xTO0DM
N {
1—{IN1  Of xEooo
2 —{INZ

4-22
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Issues in Logic Converted from 90-70 to 90-30

After you have converted a program from 90-30/VersaMax to 90-70, you should
look for and correct the following:

1.  When you replace a 90-70 function such as SHFR_WORD with its 90-30
counterpart that has fewer parameters, existing arguments may be out of place.
For example, the 90-70 SHFR_WORD

©owIooon [ =EEE
| WORD |
" 100001 10
—11 E O xEO00m
5 —H
=R00001 —IN
=:R00io0 — 5T

becomes a 90-30 SHFR_WORD with misplaced arguments.

" mI0000 SHER
| HORD |
©oxIoooot 10
—1 E O =Ro0om
5 HIN
=:R00001 — 5T
" wRO000

OI—

2. Some SVCREQ functions are different between the 90-30 and 90-70. For
example, SVCREQ 26 in the 90-30 is “Interrogate 1/0”, while in the 90-70 it is
“Role Switch”. Also, the parameter data format for the same service requests
may be different in the 90-30 and 90-70. Examples are SVCREQ 7, 15, and 23.
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Differences in Language Capability in VersaPro: 90-70 vs.

90-30/VersaMax

Instruction Set Differences

90-70 90-30/Ver saM ax
FAULT, NOFLT, HIALR, LOALR, On-Transition, and N/A
Off-Transition contacts.
OFDT, ONDTR, UPCTR, DNCTR function blocks have No CV output.
CV outpui.
N/A TMR function block.
ABS, CMP functions N/A

ADD, SUB, MUL, DIV, MOD available for UINT type
and MIXED (for MUL & DIV).

N/A for UINT or MIXED.

EQ, NE, GT, GE, LT, LE, RANGE available for UINT.
All have ENO output.

N/A for UINT. No ENO output.

RANGE available for DWORD.

N/A for DWORD

AND, OR, XOR, NOT, SHL, SHR, ROL, ROR, BTST,
BSET, BCLR, BPOS available for DWORD.

N/A for DWORD

SWAP, VMERD, VMEWRT, VMERMW, VMETST,
VME_CFG_RD, DATA_INIT, DATA_INIT_COMM,
and DATA_INIT_ASCII

N/A

MOVE, BLKMOV available for UINT, DINT, DWORD.

N/A for UINT, DINT, DWORD.

SHFR has N parameter (no. of elementsto be shiftedin).

SHFR hasno N parameter. A value of 1 isassumed.

TBLRD, TBLWR, LIFORD, LIFOWRT, FIFORD,
FIFOWRT, SORT, and ARRAY_RANGE

N/A

ARRAY _MOVE, SRCH EQ, NE, GT, LT, GE, and
_LE available for UINT, DWORD.

N/A for UINT, DWORD.

Conversion functions for BCD8 (BCD8 to DINT, BCD8
to REAL, DINT to BCD8) and for UINT (UINT to
BCD4, UINT to DINT, UINT to INT, UINT to REAL,
BCD4 to UINT, DINT to UINT, INT to UINT, and
REAL to UINT)

N/A, athough has WORD to REAL which is equivalent
to UINT to REAL.

DINT to INT and INT to DINT

N/A

N/A, athough has REAL to UINT, and UINT to REAL,
which are equivalent.

Conversion functions for WORD (REAL to WORD and
WORD to REAL).

CALL block N/A on Series 90 Micro and Series 90-30. Available on
VersaMax and VersaMax Micro.

CALL PSB N/A

SUSIO, FOR, END_FOR, and EXIT_FOR N/A

N/A END

Same instruction for nested vs. non-nested jumps and
labels.

Different instructions for nested vs. non-nested jumps and
labels.

SV CREQ supports functions 1-28, 32, 39. Function 26 is
“Role Switch”.

SV CREQ supports functions 6-7, 13-16, 18, 23, 26/30
(same function), and 29. Function 26/30 is“ Interrogate
1/0.” Datafor SVCREQs 7, 15, and 23 may not be same
for 90-70 and 90-30.
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Other Language Differences

90-70

90-30/Ver saM ax

LD grid size confined to 8 rows, 10 columns.

LD grid size has no row limit. Limit of 20 columns.

JUMPs must be placed in column 10.

JUMPs may be placed in any column.

Indirect addressing available.

N/A. Use Array Move instead.

Multiple programs per folder.

N/A

Main program can contain 255 blocks plus _MAIN block.

Main program can contain 64 blocks plus_MAIN block.

C blocks can have up to 7 parameter pairs.

C blocks, no parameter pairs.

_MAIN cannot be a C block.

_MAIN may bea C block.

PSBs

N/A

C programs

N/A

90-70 can have 64 1/O interrupt blocks; 16 timed interrupt
blocks.

VersaMax can have up to 16 interrupt blocks, any
combination of I/O or timed.

Interrupt blocks can call other blocks and be called.

Onetimed interrupt block (scheduling based on block’ s
name.

Interrupt blocks cannot call other blocks or be called.

%P, %L, %GA-GE memories

N/A

Dataflow between functions.

N/A

Cannot call more than 64 unique blocks from one block.

N/A, but since folder can only have 64 blocks, essentidly
have the same limitation.

Block size up to 32K bytes.

Block size up to 16K bytes.

N/A

IL language.

Unlimited nesting of MCRNSs.

MCRN nesting limited to 8 levels.

N/A

LD topology restrictions:
No flow around functions.
Transitional coil must be only cail in rung.
No short circuits; properly nested subexpressions.

No subpaths starting from a vertical if the rung contains
afunction, unless the subpath |eads directly to a cail.

No contacts following afunction.
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Chapter

GFK-1670D

Working in the Instruction List Editor

The Instruction List Editor window allows you to create, edit, display and monitor
programs and blocks created in Ingruction List. This chapter introduces you to the IL
Editor window and how you can customize its ook as well as how to create and edit logic.
Only Series 90-30 and VersaMax PLCs support IL programs.

Chapter Contents

How to access the IL Editor

An overview of the IL Editor Window

How to customize the IL Editor Window display
How to enter and edit logic

Details about Instruction List Operation

5-1



Overview of the Instruction List Editor

5-2

The Instruction List Editor is used to create programs using the Instruction List
programming language. Ingruction List isatext-based language which consigs of a
series of instructions, which combined, represent actions to be performed ona PLC.

Row Numbers:
Lists the number for

each row in the IL Editor

Instruction List Editor Window:
Displays IL Logic. Columns include Label, Instruction,
Operand, Reference Address, Value and Comment.

\/ Label | Instuction | Oferand | Ref Addess | Walue | Comment | |
1 LO_BOCOL xI00001 5100001 ﬂ
z AND %100005 100005 ]
3 ST_EOOL wO00001 000001 Active Cell:
4 LD_EBOOL =I00001 1100001 To change the
5 AND 100002 %I00002 contents of the
3 ANDH 100005 1100005 active cell, double
7 ST_BO0L wMO0115  xMO011S click the cell.
g LON_EBOCL  »MO0115  =M00iis A combo-box will
q ST_BO0L wMO0113  xMO0113 appear, displaying
L LDBOCL  MODL3 o0t valid choices
— = based on the
12 LD_EOOL ialamn, high,... ; =I00300 insertion point
13 ST_BOOL wMO0113  xMOo0113 point.
14 LON_BOCL — %MO0113  xMO0113
15 TMFC LABEL:
3 LO_BOOL ALW_ON E00007 ,LI
DT | s e
— | )
Variable
Declaration Table
Lists all variables
Global | . .
Local I All | S_I,Isteml Tempu:uraryl which can be used in
Mame | Type | Len | Address | Des. | Sor. your IL logic.
alarm_low [Ward (1 %I00225 Glohal |
alarm_high [Bit 1 %I00300 Glahal C |

TheIL Editor containsthe following columns/fields:
Label: Displays alabd that can be referenced by a JUMP instruction.

Instruction: Displays the function name. Instructions are entered by clicking on the
Ingruction field and then typing or selecting from the drop-down list.

VersaPro™ Programming Software User's Guide — November 2004

Reference Address: Displays the memory location of the operand.
Value: Theactual value of the operand in the PLC.

Comment: Displays an optional comment about the instruction.

Operand: Displays the variables or constants used by the instruction. Operands are
entered by clicking on the field and then typing or selecting from the drop-down list. This
list only displays variables appropriate to this type of instruction.
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Customizing the IL Editor Display
Y ou can customize font selection and color for the IL Editor. Perform the following steps
to customize the display:

1. From the Folder Browser, click the Tools menu and select Options. The
Options dialog box will appear. Select the Display tab.

Options !

General Display | Ladderl Eummunicatiunsl

LCategary i~ Colors

| -
| |Backaground
| | Comments ~

Font Size
[M5 Seri N E =l
Sample

‘ AaBEbryEz

Ok I Cancel Help

2. You can changethe font selection and change the colors used for the display of
online values (animate), background display color and color used to display
comments.

3. Makethedesired changes. Click OK to accept.
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Entering Instructions and Instruction Parameters

This section describes how to enter and modify IL logic. Instructions consist of program
elementsto perform Boolean logic and execute functions such astimers, math functions
and other functions. Variables and constants are assigned as operands for the instruction.

Selecting the Instruction

Ingructions are selected directly in the IL Editor window. To add anew instruction or
change an existing instruction, perform the following steps:

1. Sdect thelocation where you want to add a new instruction or modify an existing
instruction.

2. Double-click the cell. The Ingruction combo-box will appear, as shown below.

| Imstruction | Operand | Fiea:h:llress | Yalue | Commert | |

{r=]

—_
(=]

i1

12
13
14
13
16

17

1]

»I00001 -
1000053

LD_EBOOL 100001
AND =I00003
ST_BOOL 000001 000001

LD_EOCOL 100001

»I00001

o E|

X

ADD_INT[ -
ADD REAL —

AND(
AND_WORD(

ANDN

ANDN|

ARRAY MOVE_BOOL|
ARRAY MOVE_BYTE[

15
15
K
M

|2
K

ARRAY_MOVE _DINT[ =

— ol

3. Sdect theingtruction. Functionsare identified asFUNCTION_NAME{. If a
function is selected, parameters will appear between the brackets framing the function

block.

4. Thenew instruction isinserted into the IL program.
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Completing Address and Length Information

Certain ingructions require you to supply a length (for example, a Move Instruction) or an
address (for example, a Timer Ingtruction) for the instruction to operate. Instructions
which require thisinformation will show a Length or Address field in the Instruction
column as shown below. Simply enter alength or address, as appropriate.

Label | Instuction | Operand |
ST_ROOL  %MOo113 The MOVE_INT
LABELS: instruction
LABELZ: requires a length
MOWE _IMTY to operate
= correctly.
Length =
==
) The TMR_HUND
TMR HURNC instruction
N requires an
Adgress address to
P = operate correctly.

Completing Instruction Parameters

After an ingruction is added to the program, you need to assign avariable or constant to
each instruction operand. This section describes how to compl ete instruction operandsin
one of the following ways:

e Assign an existing variable to an operand
e Creating anew variable for an operand

e Assigning aconstant value to an operand

Assigning Variables to Instruction Operands

Variables can be assigned to instruction operands. Variables may be Local Scope (local to
the block) or Global Scope (Global to al blocksin the folder). The default scope for
variablesis Global Scope.

Y ou may assign an existing variable or create anew variable for the instruction operand.
This section describes how to assign variables to parameters usng the mouse and the
keyboard.
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To assign an existing variable using keyboard entry:

1

Use the arrow keys to position the cursor on the operand where you want to assign a
variable.

Type or select the variable as follows:

To select avariable from the list of defined variables, press Enter. The variable
combo-box will appear. Use the up and down arrow keys to display the variables.
When you find the variable you want to use, press Enter to accept.

To enter avariable by name, simply type the variable name. Press Enter to accept

To assign an existing variable using the mouse:

1

Double-click on the operand where you want to assign avariable. The variable
combo-box will appear.

To expand the variable ligt, click the arrow on the combo-box. Use the dlide control
to scroll up and down through thelist.

Select the variable from thelist. Press Enter, or click outside the operand areato
accept.

To create a new variable for an instruction operand:

1

Select the instruction operand using the keyboard or mouse

Keyboard Select: Use the arrow keys to position the cursor on the operand where
you want to assign a variable. Press Enter. The variable combo-box will appesr.

M ouse Select: Double-click the operand. The variable combo-box will appear.

Type a variable name, reference address and scope (optional) into the edit box using
the following guidelines. (Fields must be separated by commas.)

VYariable HName, Scope, Reference Address |

Enter reference type and address
in following format: 100F ar SR100

Global: G, Local: L

—* valid Characters Include: 4.7, az 0-5, %, _(underscore), +, - #, @, =, =, =

The following example shows creating avariable "pl_count" for parameter IN of the
MOVE_INT Function.
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Assigning Constants to Instruction Operands

GFK-1670D

MOWE_IMTC
M = p1_count, L, 707r j
Lenoth =[ezno0011, G .
== %R00020, G
] %R00100, L
TMR_HUMC|%R00200, G
l&'ddregg %HHHEEEJ G
Py = %R00300, G
) 2%R00%00, G
alarm low, G
p— Parts_total, G !
Tot _parts, G bl |

3. Toaccept the variable, pressthe Enter key — or use the mouse to click off the active

cell.

Constants can be assigned to instruction operands.

To assign a constant using keyboard entry:

1. Usethearrow keysto position the cursor on the instruction operand where you want

to assign a constant.

2. Typethe constant value. Press the Enter key.

Rules on constants

A congtant’s value may not exceed the capacity of the operand and must be entered in a
format consistent with theingtruction type.

Format Prefix Example
Decimal (default) None 43
Real None 43.72
Scientific None 6.93e4
Binary 2# 2#11110000
Octal 8# 8#730
Hexadecimal 16# 16#dcab
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Using Cut, Copy, Paste and Delete in the IL Editor

5-8

Inthe L Editor, you can cut or copy row(s) or cell(s) from one portion of Instruction List
logic to ancther portion, or from one block to another, without removing the variables
included in those rungs or cells from the Variable Declaration Table.

You can also delete selected rungs or cells.

This section describes the different ways you can perform cut, copy, paste, and drag-and-
drop in the IL Editor window.

To cut or copy in the IL Editor:

1. OpenthelL block you want to edit. Select row(s) or cell(s) you want to copy or cut.

2. Choose Cut or Copy from the Edit or right mouse menu, click the Cut or the

Bo
Copy button on the Standard tool bar, or press Ctrl+C to Copy or Ctrl+X to Cut.
The sdlected information is cut or copied to the Clipboard.

Note: You can only copy a part of a multi-row instruction astext. If you
copy asinglerow of a multi-row instruction, the selection cannot be
pasted back into VersaPro.

To cut or copy in the IL Editor using Drag and Drop:
1. OpenthelL block you want to edit. Select row(s) or cell(s) you want to copy or cut.

2. ToCut (using drag and drop), position the mouse arrow over the selected logic, press
down and hold down the primary mouse button.

To Copy (using drag and drop), position the mouse arrow over the selected logic,
press and hold the CTRL key, then press and hold the primary mouse button.

3. Movethelogic to the appropriate area. To drop the selection, rel ease the mouse
button and/or the Ctrl key.

To copy as tab-delimited text for pasting into another application:

1. OpenthelL block you want to edit. Select row(s) or cell(s) you want to copy.

2. Sdlect the Edit menu and choose Copy as Text.

3. Thesdected information is copied astab-delimited text, and becomes available for
pasting into any application that accepts tab-delimited text.
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Instruction List Operation

The IL programming language is an Accumulator based language. The instructions
executed by the IL program modify or use an Accumulator that islocated in PLC memory.
The Accumulator also has a Type associated with it that has been set by an operator or
Function call.

The operatorsthat can be used in an IL program arelisted in the following table. Since IL
is an accumulator-based programming language, the operators work directly on the
Accumulator. Comparison operators have a Boolean (1 or 0) result depending upon the
result of the operation. Operands for IL instructions can be in the form of Variables,
References, or Constants. Operators and Functions are unconditionally executed when
encountered inthe IL program. That is, an instruction is executed regardless of the result
of aprevious instruction.

The LD* (Load) operators are used to set the contents of the accumulator to the value of
the variable or constant specified by the operand. The LD operators also set the Type of
the accumulator. The ST* (Store) operators are used to set the value of the variable
specified by the operand to the contents of the accumulator. Theremainder of the
operators manipulate the contents of the accumul ator or perform an action based on the
accumulator’ s value. For the Math and Relationa operators, the type of the accumulator

must be Integer.
Operator Operand Description / Effect on Accumulator
LD_BOOL Discrete Variable or Ref Accumulator := Boolean Variable
Address Load the contents of the Boolean variable into the
Accumulator. Accumulator Type set to Boolean.
LDN_BOOL Discrete Variable or Ref Accumulator := NOT Variable
Address L oad the negative contents of the Boolean variable into
the Accumul ator.
Accumulator Type set to Boolean.
LD_INT Variable, Ref Address, or Accumulator = Integer Variable
constant Load the contents of the Integer variableinto the
Accumulator. Accumulator Type set to Integer.
LD_ENO None Accumul ator := Boolean ENO
Load the contents of the ENO (Enable Output) from the
last Function or Function Block call into the
Accumulator.
Accumulator Type set to Boolean.
ST_BOOL Discrete Variable or Ref Variable := Boolean Accumulator
Address Store the contents of the Boolean Accumul ator to the
Boolean variable.
Accumul ator value and Type are unchanged (Bool ean).
STN_BOOL Discrete Variable or Ref Variable := NOT Boolean Accumul ator
Address Store the negative contents of the Boolean Accumulator
to the Boolean variable.
Accumul ator value and Type are unchanged (Bool ean).

GFK-1670D Chapter 5 Working in the Instruction List Editor 5-9



Operator Operand Description / Effect on Accumulator
ST_INT Variable or Ref Address Variable := Integer Accumulator
ST _DINT Variable := Double Integer Accumulator
ST REAL Variable := Real Accumulator
ST _WORD Variable := Word Accumul ator
Store the contents of the Integer, Double Integer, Red,
or Word Accumulator to the variable.
Accumul ator value and Type are unchanged.
S Discrete Variable or Ref Set Coil Variable := Boolean Accumul ator
Address Store the contents of the Boolean Accumulator to the Set
Caoil Boolean variable.
Accumul ator value and Type are unchanged (Bool ean).
R Discrete Variable or Ref Reset Coil Variable := Boolean Accumul ator
Address Store the contents of the Boolean Accumulator to the
Reset Coil Boolean variable.
Accumul ator value and Type are unchanged (Bool ean).
NT Discrete Variable or Ref Negative Transition Variable := Boolean Accumul ator
Address Store the contents of the Boolean Accumulator to the
Negative Transition Coil Boolean variable.
Accumul ator value and Type are unchanged (Bool ean).
PT Discrete Variable or Ref Positive Transition Variable := Boolean Accumulator
Address Store the contents of the Boolean Accumulator to the
Positive Transition Coil Boolean variable.
Accumul ator value and Type are unchanged (Bool ean).
NOT None Accumulator := NOT Accumulator
Invert the Boolean state of the Accumul ator.
Accumul ator Type unchanged (Bool ean).
AND Discrete Variable or Ref Accumulator ;= Accumulator AND Boolean Variable
ANDN Address Accumulator := Accumulator AND NOT Boolean
AND( Variable
Accumul ator := Accumulator AND Boolean expression
Accumul ator Type unchanged (Bool ean).
OR Discrete Variable or Ref Accumulator := Accumulator OR Boolean Variable
ORN Address Accumulator := Accumulator OR NOT Boolean
OR( Variable
Accumulator := Accumulator OR Boolean expression
Accumul ator Type unchanged (Bool ean).
XOR Discrete Variable or Ref Accumulator := Accumulator XOR Boolean Variable
XORN Address Accumulator ;= Accumulator XOR NOT Boolean
Variable
Accumul ator Type unchanged (Bool ean).
ADD Variable, Ref Address, or Accumul ator := Accumulator + operand
Constant Accumul ator Type unchanged (Integer).
SUB Variable, Ref Address, or Accumulator := Accumul ator - operand
Constant Accumul ator Type unchanged (Integer).
MUL Variable, Ref Address, or Accumulator := Accumul ator * operand
Constant Accumul ator Type unchanged (Integer).
DIV Variable, Ref Address, or Accumulator := Accumulator / operand
Constant Accumul ator Type unchanged (Integer).
VersaPro™ Programming Software User's Guide — November 2004 GFK-1670D
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Operator Operand Description / Effect on Accumulator
MOD Variable, Ref Address, or Accumul ator := Accumulator MOD operand
Constant Accumul ator Type unchanged (Integer).
GT Variable, Ref Address, or Accumul ator := (Accumulator > operand)
Constant Accumul ator Type set to Boolean.
GE Variable, Ref Address, or Accumulator := (Accumulator >= operand)
Constant Accumul ator Type set to Boolean.
EQ Variable, Ref Address, or Accumul ator := (Accumulator = operand)
Constant Accumul ator Type set to Boolean.
NE Variable, Ref Address, or Accumulator := (Accumulator != operand)
Constant Accumul ator Type set to Boolean.
LE Variable, Ref Address, or Accumulator := (Accumulator <= operand)
Constant Accumul ator Type set to Boolean.
LT Variable, Ref Address, or Accumulator := (Accumulator < operand)
Constant Accumul ator Type set to Boolean.
RET None Unconditional Return from Block
RETC Return from Block if Boolean Accumulator has va ue of
RETCN 1
Return from Block if Boolean Accumulator has va ue of
0
JMP Label Unconditional Jump to | abel
JMPC Jump to labd if Boolean Accumulator has value of 1
JMPCN Jump to label if Boolean Accumulator has value of 0
CAL Subroutine Name Unconditional Call Block
CALC Call Block if Boolean Accumulator has value of 1
CALCN Call Block if Boolean Accumulator has value of 0
FUNC_NAME( | Variable, Ref Address, or Call built-in PLC Function.
IN1:= Constant, dependent upon Accumul ator value and Type are set to val ue and type of
IN2:= type of the function Output parameter Q1, if it exists.
Q2=> parameters.
)
) End of Boolean nested operation.
Accumul ator value and Type are unchanged (Bool ean).
Constants
The IL editor supports the following constants for use as operands : Integer, Real, Real
with exponents, Base 16 (16#xxxx), Base 8 (8#xxx), and Binary (2#xxxxxxxx). To use a
Constant of 1 or 0 for an operand used with a Boolean operator, the ALW_ON (1 or
TRUE) and ALW_OFF (0 or FALSE) System variables must be used.
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Functions

Functions are invoked using formal input lists. Functions are a so unconditionally
executed, regardless of the result of a previous instruction. Functions usualy place their
result in the Accumulator. The type of the accumulator is also usualy determined by the

function.
“AddResultGt100 = ({SQRT _IHNT{Inputl) > 100}
SQRT INT{
IH:= Inputl “Input to Function call
]
GT 100
5T BOOL AddResultzti100 “*Set to TRUE if result greater than 100

Function Blocks

Function Blocks are also invoked using formal input lists. Function Blocks are also
unconditionally executed, regardless of theresult of a previous instruction. Function
Blocks usually place their result in the Accumulator. The type of the accumulator is also
usually determined by the function block. The Address of a Function Block is an input

parameter.
UPCTR(
Address := sROO0D22
R := sMOo0012
PY := 1
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PLC Built-in Functions and Function Blocks

The following PLC Built-in Functions and Function Blocks can be called by the IL
program. The resulting Accumulator’ s value and Type are al so specified for each function
and function block. A Yesin the ENO column indicates that the function or function block
sets the ENO (Enable Output) variable. The table al so indicates whether the function or

function block requires the accumulator to be initialized by placing an LD Bool ingtruction
in front of the function block.

Function or Function Block ENO Requires Resulting Accumulator

LD Boolean Value and Type
Instruction

Timers and Counters (Function Blocks)

ONDTR_TENTHS Yes Yes N/A

ONDTR_HUNDS Yes Yes N/A

ONDTR_THOUS Yes Yes N/A

TMR_TENTHS Yes Yes N/A

TMR_HUNDS Yes Yes N/A

TMR_THOUS Yes Yes N/A

OFDT_TENTHS Yes Yes N/A

OFDT_HUNDS Yes Yes N/A

OFDT_THOUS Yes Yes N/A

UPCTR Yes N/A

DNCTR Yes N/A

Standard Math (Functions)

ADD_INT Yes Output Parameter Q, Integer

ADD_DINT Yes Output Parameter Q, Double Integer

ADD_REAL Yes Output Parameter Q, Redl

SUB_INT Yes Output Parameter Q, Integer

SUB_DINT Yes Output Parameter Q, Double Integer

SUB_REAL Yes Output Parameter Q, Red

MUL_INT Yes Output Parameter Q, Integer

MUL_DINT Yes Output Parameter Q, Double Integer

MUL_REAL Yes Output Parameter Q, Redl

DIV_INT Yes Output Parameter Q, Integer

DIV_DINT Yes Output Parameter Q, Double Integer

DIV_REAL Yes Output Parameter Q, Redl

ADD_INT Yes Output Parameter Q, Integer

ADD_DINT Yes Output Parameter Q, Double Integer

ADD_REAL Yes Output Parameter Q, Redl

MOD_INT Yes Output Parameter Q, Integer

MOD_DINT Yes Output Parameter Q, Double Integer

SQRT_INT Yes Output Parameter Q, Integer
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Function or Function Block ENO Requires Resulting Accumulator
LD Boolean Value and Type
Instruction
SQRT_DINT Yes Output Parameter Q, Double Integer
SQRT_REAL Yes Output Parameter Q, Redl
Trig Functions (Functions)
SIN Yes Output Parameter Q, Redl
COS Yes Output Parameter Q, Redl
TAN Yes Output Parameter Q, Redl
ASIN Yes Output Parameter Q, Redl
ACOS Yes Output Parameter Q, Redl
ATAN Yes Output Parameter Q, Redl
L ogarithmic/Exponentid Functions
(Functions) Yes Output Parameter Q, Redl
LOG Yes Output Parameter Q, Redl
LN Yes Output Parameter Q, Redl
EXP Yes Output Parameter Q, Readl
EXPT
Radian Convers on Functions (Functions)
RAD_2 DEG Yes Output Parameter Q, Redl
DEG 2 RAD Yes Output Parameter Q, Redl
Relationa Functions (Functions)
EQ INT No Output Parameter Q, Boolean
EQ DINT No Output Parameter Q, Boolean
EQ REAL No Output Parameter Q, Boolean
NE_INT No Output Parameter Q, Boolean
HE:E)IE'\/LTL No Output Parameter Q, Boolean
GT_INT No Output Parameter Q, Boolean
GT DINT No Output Parameter Q, Boolean
GT_REAL No Output Parameter Q, Boolean
GE_INT No Output Parameter Q, Boolean
GE_DINT No Output Parameter Q, Boolean
GE_REAL
LT INT No Output Parameter Q, Boolean
LT DINT No Output Parameter Q, Boolean
LT REAL No Output Parameter Q, Boolean
LE INT No Output Parameter Q, Boolean
LE DINT No Output Parameter Q, Boolean
LE_REAL No Output Parameter Q, Boolean
No Output Parameter Q, Boolean
No Output Parameter Q, Boolean
Relationa Functions (Functions)
RANGE_INT No Output Parameter Q, Boolean
RANGE_DINT No Output Parameter Q, Boolean
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Function or Function Block ENO Requires Resulting Accumulator
LD Boolean Value and Type
Instruction
RANGE_WORD No Output Parameter Q, Boolean
Bit Functions (Functions)
AND_WORD Yes Output Parameter Q, Word
OR_WORD Yes Output Parameter Q, Word
XOR_WORD Yes Output Parameter Q, Word
NOT_WORD Yes Output Parameter Q, Word
Bit Functions (Functions)
SHL_WORD No Output Parameter B2, Boolean
SHR_WORD No Output Parameter B2, Boolean
ROL_WORD Yes N/A
ROR_WORD Yes N/A
BTST_WORD No Output Parameter Q, Boolean
BSET WORD Yes N/A
BCLR_WORD Yes N/A
BPOS WORD Yes Output Parameter POS, Integer
MSKCMP_WORD No Output Parameter MC, Boolean
MSKCMP_DWORD No Output Parameter MC, Boolean
Data Move Functions (Functions)
MOVE_BOOL Yes N/A
MOVE_INT Yes N/A
HOvE oD e
Yes N/A

Data Move Functions (Functions)
BLKMOV _INT Yes N/A
BLKMOV_WORD Yes N/A
BLKMOV_REAL Yes N/A
BLKCLR_WORD Yes N/A
SHFR BIT Yes Yes N/A
SHFR_WORD Yes Yes N/A
COMM_REQ No Output Parameter FT, Boolean
Data Move Function Blocks (Functions)
BIT_SEQ Yes Yes N/A
Table Functions (Functions)
ARRAY_MOVE_INT Yes N/A
ARRAY_MOVE_DINT Yes N/A
ARRAY_MOVE BIT
ARRAY_MOVE BYTE Yes N/A
ARRAY_ MOVE_WORD Yes N/A
SRCH_EQ INT Yes N/A
SRCH_EQ_DINT Yes Output Parameter FD, Boolean

SRCH_EQ BYTE

GFK-1670D
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Function or Function Block ENO Requires Resulting Accumulator
LD Boolean Value and Type
Instruction
SRCH_EQ_WORD Yes Output Parameter FD, Boolean
SRCH_NE_INT Yes Output Parameter FD, Boolean
SSS%H_HE_QLNTTE Yes Output Parameter FD, Boolean
SRCH NE WORD Yes Output Parameter FD, Boolean
SRCH:GT:INT Yes Output Parameter FD, Boolean
SRCH_GT_DINT Yes Output Parameter FD, Boolean
SRCH_GT_BYTE Yes Output Parameter FD, Boolean
SRCH_GT_WORD Yes Output Parameter FD, Boolean
ig::gE:mT Yes Output Parameter FD, Boolean
SRCH_GE BYTE Yes Output Parameter FD, Boolean
SRCH_GE_WORD Yes Output Parameter FD, Boolean
SRCH_LT_INT Yes Output Parameter FD, Boolean
SRCH_LT_DINT Yes Output Parameter FD, Boolean
SRCH LT BYTE
SRCH:LT:WORD Yes Output Parameter FD, Boolean
SRCH_LE_INT Yes Output Parameter FD, Boolean
SRCH_LE DINT Yes Output Parameter FD, Boolean
SRCH_LE BYTE Yes Output Parameter FD, Boolean
SRCH_LE_WORD Yes Output Parameter FD, Boolean
Yes Output Parameter FD, Boolean
Yes Output Parameter FD, Boolean
Yes Output Parameter FD, Boolean
Yes Output Parameter FD, Boolean
Yes Output Parameter FD, Boolean
Conversion Functions (Functions)
INT_TO BCD4 Yes Output Parameter Q, Word
BCD4 TO_INT Yes Output Parameter Q, Integer
INT_TO _REAL Yes Output Parameter Q, Integer
DINT_TO_REAL Yes Output Parameter Q, Integer
BCD4 TO _REAL Yes Output Parameter Q, Integer
WORD_TO_REAL Yes Output Parameter Q, Integer
REAL_TO WORD Yes Output Parameter Q, Word
REAL_TO_INT Yes Output Parameter Q, Integer
REAL_TO DINT Yes Output Parameter Q, Double Integer
Control Functions (Functions)
DOIO Yes N/A
SVC REQ Yes N/A
Control Function Blocks (Function
Blocks) Yes Yes Output Parameter CV, Integer
PID_IND Yes Yes Output Parameter CV, Integer
PID_ISA
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Function or Function Block ENO Requires Resulting Accumulator

LD Boolean Value and Type
Instruction

New Series 90-30 (36x) Function Blocks

(Function Blocks)

SER Yes | Yes N/A

VersaMax Release 1.1 and later Function

Blocks

DRUM Yes Yes Output Parameter Q, Word

SCALE_INT Yes Output Parameter OUT, Integer

SCALE_WORD Yes Output Parameter OUT, Word

Nesting of Boolean Expressions

The user can nest Boolean expressions using the AND( and OR( operators up to anesting
level of 8. When anested Boolean expression is started with an AND( or OR (operator,
the next instruction must bea LD _BOOL or LDN_BOOL operator. The only operators
that are allowed within anested Boolean expression are: S, R, ST_BOOL, STN_BOOL,
NT, PT, NOT, AND*, OR*, and XOR*. Nested Bool ean expressions can be used to
evaluate complex Boolean equations. A sample nested Boolean expression is as follows :

LD_EBOOL
AND(
LD_EOOL
OR

AND

OR(

LD _EOOL
OR
5T_BOOL
ANDN

)
AND

OR

)
3T _BOOL

%0I00001

I00002
%%TO0010
%% TO0011

HTO0032
HTO0033
ShI000T?
% TO00E=

wWTO00E=
H00067

%% TO0099

%I00001

%I00002
%% TO0010
%TO00011

wTO0032
% TO0032
SMI000Ty
% TO00%=

% TO00E=
H00067

% TO0099

No control instructions or function calls may be placed within nested Boolean expression.
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Using ENO

When a function or function block is executed, it's ENO output is used to indicate the
successful execution of the function block. If an error occurs when the function is
executed, it will set or reset the ENO output. The user can check the status of the ENO
output by using the LD_ENO operator to load the ENO output value into the
Accumulator. The user can then examine this valuefor error handling.

“Calculate the following expression
%R00005 = (% F00001 + 100 * %R00077
Het caleOF variable to 1 if caloulation successfial

ADD DINT(
IM1 = SaRO0001 SeR00001
INZ = 100
ST _DINT SaRO0003 SeRO00003
LD _ENO “LD_ENO used to get ENO output of ADD DINT
JLPCH Brtor:
UL DINT(
IM1 = SaRO0003 SeRO00003
INZ = SaRO007Y SRO007Y
)
ST _DINT SaRO0005 SeRO0005
LD _ENO “LD_ENO uszed to get ENO output of MUL_DIN
JLPCH Brtor:
LD BOOL ALW 0N SaR00007
ST _BOOL calcO k. Y 00077 “cale0k =1
RET
BITOL
LD BOOL ALW OFF 00008
ST _BOOL caleO R 00077 “raleDk =10
RET
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Defining Temporary Variables

When programming in Ingtruction List, the user must define the memory locations to be
used by the IL Accumulator. Y ou must define eight consecutive discrete pointsin %T,
%M, or %Q memory for use as the Boolean Accumulator. Y ou must also define two
words of reference memory in %Al, %AQ, or %R memory for use as the Word, Integer,
Double Integer, and Real Accumulator. To define IL Temporary Variables, go to the Edit
menu and select Properties, Variable Table. Once temporary variables have been defined,
these references may not be referenced directly in the program.

Error Checking

GFK-1670D

Thefollowing error checking is performed on the IL program when it is compiled.

1
2.

Ea

© © N o o0

The type of the Accumulator must be compatible with the type of the operator.

A LD ingtruction or Function call must occur before a ST instruction. (Accumulator
must have aValue and Type.)

Parenthesis of nested expressions must be matched.

Reference Types must be correct for operators. For example, can't do a“S %R00001”
since data type must be bit.

JMPs and MCRs must have matching | abels.

All variables must be defined.

CALs must have matching IL/LD Blocks.

Reference Addresses must be within the limits of the configured CPU.

Function and Function Block parameters must be the correct memory types and
values.

Chapter 5 Working in the Instruction List Editor 5-19



Chapter | Working with the Variable Declaration Table

The Variable Declaration Table (VDT) isthe window used to creete, edit and view
variables online. The VDT usually displays automatically when the Folder Browser is
open. If the VDT is not displaying from the Folder Browser, select the View menu and
select Variable Declaration Table, or click the Variable Declaration Table toolbar button

&=

This chapter introduces you to variables and describes how to create variables for use in
your LD and IL programs.

Chapter Contents

e Anoverview of the Variable Declaration Table (VDT)

e Anintroduction to variables

e How to create and edit variables

e How towork with variables using standard cut, copy and paste commands

¢ How to delete variables and compact and save the VDT

e How toimport and export variables to and from SNF Files

GFK-1670D 6-1



Overview of the Variable Declaration Table

The Variable Declaration Table is organized into tabs. Each tab displays variables as
described bel ow:

Global Tab: Displaysal Global variables.

Local Tab: Displays variables local to the active block. If no block is open the Local tab
is blank.

All Tab: Displays all variables, Global and Local.

System Tab: Displays System variables. These variables are not editable, but they can be
used in logic.

Temporary Tab: Displays variables created in the Variable Table Properties dialog box
for temporary usein the IL Editor. Temporary variables are not editable.

A sample Variable Declaration Table is shown below.

MName Type Len | Address | Description | Stored Yalue pe Fet | Ouwr Ext
S 100061 Bit 1 22100081 _D/ Global W
%QUUDIB Bt 1 > Variab|e Scope Global U’
2500051 Eit 1 * Global variables may be used on | Glohal ol
22100082 Bit 1 ¢ all blocks. Glohial v
200020 Bit TRE %kmage?: t‘;\ZEd Glabal v
%QU005: Bit 1 ? var?/alble is define\(/iv. Glabal d
100043 Bit 1 2 Clobal i
000001 Bit 1 >000001 Clobal s
100054 Bit 1 2100084 Clobal s
22000017 Bit 1 22000017 Global W
22100085 Bit 1 22100085 Glohal W
22000018 Bit 1 22000014 Global W
2200000 Bit 1 AR Glahal W
VDT Tabs Bit 1 22100086 Global v
\(/:;:i:;ball;:g tt‘;"'e"" Eit 1 |%qooni Global s
different scope Bit 1 22100087 Clobal v
— —! |Bit 1 22000014 Clobal v
[>z100088 }ﬁuﬁ\ 1 2100058 Global W
1[5 Global Loca Al System Temporan |i|

6-2
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Variable Table Field Descriptions

GFK-1670D

This section describes the fiel ds which are included when defining a variable.

Name

In variable programming, names are assigned to memory addresses. Y ou can assign a
logical name, or let the reference address match the variable name. If you do not assign a
name for the variable, the reference addressis automatically used asaname. A variable
name can be no longer than 31 characters, and may only consist of the charactersA - Z, a-
z,0-9, _,+ - # @, <,> = Variablenames must start with aletter or underscore (*_").
For alist of reserved words, see page 6-4.

Type

Each variable must be assigned a data type describing how the variable isto be used in the
program. VersaPro alows you to assign a variable a Bit, Byte, or Word data type.

Length

The Length field specifies the amount of datathat avariable isto use. For word data type,
length specifies the number of words. For Byte data type, theit specifies the number of
bytes. For bit data type, the length must be 1. The Data Length defines the amount of
Stored Vaue Datathat is specified for avariable.

Address

A reference address links a variable with a physical location in the PLC.

Description

The Description field allows you to enter descriptive information about avariable. The
field is optiona and may be left blank. Descriptions can be no longer than 64 characters.
Stored Value

Any initial value specified for avariablein the Variable Declaration Table istransferred to
the PLC upon program transfer, even if the variable isnot used in the program. Such
values are considered an attribute of the variable. Y ou can specify as much information
per variable asthe Reference Table will hold.

Scope

Scope defines the areas where a variable can be used in afolder. The possible values for
scope are “Global” and (for each block in the folder) “Local: <block name>". System
variables are pre-defined for use by the PLC CPU.
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Retentive

The Retentive field specifies whether or not the selected variable retains its val ue after
loss of power. Theretentive state shown inthe VDT initidizes the variable when stored.
It does not show the current retentive state aslogic isrunning. VersaPro requiresthat the
retentive state be checked for al memory areas except %M, %Q, and %T. Row validation
automatically corrects any incorrect settings for al but these areas.

Overrides

Overrides are tools for program checking and maintenance. Y ou can test aprogram in a
PLC that isnot connected to 1/O hardware by using overrides to smulate inputs. Y ou can
also check a program when 1/0O hardware is connected by using overrides to prevent coail
operation. Overrides can temporarily bypass a failed input device so that machine
operation can continue until the device can be repaired. However, using overridesin this
manner can cause the overriding of safety devices and isnot recommended. The override
state shown in the VDT initializes the variable when stored values or overrides are stored.
It does not show the current override state asaprogram is running. Override may only be
checked on a non-system bit variable assigned to %G, %l, %M, or %Q.

EXT

When the EXT (show externally) field is selected, the variable can be shared by other
applications.

Reserved Words

6-4

In addition to function block names, the following words are reserved and may not
be used as variable, program, block, label, or task names:

AUX LPT1
CLOCK$ LPT2
comM1 LPT3
comM2 LPT4
COM3 LPTS
COoM4 LPT6
COM5 LPT7
COM6 LPT8
comM7 LPTO
CoM8 NUL
COM9 PRN
CON
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Creating and Modifying Variables

VersaPro allows you to create and modify variables for use in program logic. Variables

can have different data types, scopes, lengths, and addresses. Several variables can

reference the same address, and you can associate descriptions and initia stored values
with any variable. VersaPro allows you to create and modify variables on the fly or prior
to program construction.

System Variables (%S, %SA, %SB, %SC) cannot be edited. They are present in the

variable list whenever anew folder is created.

Modifications that you make to variablesin the Variable Declaration Table arereflected at
all reference pointsincluding program logic.

Note:

Declaration of variables with overlaps, for example avariable a %R8

with length 3 and a variable a %R10 of length 2 have an overlap a

%R10, will result in stored value conflicts when you attempt to Store
the stored valuesto the PLC. In order to resolve these conflicts, you

must use the VDT to rel ocate variables so that they do not overlap.

To create a new variable or modify an existing variable in the VDT:

1. From the Folder Browser, double click on the Variable Declarationsicon. The cursor
will become active in the Variable Declaration Table

2. Perform thefollowing steps to create or edit:

To create anew variable, click the right mouse button and choose Insert Row. A
new row will appear in the VDT.

To edit an existing variable, locate the variable and double click on the fields you

__|[Tot_pans [FPEE

want to edit.
GIDI:nall Local Al |5_I,Istem| Tempuraryl
M ame | Tupe | Len| Addrezs | Description | Stored Y alue | Scope | Ret | I:I'-.frl
J w“EO0100 |Word |1 =Ro0oio0 Local _MAIN|
] Glohal ¥

3. For new variables, complete the Name, Type and Addressfields. Verify Scope and
Length. You may also enter a Description and Stored Vaue, if desired. To modify
existing variables, change the parameters asrequired in your application:

VersaPro will display message boxes if the variable definition isincompl ete, or
(for modified variables) does not pass validation.
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Navigating inthe VDT

VersaPro allows you to navigate using either the mouse or the keyboard. Y ou can aso
navigate to a particular variable usng the Go to Variable didog box or the Edit Variable
menu item.

Navigating Using the Mouse or Keyboard

To navigate using the mouse:

Move the mouse arrow to the cell that you want to edit, then click the primary mouse
button. Aswith keyboard navigation, if you' re editing a cell, moving the selection implies
accepting the datain the cell from which you are moving.

To navigate using the keyboard:

Reference the following table to navigate through the VDT using the keyboard.

Arrow Keys If the current cell has not been selected for editing (if the cell, but not the text, is
highlighted):, the arrow keys move the selection one cdll in the direction of the arrow
key.

If the current cell has been selected for editing:, the Left and Right arrow keys move
the cursor to theleft or right in the cell until the beginning or end of the text is
reached

Moving from one row to ancther, by using up/down or right/left arrow keys, always
triggers row validation.

Enter If the current cell has not been selected for editing (if the cell, but not the text, is
highlighted), the Enter key selects the cdll for editing.

If the current cell has been selected for editing, the Enter key submits the contents of
the cell for row validation, and selectsthe cell below the current one.
F2 Selects or unselectsthe current cell for editing.

Shift + Arrow Keys | If the current cell has not been selected for editing (if the cell, but not thetext, is
highlighted), the Shift + Arrow keys select the current cell and moves the selection
one cell in the direction of the arrow key.

If the current cell has been selected for editing, the keys select the current character
and moves the selection one character in the direction of the arrow key.

Shift + Space Bar Selects the current row.

Home If the current cell has not been selected for editing (if the cell, but not the text, is
highlighted), the Home key selectsthe first cell in the current row.

If the current cell has been selected for editing, the Home key moves the cursor to the
left of thefirst character inthe cell.
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End

If the current cell has not been selected for editing (if the cell, but not the text, is
highlighted), the End key selects thelast cell in the current row.

If the current cell has been selected for editing:, the End key moves the cursor to the
right of thelast character in the cell.

Ctrl + Home

Selects the first cdl in the first row.

Ctrl + End

Selects the first cell in the last row.

Tab

If the current cell has not been selected for editing (if the cell, but not the text, is
highlighted), the Tab key selects the next cell to theright.

If the current cell has been selected for editing, the Tab key submits the contents of
the cell for row validation, and selectsthe next cell to theright.

Note: Moving from one row to another, by tabbing left from the leftmost cell or right
from the rightmost, aways triggers row validation.

Shift + Tab

If the current cell has not been selected for editing (if the cell, but not the text, is
highlighted), the Shift + Tab keys select the next cell to the left.

If the current cell has been selected for editing, the Shift + Tab keys submitsthe
contents of the cell for row validation, and selects the next cell to the |eft.

Note: Moving from one row to another, by tabbing left from the leftmost cell or right
from the rightmost, aways triggers row validation.

Ctrl + Tab

Displays the next VDT tab (Local, Global, All, System) to the right.

Page Down/Up

Moves the display one vertical viewable page down/up, and selectsthe cell in the
same rel ative x,y position as before the movement.

Locating a Variable using the Go To Variable Dialog Box

Y ou can quickly locate variables using the Go To Variable dialog box. Perform the
following steps to locate a variable by name.

1. Fromthe Variable Declaration Table, click the right mouse button and choose Go to
Variable. The Go to Variable dialog box will appear.

Go to Yariable !

Enter the wariable name:

i| :_! LCancel

Help

PR

2. Enter the name of the variable that you want to go to, or select it from the drop-down

list.

3. Click OK. Thevariable that you entered becomes selected in the VVariable Declaration

Table.
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Using Cut, Copy, Paste and Drag and Drop in the VDT

VersaPro allows you to cut or copy and then paste variables or cellsin single or multiple
variables within the VVariable Declaration Table without removing ladder €l ements from
ladder logic or instructions from instruction list logic. It also alows you to paste items
placed on the clipboard by applications other than VersaPro into the Variable Declaration
Table, and to cut or copy items to the clipboard for pasting to any other application that
accepts tab-delimited text. Pasting overwrites any informationin acell or variable.

VersaPro also allows you to drag and drop -cut or -copy within the VDT, or from the
Variable Declaration Table to either editor. Dropping inthe VDT overwrites any
information in a cell or variable.

To cut, copy and paste in the Variable Declaration Table:

1. Openthe Variable Declaration Table Select a variable(s) or cell(s) within single or
multiple variables.

2. Choose Cut or Copy from the Edit menu, click the Cut button or the Copy button

on thetoolbar, or press Ctrl + C for Copy or Ctrl + X for Cut. To select a
variable, every fidd in the variable must be selected. The selected datais cut or
copied to the clipboard. It isnhow available for pasting to any other application that
accepts tab-delimited text.

3. Sdlect the variable(s) or cdl(s), to which you wish to paste the information that
you've cut or copied. Information on the clipboard that originated in another
application may also be pasted to VersaPro.

4. Choose Paste from the Edit menu, click the Paste button B or press Ctrl + V.
Row validation is performed on each variable to check for global scope conflicts with
existing variables before pasting to the VDT. If avariable failsrow validation, an
error message appears, and then a dialog box appears allowing you to correct errors
appears. If the problem is corrected, row validation continues for other variables. If
the information on the clipboard is valid for pasting in VersaPro and the number of
variables or cells correspondsto the area that you' ve highlighted, the information is
pasted.
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Details on Cutting and Copying

If every cdll in avariable is sdlected and a cut is performed, the variableis deleted
from the folder.

Vertica gaps between non-contiguous variables are del eted when the variables are
copied to the clipboard.

Rows on the clipboard are separated by a CR/LF. Columns are separated by tabs.
These separations become obvious when pasting to an externa application.

If acut or copied variabl€e' s length is greater than 1, its stored val ues are separated by
commas when pasted to external applications (like Microsoft Excel®).

When cut or copied to the clipboard, Retentive and Override values are stored as 1 for
Trueand O for False.

It isnot possible to make non-contiguous row selections with the keyboard.

The following fields cannot be cut from avariable: Type, Length, Scope, Retentive,
Override

Details on Pasting

GFK-1670D

If more variables reside on the clipboard than have been sdlected to be overwritten,
the selected variables are overwritten and the remaining clipboard variables are
inserted on to the table(s)

If fewer variablesreside on the clipboard than have been selected to be overwritten,
as many of the selected variables as possible are overwritten, and therest are deleted.

Nothing may be pasted into the System tab.
Nothing may be pasted into the Temporary tab.

If avariableis pasted onto the Global table, it becomes a global variable regardless of
its origina scope.

If avariableis pasted onto aLocal table, it becomeslocal to that block regardless of
its origina scope.

If aglobal variableis pasted onto the All table, it remains global .

If alocal variableis pasted onto the All table, the program will attempt to assign it to
its defined block. If that block does not exist in the folder, it will be made a global
variable.

Any values changed by a paste operation on the visible table will also be changed on
any other table where they appear.

Values that have been atered by a pastein the VDT aredso dtered in the IL and LD
program logic displays.
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For cells, if the selected areais smaller than the area on the clipboard, an error
message appears and the paste is aborted. If the selected areais larger than the area on
the clipboard, the cut or copied information is pasted in the upper |eft corner of the
selected area

Any text may be pasted into a free floating or line comment.

For rows, if the selected number of rows is smaller than the number on the clipboard,
an error message appears and the paste is aborted. If the selected number of rowsis
greater than the number on the clipboard, the extrarows are deleted. If only acell is
selected, the rows are pasted above that cell.

To drag and drop-cut in the VDT:

S T o A

Open the Variable Declaration Table.

Select avariable(s) or cell(s) within single or multiple variables.
Position the mouse arrow over the selected variable or cell.
Press and hold the primary mouse button.

Move the variable or cell to the appropriate area.

To drop the selection, release the mouse button. If it isvalid in the new location, the
selected variable or cell isremoved from the original position and placed in the new
position. If itisnot valid, the drag and drop operation is cancelled.

To drag and drop-copy in the VDT:

6-10

N o g~ NP

Open the Variable Declaration Table.

Select avariable(s) or cell(s) within single or multiple variables.
Position the mouse over the selected variable or cell.

Press and hold the Ctrl key.

Press and hold down the primary mouse button.

Move the variable or cell to the appropriate area.

To drop the selection, release the mouse button. If it isvalid in the new location, the
selected variable or cell is copied from the original position and placed in the new
position. If itisnot valid, the drag and drop operation is cancelled.
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Details on Dragging and Dropping in the VDT
e Changesto values that occur through Dragging and Dropping will also appear on any
other affected table(s) or editors.
e Draganddrop of variablesis only available on the same VDT tab.

¢ When a selection spans more than one variable, row validation is performed. If any
cell inthe selected areaisinvalid in its new location, the entire drag and drop
operation is cancelled.

e You cannot cut the following cells, unless the entire row is selected: Type, Length,
Scope, Retentive, Override

o If asdectionisdropped that would go beyond the lagt row of the VDT, new rows are
created to accommodate the drop.

e When asdectionisdropped, it overwritesthe existing cells.

e VersaPro does not allow dragging and dropping a discontinuous set of cells.

To drag and drop from the VDT to the LD or IL Editor:

Open ablock inthe IL or LD Editor.

Open the Variable Declaration Table.

Select avariablein the VDT.

Position the mouse over the selected variable.

Press and hold down the primary mouse button.

o g M W NP

Move the variable to the Operand field of an existing instruction in the IL Editor, or
to an element or operand in the LD Editor.

7. Release the mouse button to drop the variable. The variable becomes the operand for
the selected instruction.

Details on Dropping a Variable into an Editor

e When asdection isdropped it overwrites the existing cell.
e Variablesmay only be dropped on existing €l ements or operands.

o Ifthevariableisinvalidin its new location, the entire drag and drop operation is
cancelled.

e  Multiplerows cannot be dragged and dropped from the VDT to the IL Editor.
No more than one row from the VDT may be dropped into the LD Editor.
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Variable Declaration Table Utilities

VersaPro provides several utilities to sort variables, delete variables aswell as clear and
savethe VDT.

This section describes how to use the utilities supported by the VDT.

Sorting Variables

VersaPro allows you to sort variables in the VDT, in ascending or descending order,
according to any but the Stored Vaue column.

To sort variables in the VDT

1. Openthe Variable Declaration Table.

2. Sedect acolumninthe VDT, other than the Stored Value column, by clicking onits
quick-select button. VersaPro does not allow sorting on the Stored Value column.

3. Choose Sort from the View menu, then choose Ascending or Descending from the

submenu that appears, or choose Sort Ascending or Sort Descending from the
Context-Sensitive Menu.

Deleting Variables and the Contents of a VDT

6-12

Variables can be deleted from the Variable Declaration Table without removing ladder
elements from ladder logic or ingtructions from instruction list logic. Elements from which
variabl es have been removed become unnamed.

VersaPro also allows you to delete the contents of a Variable Declaration Table (clearing
the VDT). Performing such adeletion removes all the VDT’ s variables from the Global,
Local, and All tabs and from program logic. The logic itsdf isnot affected. The VDT
remainsin the folder and is ways displayed in the Folder Browser; it can only be cleared,
not deleted.

To delete a variable in the VDT

1. Openthe Variable Declaration Table.

2. Sdect thevariable or variables that you want to delete.

3. Choose Delete from the Edit menu or press the Delete key. The variable or variables
are deleted from the VDT.

4. Thevariables are deleted from program logic.
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¢ InLadder Diagram blocks, the names of deleted variables are removed from
elements, but the el ements to which these variables had been assigned are not
removed.

e InInstruction List blocks, the names of deleted variables are removed from the
Operand column, and their addressees are removed from the Reference Address
column, but the relays and instructions to which these variables had been
assigned are not removed.

Note: In order for asingle variableto be deleted, every fidd in the variable
(the entirerow) must be selected. If every field isnot selected when the
deletion is performed, the selected fields are cleared, but the variable
remainsin existence.

To clear the Variable Declaration Table
1. Highlight the Variable Declaration Table in the Folder Browser.

2. Choose Delete from the Edit or the Context-Sensitive menu, or press the Delete key.
A confirmation message appears asking if you are sure you want to erase al variables
from the program.

3. Click OK to ddeteall variables. Otherwise click Cancdl.

e All global and local variables are deleted from the VDT. No variablesremain on
the Global, Local, or All tables.

e All variables areremoved from program logic.

e System variables remain on the System table. They can never be deleted.

Saving Edits in the VDT

To save the Declaration Table
1. Fromthe Variable Declaration Table, click the Save Folder button on the toolbar

, choose Save from the File or the Context-Sensitive menu, or press
Ctrl +S.

2. VDT datais saved.

Note: In anumber of circumstances, for instance, when you close a folder or
close the application, the VDT is saved automatically.
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Compacting the VDT

When you edit the VDT by cutting, copying, pasting, or deleting, the VDT retains
information about your edits. This edit history can cause the VDT to grow substantidly in
size. If alarge amount of editing has taken place in aparticular VDT, it is sometimes
useful to remove the VDT's edit history and thereby lessen its size. The Compact option
on the Folder menu allows you to do so.

To compact the VDT:

1. Open afolder.

2. Open the Variable Declaration Table.

3. Makethe Variable Declaration Table active.
4. Choose Compact from the Folder menu.

The VDT iscompacted.

Viewing the Highest References Used

To display alig of the highest references used for all memory types, select Highest
References Used from the VDT context sensitive menu.

Finding Unused Variables

Unused variables are variables which have been created, but are not used in any program
logic. From the Folder menu, select Find Unused Variables. The unused variables will be
listed in the Information window by Name, Scope, and Address.

Creating a Cross-Reference Listing of Variables

From the Tools menu or the Folder browser CSM menu, select View Online Cross
References. The Information window will display alist of al variables used in the selected
block by reference type. The cross reference also lists each Rung and Instruction that uses
the variable.

To view online use tables

From the Tools menu, select View Online Use Tables. The Online Use Tables report
provides atable for each reference type used in the folder. The table identifies reference
addresses used as explicit, implicit, or both. Results are displayed in the Reports tab of the
Information Window.
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Importing and Exporting Variables

VersaPro allows you to import and export variables to external locations using a Shared
Name File Format. This section describes how to import and export variables to and from
SNF Files.

To import a variable:

1
2.

Open the folder into which you wish to import an SNF file.

Choose Import Variable from the VDT CSM or the Tools menu. A browse dialog box

appears asking you to locate the file that you wish to import.

Locate thefile that you wish to import.

Click the Open button. Thefile isimported and the variables are displayed in the

VDT.

Details on Importing an SNF File

VersaPro ignores the Header section of SNF files.
The Imported SNF file must contain a PT_ID field, and that field must be the first

fidld in the first non-comment field row.

The number of Data Entries must correspond to the number of Field Names.

VersaPro supports the following field names:

GFK-1670D
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PT_ID (name)
ADDR

DESC
PT_TYPE
LENGTH
RETENTIVE
OVERRIDE
STORED_VAL
SHOW_EXT
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All other field names and corresponding data entries are ignored.
e Empty data entries default to the same default entry as the VDT.

e Any dataentriesthat violate row validation , contain invalid entries for a particular
field (other than the PT_TYPE field), or repeated variables produce a conflict error.

e All imported SNF variables are added to the global table unless another block has
been specified in the address field.

e Imported SNF variables are added below any existing variables.

e Sdecting Cancel from the Conflict dialog cancelsthe entire import process. All data
is purged.

e Any Description that contains quotation marks must start and end with quotation
marks, to determine where separations occur between Descriptions and the additional
text in the variable.

To export a variable:

1. Fromthe VDT, select the variable or variables that you wish to export.

2. Choose Export Variable from the VDT CSM or the Tools menu. If no variables are
selected, an error message appears informing you that at |east one variable must be
selected in order to export. A dialog appears asking you to determine the location to
which you wish to save the exported file.

3. Choose alocation. The default export location isthe last Import/Export directory
used. Click OK.
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Details on Exporting an SNF File

GFK-1670D

The following Field Names are exported as.

O
O

O OO o0oOo o O

PT_ID (name) - variable name

ADDR (“address, block name”’ format for local variables) - variable reference
address and scope

DESC - variable description

PT_TYPE - variable type

LENGTH — length of variable

RETENTIVE - variableretentive state

OVERRIDE - variable override state

STORED_VAL - stored values in comma delimited format
SHOW_EXT —variablesto be viewed by HMI

The $$& & FileType section of the SNF header will be I/O.

O
O
O

VersaPro does not export the ##Del VarDEc! section of the SNF header.
Any additional commentsin the SNF files must be added using an outside editor.
The default extension of the exported fileis*.SNF.
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Variable Resolution

Thisdialog allows you to easily resolve variable conflicts. You can keep existing variable
definitions or overwrite them. This dialog appears as the result of a Paste, Import SNF, or
Insert Block operation that causes one or more variables to conflict with existing

variables.

Yariable Resolution Dialog
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If Prompt for Each Conflict is selected, the following diaog box will appear.

Variable Conflict Dialog E

Basic |Auxi|iary|

New Existing
Marme: IREG_1
Type: =zl word -]
Length: |1 |1

R, Addr. |%RDDDD1 I%RDDDEH
Scope: |Global =l |clobal =

Add Mew | Use Existing | Cancel | Help |

To enter Description, Stored Value, Scope, Override, Retentive, and External for the
variable, select the Auxiliary tab. (These values can aso be edited in the VDT.)
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Configuring PLC Hardware

Stand Alone Hardware Configuration (HWC) contains the configuration information for
your Series 90-70, Series 90-30, VersaMax, VersaMax Nano/Micro, and Series 90 Micro
PLCs, aswell as Ethernet Global Data (EGD) configuration. It also providestoolsto
allow you to monitor power consumption and I/O mapping for modul es added to your
system. The default rack and CPU configuration that appears when you enter HWC is set
by selecting Options from the Tools menu in VersaPro.

The configuration information must match the physical hardware of your system. Typical
stepsin configuring your PLC hardware include:

Configuring therack type and power supply

Selecting and configuring a CPU for a PLC rack system, or an NIU for a VersaMax
Remote I/0 rack system.

Configuring modul es and customizing parameters for your application
Configuring EGD exchanges and Name Resol ution, if applicable
Saving the HWC so that it can be stored to the PLC from VersaPro

Detailed information about configuring parameters for a specific moduleis available
through the online help. To access this information, open the Parameter Editor window
for the module (double-click the module), then select Module Help from the Help menu.

Chapter Contents

Accessing Hardware Configuration

Configuring the Series 90-30 Rack or Series 90-70 Rack
Configuring the VersaMax Modular Rack

Configuring the VersaMax Remote 1/0 Rack
Configuring VersaMax Nano and Micro PLCs
Configuring Series 90 Micro PLCs

Hardware Configuration Reference View

Hardware Configuration Log View

Converting Rack Systems

Printing Hardware Configuration
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Accessing Hardware Configuration il

To access HWC from VersaPro, double-click the Hardware Configuration icon B in the
folder browser. Therack system for the configured CPU hardware will appear, along with
a graph showing power consumption statistics for the module, atable showing references
used in hardware configuration, and alog that maintains arecord of HWC events.
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Hardware Configuration Toolbar

When you launch HWC, the main window displays While you are working in Hardware
Configuration, you may want to display the Hardware Configuration toolbar, which
provides access to commonly used areas of Hardware Configuration:

To display the Hardware Configuration toolbar, go to the View menu and place a
checkmark next to Toolbar.

Fa) [ielaelie) (e

Using the Parameter Editor

To configure module parameters, you will use the Parameter Editor, which appears
automatically when you insert or replace amodule. To change parametersfor amodule,
choose Configure Parameters from the context-sensitive menu, or choose Configure
Parameters from the Edit, Modul e Operations submenu, or double click on the module.

The Parameter Editor provides an extended set of Windows-compatible editing facilities
to make configuring your system less labor intensive.

e Parametersare displayed in an edit window that can be resized, maximized, and
minimized.
e You can open multiple parameter views at the same time. Thisfeature alows you to

view the parameter set of one module while editing another, and you can easily copy
and paste a single parameter val ue between module views.

e The Edit Window can be displayed in Tabbed mode (default) or Spreadsheet Mode
(allows all parameter groupsto be displayed and edited in asingle, scrollable view).
To change the display, sdect Parameter Edit from the View menu.

e TheTitle Bar of the window uniquely identifies the associated modul e with the rack
system name, the module rack/d ot address, and the module catal og number.
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Note:

Some of the more complex modul es, such as the Motion modul es,

contain key parameters known as Mode Setters.

All parameters, including Mode Setters, that affect other parameters are
listed in italics. To obtain an explanation of parameter relationships for
these parameters, press F1 in the Editor window and select the
parameter name from the Help index. Or, right click the parameter and
select What's This from the CSM.

[l Vershx (0.0) IC200CPU

Seftings  Scan |P0rﬂ P

Mode Setter

Changes the set of
parameters available for
editing. Resets the

werCDnsumptiDnl

I | Tip

Displays valid choices
for selected parameter.

Editing Tips

7-4

Para M parameters it affects. Values
Shwissn Mads = Constant [
Sweep Timer [mSec): 100
[Editakls Riange Variahle: Low Limit=5, High Limit = 500]
' [~
‘|CPU 20K User 1 RS23z2 || 4

Status Bar
Displays information about
module being configured.

Valid values for each parameter are displayed in atool tip that appears when you hover

the mouse cursor over the parameter cell. To edit parameter values:

e Typedirectly into the selected cell in amanner similar to typing into a spreadsheet
cell, or usethe Data Entry Tool. To open the Data Entry Tool, right click in the
parameter cell and choose Data Entry Tool from the context-sensitive menu, press the
F2 key, or double click.

e If thevalid values consists of alig of choices with uniqueinitial letters, select avalue
by smply typing its first letter in the cell.

Y ou can save time when entering the same value for multiple parameters (of the same

type) by Copying and Pasting or dragging and dr opping one parameter valueinto other
parameter value cells. Copy/Paste and drag/drop can be used within the same module view
or between module views.
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Drag/drop works with the keyboard as follows:

e To copy the datafrom the source cell to the drop cell, do not press any key, or press
the Ctrl key while dragging.

e To move the data from the source cell to the drop cell, press the Shift key while
dragging.

e To copy the datafrom the source cell to al cells between the source and drop cell
(including the drop cell), press the Alt key while dragging. This assumes that drag
and drop is occurring on the same Edit window and the source and drop cellsarein
the same column. This features allows you to quickly fill an entire range of cellswith
identical information.

Note: Parameter val ues that have been changed since the start of the editing
session are shown in bold.

Undoing Changes

e Toreset asngle parameter to the Start of Edit Session value or to Factory Original
(default) setting, right click on the parameter and choose Reset Parameter from the
context-sensitive menu.

e Toreset al the parameterson atab, right click anywherein the tab, and choose Reset
Tab from the context-sensitive menu.

e To Undo changes, choose Undo from the Edit menu, or click the Undo button on the
Editor toolbar.

The Editor supportsfrom 1 to 32 levels of Undo/Redo (default is 10). You can set the
levels of Undo/Redo by choosing Options from the Tools menu.

Note: Y ou cannot Undo changes that result from changing a Mode Setter
parameter.

Error Notification

Erroneous values are displayed in the Error Color (red by default) and an explanatory
Tool Tip isprovided for the error.

To seethe Tool Tip for an erroneous setting in the Parameter Editor, hover the mouse
cursor over the parameter cell.

To change error notification colors

1. Sdect Options from the Tools menu.

2. IntheOptions diaog box, choose the General tab.
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In the Colorslist, choose the condition for which you want to set the color.
Click the Choose button. The Windows col or selection dialog box will open.

Select acolor, click OK in the color selection dialog box, then dick OK inthe
Options dialog box.

Correcting Errors

To automatically correct an erroneous value, right click on the value and select Auto
Correct from the context-sensitive menu. If you attempt to close a configuration that
contains an error, the Parameter Error List dialog box will appear. To automatically
correct al errorslisted in this didog box, click the Auto Correct button.

Shortcut Keys for HWC

7-6

Y ou can edit information in Hardware Configuration through menu bar selections, the
context-sensitive menu, or short-cut key sequences.

To edit modules using the menu bar, click the module or slot you want to configure,
go to the Edit menu, and select the appropriate action.

To edit modules using the right mouse button, click the module or dot you want to
configure, click the right mouse button, and sel ect the appropriate action.

To edit modules using standard cut, copy, and paste functions, highlight the module
and use the Edit menu options or CTRL key shortcuts.

To copy amodule, click the module you want to copy and press CTRL+C. To paste
the module, click the new slot and pressCTRL + V.

To cut amodule (which alows you to paste it in another slot), click the module and
press CTRL+X. To delete amodule, click the module, and select Delete from the Edit
Menu or pressthe Delete key.

To Undo a previous operation, press CTRL + Z.

Y ou can use drag and drop to move modules between slots. To use drag and drop,
highlight the module you want to move, click and hold the left-mouse button, and
drag the module to the new dot.

To close awindow, press Ctrl + F4.

To Close HWC, press Alt + F4.
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Setting Options in Hardware Configuration

To set HWC options, go to the Tools menu and select Options. To adjust the szeand
content of the HWC System Log, enable Audit Trail Mode, set the number of Undo
Levels, and select Error and Warning colors, select the Genera Optionstab.

Options

General Options | Parameter Edit Options |

Log File
Maximum Size (Bytes)
1

W Audit Trail Mode

Undo Lewvels

20

Fower Mormal
Fower\Warning
Text Errar
Text'Warning

[ o |

Cancel Help

To change theformat of the Parameter Editor window and the mode for assigning the next
reference, select the Parameter Edit Optionstab.

Options

General Options Farameter Edit Options |

Pararmeter Yiew

" Spreadsheet

MNew Reference Assignment

= Ment Availahle
& First &wvailable

oK | Cancel Help
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Configuring a Series 90-30 or 90-70 Rack

When you enter Hardware Configuration for the Series 90-30, the default view is the Rack
(Main). The default 90-30 CPU moded is the CPU351. The default 90-70 CPU model is

the CPX772.

I, HWC - [chan4_30h]

Bili File Edit “iew ‘Window Tools Help

D|SE] 2= e2] 2| &|@] 2= |ke|g2] context sensitive Menu

Choices:

Rack Tabs

Power Supply

Main I Rack 1 | Rack 2| Rack 3| Fack 4| Fack 5| Fiack EI Fag Click the secondary mouse button to

view list of available commands for the

/

[ICEA3CHS 391 - Base 10 Slat

Changing Rack Type

To change rack type:

=] Corfigue Farameters. .

E Add Module...

ﬂz Heplare Modile:..
Welete hodule

Change Rack Type...

Clear Rack
Configure CPU Parameters...
iz Replace CPU...

Mame Resolution and Fouting...
Ethemet Global Data...

Sdd [EarerEEse..
[Velete [EarenBaze,..

|meert Carnmer/Base..,

Henlace EamernBase,.

7-8

1. Position the cursor anywherein the Rack window, then click theright mouse button.

2. Choose Change Rack Type.
3. Click the catalog number and description of the type matching your system, then click
the OK button.

Note: Change Rack Typeisonly active for Series 90-70 and non-imbedded
Series 90-30 CPUs (CPU331 and higher).
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Changing/Configuring Power Supply and CPU

Configuring a Power Supply

To change the default power supply:

1
2.
3.

Click the power supply dot in the Rack window.
Click the right mouse button and choose Replace Module.

Click the catal og number and description of the power supply in your system, then
click the OK button.

Respond to prompts if any appear.

When you replace the default power supply, the Parameter Editor appears alowing
you to view detailed power consumption information. If you are using the default
power supply, you can double-click on the power supply slot in the Rack window to
view the details.

When you have finished, click the OK button.

Configuring a CPU

To change the default CPU:

1
2.

From the rack view, click the right mouse button and choose Replace CPU.

Click the catal og number and description of the CPU in your system, then click the
OK button.

Note: To configure EGD exchanges for a 90-30 CPU364 or a 90-70
CMM742, see “Ethernet Global Data Configuration” on page 7-31.

Configuring the CPU's Parameters

GFK-1670D

To configure the CPU’s parameters:

1

When you replace the CPU, the Parameter Editor window appears. If you are using
the default CPU, then double-click the CPU dot.

Within the Parameter Editor window, click the tab pertaining to the parameters you
want to view or modify (where applicable).

Click in the Values fields you want to edit. (See "Editing Tips' on page 7-4.)
When you have finished editing the CPU parameters, click the window close button.
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Adding/Configuring Rack Modules

To add modulesto the rack:

1
2.

Select the dot where the moduleisto be placed.

Double-click on the empty dot or click the right mouse button and choose Add
Module. (If you are replacing a previously configured module, click the right mouse
button and choose Replace Module.)

Click the tab describing the I/O module type you need (Discrete Input, Discrete
Output, Analog Input, Analog Output, Communications, etc.).

Click the catalog number and description of the module in your system, then click the
OK button.

Configuring the Module’s Parameters

To configure the modul € s parameters:

1

When you add or replace amodule, the Parameter Editor appears. You can also
access thisdialog box by double-clicking the module slot from the Rack window.

Within the Parameter Editor, click the tab pertaining to the parameters you want to
view or modify (where applicable).

Click in the Values fields you want to edit. (See "Editing Tips' on page 7-4.)

When you have finished editing the modul e parameters, click the window close

button.

Configuring Expansion Racks

Expanson racks are configured in the same manner asthe main rack. To add modulesto
an expansion rack, click the Rack tab and add the modul e configuration which
corresponds to the attached hardware.

7-10
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Deleting Rack Modules

Deleting amodule removes it from the rack. If you save the Hardware Configuration after
deleting the modul e, the configuration information about the deleted module will be lost.
Perform these steps to delete amodul e;

1. Sdect the module you want to delete.
2. Pressthe Delete key or click the right mouse button and choose Delete Module.

Clearing the Rack

Clearing the rack removes all modules except the power supply and CPU. If you save the
Hardware Configuration after clearing therack, the configuration information about the
deleted modules will be lost.

Perform these steps to clear the rack configuration:
1. Click anywherein the Rack.
2. Click the right mouse button and choose Clear Rack.

3. A confirmation dialog box will appear. To confirm the clear rack operation, click the
Y es button.
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Genius Bus Configuration (Series 90-70 PLCs)

The Genius Bus view is used to configure the bus attached to a 90-70 Genius Bus
Controller (GBC). Thiswindow contains seria bus addresses (SBAS) for 32 devices
(0—31). The controlling GBC occupies the SBA corresponding to its Serial Bus
Address (31 by default), which is configured in the module parameters for the GBC.
In a Redundant Controller system, the redundant GBC also occupies a SBA on the
bus.

SAHWC assigns a name to the bus in the format FileName: Bus_rack_dot. If you
move the GBC to adifferent rack/d ot location, the bus name will be updated.

The Genius Bus view appears automatically when you add a GBC to the 90-70 rack
system configuration. Y ou can also access this window by selecting a GBC and
choosing Expand Bus from the context sensitive menu (CSM).
W@ 90700ct5 - Bus_0_2 =l B
Genius® Bus |

25 26 27 28 29 30

Kl

|Genius® Bus |Bus

Bus Operations

7-12

To set Redundancy to Yes for all devices on the bus

Go to the Edit menu, select the Bus Operations submenu, and choose Set All Devices
Redundant. On al blocks that have a Redundancy parameter, it will be set to Yes.

To set Redundancy to No for all devices on the bus

Go to the Edit menu, select the Bus Operations submenu, and choose Set All Devices
Non-Redundant. On all blocks that have a Redundancy parameter, it will be set to
No.
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To clear the bus
Choose Clear Bus from the Edit, Bus Operations submenu or from the CSM. All
blocks will be removed from the bus except for the controlling GBC.
Block Operations

Except for Edit Configuration, these operations cannot be performed on the
controlling GBC in a Genius bus. In a Redundant Controller system, Edit
Configuration, Copy, and Paste can be performed on the redundant GBC.

To add a block

Double click an empty SBA, or select the SBA, go to the Edit menu, and choose
Block Operations, Add Block. The Block Catalog will appear. Select a device and
click OK.

To edit block configuration

Select the block and choose Configure Parameters from the Edit, Block Operations
submenu or from the CSM. The Parameter Editor window for the selected block will
appear. (Keyboard shortcut: Ctrl +E)

To delete a block

Select the block and choose Delete Block from the Edit, Block Operations submenu
or from the CSM. To delete all blocks, except the controlling GBC, from the bus, use
the Clear Bus command. (Keyboard shortcut: Del)

To replace a block

Select the block and choose Replace Block from the Edit, Block Operations submenu
or from the CSM. The Block Catalog will appear. Select a device and click OK.

Drag and Drop

Y ou can use drag and drop to move a block to a different SBA on the Genius bus.
(To move the controlling GBC, you must edit its Serial Bus Address in the Parameter
Editor window.)

Cut, Copy, and Paste
To perform these commands, select a block and choose the command from the CSM
or Edit menu. Keyboard shortcuts:

Cut Ctrl + X
Copy Ctrl+C
Paste Ctrl +V
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CPU Redundancy

There are three types of basic CPU redundancy. These redundant systems can be used in
combination with Genius redundancy schemes.

For more information about redundant systems based on 1C697CGR772 and
|C697CGR93, refer to the Series 90-70 Enhanced Hot Standby CPU Redundancy User's
Guide, GFK-1527. For redundant systems based on |C697CPU780, refer to the Series 90-
70 Hot Sandby CPU Redundancy User's Guide, GFK-0827.

Single Buswith Preferred Master — Uses a single Genius bus with bus controllersin
each PLC. The primary unit is always chosen as the active unit when the unitsinitially
synchronize. (GHS control strategy.)

Single Bus with Floating M aster — Uses a single Genius bus with bus contrallersin
each PLC. No switchover occurs on initial synchronization to make the primary unit the
active unit. (GDB control strategy.)

Dual Buswith Floating Master — Uses dual buses with the bus controllersin each PLC.
No switchover occurs on initial synchronization. Bus Switching Modules (BSMs) are
required in accordance with configuration of a dual bus network. This option provides
redundancy of both the PLC and the I/O bus. (GDB control strategy.)

Configuring CPU Redundancy Over Genius

CPU Redundancy Over Genius Types

7-14

There are five types of CPU Redundancy Over Genius systems, which are built upon the
various types of redundant Genius systems.

CPU Redundancy (GHS) Using Genius Dual GBC Redundancy (Paired GBC External) — Single Bus
with Preferred Master

CPU Redundancy (GDB) Using Genius Dua GBC Redundancy (Paired GBC External) — Single
Bus with Floating Master

CPU Redundancy (GDB) Using Genius Dua Bus Redundancy (Paired GBC Externd) — Single Bus
with Foating Master

CPU Redundancy (GDB) Using Genius Dua Bus and Dual GBC Redundancy — Dua Bus with
Floating Master

CPU Redundancy (GDB) Using a Mixed Genius Redundancy Scheme
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General Procedure for Configuring CPU Redundancy Over Genius

The following procedure configures two separate PLCs in two equipment folders. The first
one configured will be considered the Primary PLC in the system. The software will
automatically create the configuration for the Secondary PLC. Y ou will need to
Import the Secondary configuration into its own folders. The configuration of the

two PLCs will beidentical except for afew necessary differences such as CPU
Redundancy Mode (Primary or Secondary) and the Serial Bus Addresses (SBA) of the

GBCs (31 for the Primary and 30 for the secondary).

0.

10.

11.

From the Redundancy menu, select Wizard.

In the Wizards window, select Set up a Primary Rack System for CPU Redundancy.
Click Next.

Select a CPU. CPU model CPU780, CGR772, or CGR935 can be used in this
redundancy system.

Select the Redundancy Setup:

Single Bus with Preferred Magter (for CPU780, CGR772, or CGR935)
Single Bus with Floating Master (for CGR772 or CGR935)

Dual Buswith Floating Master (for CGR772 or CGR935)

Select the Rack and Slot locations for the BTM and RCM. Click Next.

Review the settings for Redundancy Scheme, BTM location, and RCM location. If
settings are correct, click Finish. If you need to make changes, click Back.

When you click Finish, thewizard will create arack configuration with the selected
CPU, aBTM, and an RCM.

Use the redundancy wizard to Add GBCs for Genius Redundancy.

Configure critical data and all redundant %AQ and %Q referencesin the Shared 1/0
section of the CPU Settings tab.

Use the redundancy wizard to generate the secondary rack system.

Use of Rack 7 in CPU Redundancy Over Genius Schemes

GFK-1670D

In these systems, each PLC's CPU addresses the other PLC's Main Rack as though it was
itsown Rack 7. Therefore, Rack 7 in each PLC system (both Primary and Secondary) will
be reserved for this purpose and will not be available for use asa physical expansion rack.
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Storing the Configurations to the PLCs

7-16

The configurations for both the Primary and Secondary PLCs are stored in two separate
Equipment Folders. Y ou will need to store the Primary PLC's configuration using the
Primary's Folder, and then store the Secondary PL C's configuration using the Secondary's
Folder. The Store procedure lets you select what portions of the equipment configuration
toincludein a Store operation. Details about the store procedure in general are found
elsewherein the online help.

Basic Store Procedure

Thisfollowing steps describe the procedure to store the Primary and Secondary configurations
to the PLCs. If your programmer is already connected to and communicating with the Primary
PLC, skip down to Step 4.

1

Connect your serial communications cable from your programmer (probably a
persona computer) to the PLC's programming port.

In VersaPro PLC menu, choose Connect. The Connect dialog box will appear.

Select the Device and Port that you want to use to connect to PLC, then click the Connect
Button. A connection will be made and the Status Bar displays a " Connected" message.

Select Store on the PLC Menu. The Store Folder to PLC dialog box is displayed.

Select only Hardware Configuration and motion in the selection window. A selected item
will have a check mark next to it. Clicking the item will toggle its selection check mark
between on and off.

Click the OK button to store your Primary configuration to the Primary PLC.

To store the Secondary configuration to the Secondary PLC, create a new VersaPro folder
and import the Sedondary Configuration from the original folder (File->Import Hardware
Configuration Folder in HWC menu)

Connect to the Secondary PL C and store this Configuration to the Secondary PL C as described
in steps 1-6.

Note: Both folders created as described above should be maintained to be able to use the Redundant

system.
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Configuring the Genius Redundant System

Genius Redundancy Types

There are five types of redundant Genius systems. These are sometimes used in
conjunction with CPU redundancy schemes to provide additiond protection against
component failure. Thistype of systemis caled "CPU Redundancy Over Genius."
Dual Bus Redundancy (Paired GBC Interna)

Dual Bus Redundancy (Paired GBC External)

Dua GBC Redundancy (Paired GBC Internal)

Dua GBC Redundancy (Paired GBC External)

Dual Bus and Dud GBC Redundancy

General Procedure for Configuring the Genius Redundant System

GFK-1670D

1. From the Redundancy menu, select Wizard. Note that, for Paired GBC Externd
systems, two open rack slots must be available in this PLC for the GBCs, dthough the
Paired GBC may be in another rack.

2. IntheWizards window, select Add GBCs for Genius Redundancy and click the Next
button.

3. Sdect aredundancy scheme and click Next:

Dual Bus, one PLC Dual Bus Redundancy (GBC Pair Internal)
Dual Bus, two PLCs Dual Bus Redundancy (GBC Pair Externa)
Redundant Controllers, one PLC Dual Bus Redundancy (GBC Pair Internal)
Redundant Controllers, two PLCs Dua GBC Redundancy (GBC Pair External)

Dual Bus and Redundant Controllers, two  Genius Dud Bus & Dual GBC Redundancy
PLCs

4. Select rack and dot locationsfor the primary GBC and the Paired GBC. Click Next.

5. Review the settings for Redundancy Scheme and GBC locations. If settings are
correct, click Finish. If you need to make changes, click Back.

When you click Finish, the software will create the Genius bus/GBC configuration. If you
have two GBCs, the parameter settings of the second GBC (except for therack and dlot
numbers, and SBA) will be a copy of those of the first GBC. These two GBCs will, by
default, be assigned Serial Bus Addresses (SBAS) 30 and 31. Each bus will contain an
image of its GBC. To configure devices on a Genius bus, see “ Genius Bus Configuration.”

To copy the device configurations from a redundant bus to its partner, select Wizard from
the Redundancy menu. Choose Copy a Redundant Bus and click Next. Follow the Wizard
instructions to complete the copy operation.

If your system has two PLC racks, see “ Configuring the Second PLC.”
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Configuring a VersaMax Modular Rack

When you enter Hardware Configuration for VersaMax equipment folders, the default
view isthe Rack (Main). The power supply (PWR001) and CPU (CPU0O01) arein the
default configuration.

The VersaMax rack system is built by selecting carriersinto which 1/0, communications
and power supply modules are added.

The default VersaMax rack system hasamain rack. Multiple power supplies are
supported on the main rack, asrequired by the modules you need to add into your rack
system.

Two types of VersaMax expansion networks are available: Local Single Rack and
Multiple Remote Rack. The Multiple Remote Rack configuration allows up to seven
expansion racks. Multiple power supplies can be used in expansion racks.

In the physical hardware, field wiring is connected to the module carriersinstead of the
modules. HWC displays module wiring in the Module Parameters. If you move a module
between carriers, be sure to update the wiring information accordingly.

Biff File Edit '‘iew ‘window Tools Help

D& 2 =lele=| 8|k EEkiR] Ew w28

tdain |

Empty Carrier Right Mouse Menu Choices:
Click the right mouse button to view
list of available commands for the

active carrier/module.

(1| Eorfimure Farameters,

ke

ﬂg Eeplaee hdonule=
elete hadile

|I| FWROO0T MDC= 1

[Ehatme Hashk IEe..

Clear Rack
Configure CPU Parameters. .
ig Replace CPLU...

[Hiame Besalution and Hotting..
Ettermet Eatbal ata,,

Power Supply and CPU:

To edit CPU parameters, click the Add Camier/Baze.
right mouse button and select .
Configure CPU Parameters. Delete Camier/Base. ..

Inzert Carrier/B asze. ..
[IC200CHS003 - 140 Carrier Connector Styl: Replace Carier/Baze. ..
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Changing/Configuring the CPU

The default CPU is 1C200CPU001.

To replace the CPU:
1. Click the secondary mouse button and choose Replace CPU from the CSM.

2. Sedlect a CPU from the Module Catal og. The Parameter Editor window for the
selected CPU will appear.

3. Review and modify CPU parametersin the Parameter Editor.
4. When you are finished editing the CPU parameters, click the window close button
to close the Parameter Editor window.

To view or change CPU parameters:

1. Click the secondary mouse button and choose Configure CPU Parameters from the
CSM. The Parameter Editor window for the CPU will appear.

2. Review and modify CPU parametersin the Parameter Editor.
3. When you are finished editing the CPU parameters, click the window close button
to close the Parameter Editor window.

Note: To configure EGD exchanges for a CPUEQ5 see “Ethernet Global Data
Configuration” on page 7-31.

Rack/Module Operations

7-20

In addition to configuring the CPU (or NIU), the VersaMax rack configuration is
completed through the following operations, asrequired:

e  Changing/Configuring the Power Supply

e Adding Module Carriers

e Adding Power Supply Booster Bases

e Configuring a Power Supply for a Booster Base
e Adding/Configuring Modules

e Ddeting Cariers

e Clearing the Rack

e Configuring VersaMax Expansion Networks
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Changing/Configuring the Power Supply

The default power supply is the IC200PWRO001. To change the default power supply:

1. Click the power supply slot, click the secondary mouse button and select Replace
Module. Select the new power supply from the Module Catal og.

2. The Parameter Editor window for the power supply will appear.
3. When you are finished reviewing the power supply parameters, click the window

close button to close the Parameter Editor window.

Adding Module Carriers

Carriers must be configured to house module in the VersaMax PLC. Perform these steps
to configure module carriers.

1. Toaddacarier totheright of configured modules, click the right mouse button and
choose Add Base/Carrier. The Module Catalog for Carrierswill display.

Toinsert a carrier between two configured modul es, highlight the modul e which will
be to theright of the new carrier, click theright mouse button and choose I nsert
Base/Carrier. The Module Catalog for Carrierswill display.

Note: You must click theright mouse button over amodule or carrier in the
rack configuration to view configuration choices from the right mouse
button.

2. Click the catalog number and description of the carrier you want to add, then click the
OK button.

Adding Power Supply Booster Bases

GFK-1670D

Power Supply boosters may be added into the system configuration to power modules
downstream from the booster. Perform these steps to add a power supply booster base:

1. ToaddaPower Supply Booster Baseto theright of configured modules, click the
right mouse button and choose Add Base/Carrier. The Module Catalog will display.

Toinsert a Power Supply Booster base between two configured modules, highlight
the module which will be to the right of the new base, click the right mouse button
and choose Insert Base/Carrier. The Module Catalog will display.

2. Click the Power Supply Booster Bases tab. Click the catalog number to select the
base, then click the OK button.

3. Toconfigurethe power supply, click the right mouse button and choose Add Module.
Select the Power Supply from thelist and click OK.
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Configuring a Power Supply for a Booster Base

Power Supplies can be added throughout your VersaMax system. To add or replace a
configured power supply on a Booster Base:

1

Double-click the empty booster base. For booster bases with configured power
supplies, click the right mouse button and select Replace Module. The Power Supply
Module Catalog dia og box will appesr.

Click the catalog number of the power supply you want to configure, then click the
OK button. The Parameter Editor will display.

Y ou can view information about the power supply. Click OK to complete power
supply configuration.

Adding/Configuring Modules

Once acarrier is configured, the module may be added to the system:

1
2.

Highlight the carrier which will house the module.

Double-click on the empty carrier or click the right mouse button and choose Add
Module. (If you are replacing a previously configured module, click the right mouse
button and choose Replace Module.)

Click the tab describing the I/O module type you need (Discrete Input, Discrete
Output, Analog Input, Analog Output, €tc.).

Click the catalog number and description of the module in your system, then click the
OK button.

Configuring Module Parameters

To configure the modul € s parameters:

1

7-22

When you add or replace amodule, the Parameter Editor appears. You can also
access this window by double-clicking the module dot from the Rack window.

Within the Parameter Editor, click the tab pertaining to the parameters you want to
view or modify (where applicable).

Click in the Values fields you want to edit. (See "Editing Tips' on page 7-4.)

When you have finished configuring modul e parameters, click the window close

button
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Deleting Rack Modules

Deleting amodule removes it from the rack. If you save the Hardware Configuration after
deleting the modul e, the configuration information about the deleted module will be lost.

Perform these steps to delete amodul e;
1. Sdect the module you want to delete.
2. Pressthe Delete key or click the right mouse button and choose Delete Module.

Deleting Carriers

Y ou must use the menu bar or right mouse operationsto delete a carrier. Perform these
stepsto delete acarrier:

1. Highlight the empty carrier you want to delete.
2. Click the right mouse button and choose Delete Carrier.

Clearing the Rack

Clearing the rack removes all modules (except the power supply and CPU). If you save
the Hardware Configuration after clearing the rack, the configuration information about
the deleted modules will be lost.

Perform these steps to clear the rack configuration:
1. Click anywherein the Rack.
2. Click the right mouse button and choose Clear Rack.

3. A confirmation dialog box will appear. To confirm the clear rack operation, click the
Y es button.

Configuring VersaMax Expansion Networks

There are three types of configurationsin the VersaMax rack system. To change the rack
configuration, select the type you want from the context-sensitive menu or from the Edit,
Expanson Rack System submenu.

None

Includes only the Main VersaMax rack (no Expansion). Systems created using VersaPro
1.0 have thistype of configuration. Thisisthe default VersaMax System, which is created
when you select New from the File menu or when you convert from another rack system,
such as Series 90-30.
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Local Single Rack

Includes the Main VersaMax |/O station and one Expansion rack. The Main VersaMax
rack does not contain a Transmitter. The Expansion rack contains a non-isolated Power
Supply and Receiver Integrated Unit (IC200ERM002). The power supply isnot
configured unless the Recelver unit is active. The default power supply in the expansion
rack will be the same asthe main rack's power supply. Replacing the main rack's primary
power supply will not affect the expansion rack's primary power supply.

Multiple Remote Rack

Allows you to configure up to seven Expansion racks (seven Rack tabs are aways shown).
The Main VersaMax rack contains a Trangmitter (IC200ETM001). The Non Isolated
Recelver (IC200ERM002), which is configured by default, can be replaced by an Isolated
Recelver (IC200ERM001).

The Transmitter and Receiver modul es cannot be added from the module catalog. The
only way to add these modules to arack configuration isto choose the appropriate
configuration type. Also, you cannot delete them from arack configuration except by
changing therack configuration type.

Note: If asingle-ended receiver is configured and an expanson transmitter is
present, afatal “expansion transmitter mismatch” fault will be
generated. Thisfault will also be generated if a differential (transmitter
and receivers) is configured and no expanson transmitter isphysically
present. In these cases, no faultswill be generated for individual
modules in the expansion racks. The CPU detects the presence or
absence of receiver modules connected through the expansion bus and
compares the physical configuration with the programmed
configuration. It will generate a“Loss of rack” alarm for missing
receivers and an “Addition of or extrarack” alarm for extrareceivers.
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Switching Between VersaMax Rack Systems

Y ou can switch from one VersaMax rack system type to another. This allows single rack
systems created in VersaPro versions earlier than 1.10 to be upgraded to Local Single
Rack and Multiple Remote Rack systems. Switching rack system types has the following
effects:

When you switch configurations, a messageis displayed which gives you the option of
carrying out the parameter changes of the existing CPU/modul es to the new rack
configuration.

To changerack system type, choose Expansion Rack System from the CSM or the Edit
menu. Select an expansion rack type from the submenu.

Changing VersaM ax Rack Systems

From To Results
None Local Single Rack A new expansion rack appears.
None Multiple Remote Seven new expanson racks appear in the rack
Rack system.
Multiple Remote Rack or None A message is displayed to warn about the loss
Local Single Rack of rack(s) and modulesin it and the fact that

these operations cannot be undone. If you click
OK, the standard rack will be displayed.

Multiple Remote Rack Local Single Rack A message is displayed to warn about the loss
of rack(s) and modulesin it and the fact that
these operations cannot be undone. If you click
OK, arack system containing Main and Rack 1
tabs will be displayed. If thereis an isolated
receiver in the first expansion rack, itis
replaced with the default non isolated receiver.

Related Parameters for Multiple Remote Rack Systems

On the Settings tab for CPU parameters, the Expansion Bus Speed parameter appears if
Multiple Remote Rack is selected and if thereis an isolated receiver present in any one of
the expansion racks. Values are Extended Distance (default) and Normal. For Normal
distance, the maximum allowabl e cable length is 15m (250ft) and the baud rate may vary
between 250KHz, IMHz, 3MHz, or 5SMHz. For Extended Distance, the maximum
allowable distance is 250m (820ft) and baud rateis fixed at 250K Hz.

Each expansion rack has one Power Supply and Non Isolated Recelver Unit. Theisolated
receiver can be replaced with the non-isolated receiver and vice versa. (see “Expansion
Rack Operations’).

Note: When amodule is auto-configured and the Expansion Bus Speed
setting changes as aresult, an "Expansion bus speed change" fault will
be generated. Y ou should correct the Expansion Bus Speed setting.
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Expansion Rack Operations

7-26

The catalog 1D and description for the Power Supply And Recel ver-Integrated unit is
shown on the atus bar. When you select the integrated unit, thereceiver information is
shown as a part of the status bar.

Selecting an Expansion Receiver

By default, the Expansion Receiver typeis None. A power supply is not configured for the
Expanson Rack until an Expansion Receiver is configured. There are three ways you can
configure an Expansion Receiver:

e By adding any base unit in the expansion rack. A Non-1solated Receiver Unit will be
configured by default.

e By right-clicking on the rack and selecting a Receiver Unit from the Expansion
Receiver submenu.

e By choosing a Receiver Unit from the Edit submenu, Expansion Receiver.

To deactivate the unit, select None from the Expansion Receiver submenu. (This
option isnot available if the rack configuration contains one or more Carrier/Base
units.

Changing Receiver Type for Expansion Racks in Multiple Rack Systems

The Power Supply And Receiver-Integrated unit consists of 1C200PWR001 and

| C200ERM 002 (non-isolated receiver) by default. For expansion racksin Multiple
Remote Rack systems, an isolated receiver (IC200ERM001) can be selected. To change
the receiver, choose Expansion Receiver from the Edit menu or the CSM.

Viewing Power Consumption Values

To view the parameters for the power supply, double click on the Power Supply and
Recelver-Integrated unit. Power values for the recelver are shown in the parameter dialog
of thereceiver and the value is non-editable. Receiver power isincluded as part of the
total power consumption of the main power supply.

To view the parameters for the recelver, choose Configure Receiver Parameters from the
context-sensitive menu or from the Edit, Rack Operations menu.
Clearing the Rack for Multiple Remote Rack Systems

When you sdlect this option with focus on the Main rack, the transmitter will not be
cleared. If you select this option with focus on expanson rack, it clears al the modules
except the Power Supply And Recel ver-Integrated unit.
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Configuring Receiver Parameters

This option displays the Recelver parameters for the selected Expansion rack. (The
Recelver units have no configurable parameters.)

Loading VersaMax Hardware Configurations

For general information on loading a hardware configuration, see “Loading a Folder to
Your Computer” in Chapter 10.

VersaMax Modules with Shared IDs

When the configuration is loaded from arack system, HWC uses the hardware module 1D
to determine the correct module catal og number and description. However, some
VersaMax modul es share the same module | Ds. When aVersaMax rack system containing
these modules is auto configured and the configuration isloaded an incorrect catalog
number and description may be displayed. Y ou will need to select the correct module from
the modules catal og and store it to the rack system. After storing the configuration, you
will be able to load the configuration properly.

The following modules share hardware module I Ds:

|C200M DL 650 |oads as |C200MDL 636
|C200MDL 750 loads as |C200MDL 742
|C200MDL331 loads as |C200MDL329
|C200MDD844 | oads as |C200M DD842
|C200MDL 141 loads as |C200MDL 140
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Configuring a VersaMax Remote 1/O Rack

A VersaMax Remote I/O (RIO) rack consists of a network interface unit (NIU) and
supported 1/O modules. Three types of NIUs are available: Genius (GNIU), Profibus
(PNIU), and Ethernet (ENIU). All VersaMax 1/0 modules are supported except
|C200BEM 002 and 1C200BEM 103.

When you enter Hardware Configuration for VersaMax equipment folders, the default
view isthe Rack (Main). The power supply (PWR001) and CPU (CPU0O01) arein the
default configuration. To configure a Remote 1/0 rack, you must replace the CPU with an
NIU and configure the NIU parameters.

AsinaVersaMax rack system with a CPU, the RIO rack system is built by selecting
carriersinto which 1/0, communications and power supply modules are added.

The default VersaMax rack system hasamain rack. Multiple power supplies are
supported on the main rack, asrequired by the modules you need to add into your rack
system.

The RIO supports two types of expansion networks: Local Single Rack and Multiple
Remote Rack. The Multiple Remote Rack configuration allows up to seven expansion
racks. Multiple power supplies can be used in expansion racks.

In the physical hardware, field wiring is connected to the module carriersinstead of the
modules. HWC displays module wiring in the Module Parameters. If you move a module
between carriers, be sure to update the wiring information accordingly.

Configuring an NIU

7-28

The default CPU is 1C200CPUQ01.
To replace the CPU with an NIU:
1. Click the secondary mouse button and choose Replace CPU from the CSM.

2. Select an NIU from the Module Catalog. The Parameter Editor window for the
selected NIU will appear.

3. Review and modify NIU parametersin the Parameter Editor.
4. When you are finished editing the NIU parameters, click the window close button
to close the Parameter Editor window.
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To view or change NIU parameters.

1. Click the secondary mouse button and choose Configure NIU Parameters from the
CSM. The Parameter Editor window for the NIU will appear.

2. Review and modify NIU parametersin the Parameter Editor.
3. When you are finished editing the NIU parameters, click the window close button
to close the Parameter Editor window.

Configuring the RIO Rack

The genera procedures for configuring carriers, power supplies, and modulesin an RIO
rack arethe same as for amodular CPU rack. For details, see “Rack/Module Operations’
on page 7-20.

Load/Store/Verify RIO Configuration

For Genius and Profibus NI1Us, the Load, Store, and Verify operationsrequire cable
|C200CBL002, which is used to connect a COM port on your PC to the serial port on the
left side of the VersaMax NIU.

For Ethernet NIUs, these operations use an Ethernet connection.

Communications Setup

To define communications parameters for therack system, select Communi cations Setup
from the Tools menu. The CCU will open. (If a password has been defined for the
Communication Configuration Utility, the Password dialog box will appear. Enter your
password and press OK to continue.) The main screen of the Communication
Configuration Utility will appear.

When configuring a Device in the CCU for use with a GNIU or PNIU, you should assign
a Name and default Port. Port Type should be set to SNP_SERIAL. All other fields should
be left at their default values.

When configuring a Device for use with an ENIU, you should assign a Name, default
Port, and | P address. Port Type should be set to TCPIP_ETH.
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Storing RIO Configuration

To transfer the configuration data to the associated Rack System:
1. Choose Load/Store/Verify in the Tools menul.

If the configuration has not been saved, the message, “Please save thisrack system
first,” will appear, followed by the “Save As’ dialog box. Y ou must save the rack
system once before the Load/Store/Verify dialog box can be opened. After you have
saved the rack system once, auto-saves will be performed when thiscommand is

invoked.
2. IntheLoad/Store/Verify Hardware Configuration dialog box select a Device and a
Port.
Load/5Storef¥erifty Hardware Configuration | x|
Device Pon L
0 COk1 *5) Load
MNILUExample COM2
COM3 sl Store
COM4
ENET ,
port_1 & Werify
Clear |
Close |
Helg |
FReachy 0%

3. Click the Store button. The programming software will automatically connect to the
NIU.

Note: If you attempt to store a hardware configuration to an NIU that does not
match the type selected in the configuration, an error message will
appear and the operation will be stopped.
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Loading RIO Configuration

To load configuration data from the Rack System:
1. Choose Load/Store/Verify in the Tools menul.
2. IntheLoad/Store/Verify Hardware Configuration dialog box select a Device and a

Port.
3. Click the Load button. The programming software will automatically connect to the
NIU.
Note: If you attempt to load a hardware configuration from an NIU that does

not match the type selected in the configuration, an error message will
appear and the operation will be stopped.

VersaMax Modules with Shared IDs

When the configuration is loaded from arack system, HWC uses the hardware module 1D
to determine the correct module catal og number and description. However, some
VersaMax modul es share the same module | Ds. When aVersaMax rack system containing
these modules is auto configured and the configuration isloaded an incorrect catalog
number and description may be displayed. Y ou will need to select the correct module from
the modules catal og and store it to the rack system. After storing the configuration, you
will be able to load the configuration properly.

The following modules share hardware module I Ds:

|C200M DL 650 |oads as |C200MDL 636
|C200MDL 750 loads as |C200MDL 742
|C200MDL331 loads as |C200MDL329
|C200MDD844 | oads as |C200M DD842
|C200MDL 141 loads as |C200MDL 140

Verifying RIO Configuration

To verify therack configuration:

1. InthelLoad/Store/Verify Hardware Configuration dialog box select a Device and a
Port.

2. Click the Verify button. The programming software will automatically connect to the
NIU, perform the verification, and disconnect from the NIU. The Log window will
display the results of the operation.
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Clearing RIO Configuration

This procedure clears the configuration and forces an autoconfiguration. If you clear the
NIU and then do aload from the NIU, you will be loading a default configuration that will
overwrite your existing configuration.

1. InthelLoad/Store/Verify Hardware Configuration dialog box select a Device and a
Port.

2. Click the Clear button. The programming software will automatically connect to the
NIU, clear the configuration, disconnect and display the resultsin the Log Window..
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Ethernet Global Data Configuration

EGD allows one device (the producer) to transfer (exchange) data to one or more other
devices (the consumers) at aregularly scheduled transfer rate. EGD exchanges can be
configured for a Series 90-30 CPU364, a VersaMax CPUEO5, or a Series 90-70 CMM742.

Caution

EGD exchanges are desgned for simple, efficient
communication of sampled data between devices. They are not
intended for event notification wherethe possibleloss of a
sample of data would be significant. For event notification, it is
recommended that a Service Request Transfer Protocol
(SRTP) connected service be used.

The exchange of datais uniquely defined through a combination of the Producer 1D
(identification number) and the Exchange ID:

e Each device exchanging Ethernet Global data on the network must be assigned its
own unique Producer ID. ThisProducer ID uniquely identifies the source device of
Ethernet Global data on the network. The Producer 1D number isin dotted-decimal
format (likean IP Address). For example, 3.0.0.1isavalid Producer ID.

e An Exchange ID isaunique number that identifies a particular variable or group of
variables to be transferred.

Producing devices and consuming devices operate completely asynchronously to each
other. Therefore, for each device, both the data that the device produces and the data that
the device consumes must be separately defined.

Note:  For the CPUEOQ5, thelocal Ethernet device used for each exchangeis
specified asa Rack/Slot value instead of as a configured Adapter Name.
The CPUEO5 does not support named aliasing and name resolution and
routing. To define EGD exchanges for a CPUEOQS, refer to page 7-36.
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Configuring the Ethernet Interface Adapter Name (CPU364)

If the CPU364 will be used in EGD exchanges, you must specify an Adapter Name.
When you define an EGD exchange, you will use the Adapter Name to specify which
network adapter will produce the exchange.

To specify the adapter name for a CPU364 Ethernet Interface:

e From Hardware Configuration, confirm that the CPU364 has been configured. Also,
confirm that the |P address for the Ethernet moduleis correct. If so, double-click the
CPU dot.

e The Parameter Editor will appear. Choose the Ethernet tab.

e Click the Values fidd beside Adapter Name and type a name for the adapter. When
finished, click the OK button.

Setting Aliases for Remote Ethernet Interfaces (CPU364 and CMM742)

If aremote Ethernet controller will be used in EGD exchanges, you must associate an alias
with the card's | P address. When you define an EGD exchange, you will usethisaliasto
specify which network adapter will produce the exchange.

To specify an dias for aremote Ethernet Interface:

e In Hardware Configuration go to the Edit menu, choose Rack Operations, and select
Name Resolution and Routing (or click the right mouse button and choose Name
Resolution Routing from the pop-up menu).

¢ Inthe Name Resolution and Routing Table dialog box, click the Aliases tab.
e Click the Add Entry button.

¢ IntheAliasfield, typethe name you want to use to refer to the remote Ethernet
controller.

e Click the IP Address field and type the | P address of the Ethernet controller then click
the OK button.

Name Resolution and Routing Table Configuration (CPU364 and CMM742)

7-34

The CPU364 supports the Routing Table feature, an advanced tool for configuring
communi cations between PLCs. The Routing Table should not be configured without
assistance from anetwork administrator. A Routing Table should only be configured
when more than one gateway is to be configured.
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Definitions of routing table terms:

Destination Subnet ID - The destination subnet of the data to be routed is eval uated
againg this subnet ID. A match (same subnets) causes the data to be routed to the next
hop IP address.

Destination Subnet Mask - The mask associated with the destination subnet under
evaluation.

Next Hop IP Address - The I P address where the data should be sent next to progress
toward itsfinal destination.

Cost - Thisfidd isreserved. Default valueis 1.

Accessing the Routing Table Configuration

From Hardware Configuration go to the Edit menu, choose Rack Operations, and
select Name Resolution and Routing. (or click the right mouse button and choose
Name Resolution and Routing from the shortcut menu). The Name Resolution and
Routing Tables dialog box will display.

In the Name Resol ution and Routing Tables dia og box, click the Routing tab.
Click the Add Entry button.

In the Destination Subnet ID field, enter the subnet ID (in dotted decimal
format) of the remote subnet to which you wish to route data (for example,
4.12.20.0).

In the Destination Subnet Mask field, enter the subnet mask associated with that
remote subnet (for example, 255.255.255.0).

In the Next Hop IP Addressfield, enter the | P address of the local gateway to
which you wish to send the data (for example, 3.16.32.1), then click the OK
button.

Subnet, Subnet ID, Subnet Mask

The subnet mask isa mechanism to logically divide alarge network into smaller subnets
according to your local assignment of | P addresses to nodes on the network. Nodes on the
network which have their 1P addresses alike for the bits specified in the subnet mask can
talk to each other directly; nodes whose | P addresses are not alike in these same bits must
talk indirectly, via an intermediate gateway or router.

As described in an appendix to your Ethernet modul e user manual, the 32 bits of an IP
address are divided between anet id part and a host id part. (The class of the IP address
determines how many bits are in the net id and how many arein the host id.) In general,
the net id portion of the |P address (on the left) is assigned by the Internet authorities. The
host id (on theright) is assigned by your local network administrator. Subnetting is
locally optional and consists of designating some (any number) of the host id bitsasaan
extended net id, or subnet id. The added subnet id bits are normally taken from the host id
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bits adjacent to the net id and the subnet mask identifies these bits. In your Ethernet
module configuration, you specify these bits as one (1) and theremaining host id bits as
zero (0). For example:

IP Address: 11.22.33.44

Net Id bits: 255.0.0.0 Net Id: 11.0.0.0
Added Subnet 1d bits: 0.255.0.0 Subnet Id: 0.22.0.0
Subnet Mask: 255.255.0.0 "Extended" Net Id: 11.22.0.0

Subnet ids and subnet masks are entered into the Routing Table when configuring
Multiple Gateways. The extended net id (for example, 11.22.0.0 in the above exampl€)
should be entered for the subnet id.

All nodes on a"subnetted” network must use the same value for subnet mask; subnets are
distinguished by different subnet id's, created by your local assignment of | P addresses.

Defining EGD Exchanges

7-36

Y ou need to specify the operating characteristics and data to be exchanged for each
exchange your PLC will produce or consume. Note the following exchange limitations:

e  The maximum number of exchanges that can be defined for aPLC system isas
follows:

Series 90-70 CMM742 255
Series 90 CPU364 128
VersaMax CPUEOS 16

Thisnumber can be divided up into any combination of produced and consumed
exchanges.

e Upto 100 variables can be configured per exchange. The CPUEOQS isredricted to a
total of 1200 variables across all EGD exchanges.

e Thetota szeof asingle exchange cannot exceed 1400 bytes. Thetota szeis
defined to be the sum of the data type lengths of all of the variables within thelist.
The exchange size is displayed in the Ethernet Global Data dialog box.

To define an EGD exchange:

1. From Hardware Configuration, go to the Edit menu, choose Rack Operations, and
select Ethernet Global Data (or click theright mouse button and choose Ethernet
Global Data from the pop-up menu).

2. IntheEthernet Global Data diaog box, click the Produced Exchanges tab to define
exchanges produced by your PLC or click the Consumed Exchanges tab to define
exchanges consumed by your PLC.
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PLC Timing Considerations

GFK-1670D

Since the PLC scan time and the exchange time settings (Exchange Period for produced
exchanges and Scan Period for consumed exchanges) are asynchronous, the following
should be noted:

The production of a data sample onto the network occurs at the specified Exchange
Period and is independent of the time the data sample is actually updated from the
CPU. The CPU will attempt to update the data sample at the Exchange Period

interval but cannot guarantee delivery at that specific time due to being delayed by the
PLC sweep time. For example, if the CPU is executing logic when the exchange
period expires, the update will be delayed until the logic execution is compl ete.
Therefore, the data sample produced on the network may be a duplicate of a
previoudy sent sample. Use the timestamp feature to verify whether the datais new.
(The CPU364 and CMM 742 use SNTP timestamping. The CPUEO5 uses NTP
timestamping.)

Thefirg update of the data sample from the CPU to the network adapter will occur at
the end of the firgt scan. Thefirg production of data onto the network will occur one
Production Period after the CPU trangtionsto the 1/0 Enabled state.

The CPU in the consumer will scan the data at the Scan Period independent of when
the data is updated from the network. (The network adapter updates the data upon
arrival of the data sample from the network.) Datawill not be updated in CPU
memory unlessit has been received from the network.

A range of reference memory within an exchangelist can be viewed as coherent to
scan if thelength isless than 256 bytes. If interrupts are enabled, a string of multiple
ranges may not all be deposited on the consumer sde during the same scan.
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Ethernet Global Data: Example 1

7-38

Hereisan exampleto illustrate how EGD works. The figure that follows shows three
devices (two PLCs and a PC running CIMPLICITY HMI) participating in an EGD
exchange.

Device A Device B Device C
Assigned Producer ID: 10.0.0.1 Assigned Producer ID: 10.0.0.2 Assigned Producer ID: 10.0.0.3

Exch. Definition: Prod ID 10.0.0.2 Exch ID: 1 *

A

A

Exch. Definition: Prod ID 10.0.0.1 Exch ID: 2

Exch. Definition: Prod ID 10.0.0.1 Exch ID: 1

In this example, Device A produces two exchanges and consumes none, Device B
produces one exchange and consumes one, and Device C produces no exchanges but
consumes three. The exchange produced by Device A and consumed by both Device B
and Device Cisan example of Group Usage, whereby multiple devices consume data
produced by one producing device.
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Ethernet Global Data: Example 2

This example shows the detail s of a smple exchange of data from producing device A to
consuming device B.

Device A
Assigned Producer ID: 10.0.0.1

I I I I .

PLC A sends the information
contained in the memory locations
defined for the following variables:

P_Varl (6 bytes)
P_Var2 (4 bytes)

PLC B receives the sent information
and stores it in the memory location
defined for the following variable:
C_Varl (10 bytes)

Device B
Assigned Producer ID: 10.0.0.2

PLC A sendsthe information contained in the following reference memory locations.
Each byte in the exchange contains eight discretes aligned at byte boundaries.

%1 00001 to %I00016
9%Q00001 to %Q00008

PLC B receives the information and stores it in three consecutive bytes in %G memory, as
follows:

%G00001 to %G00024
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Details of Producing PLC A

The details of the exchange that PLC A produces are defined in the Produced Exchanges
tab of the Ethernet Global Data dialog box:

Local Producer: By default, usesthe IP address of the network interface card closest
tothe CPU of PLC A. The Local Producer can be changed by the user.

Exchange I D: Identifies the packet of data that will be sent.

Net Address Name: The name assigned to the network adapter within this PLC
system that will be producing the exchange.

Consumer Type: Specifies how the consuming device will beidentified (by name, IP
address, or group I1D). For this example, the consuming PLC isidentified by its Local
Producer |P Address.

Consumer Address: The Local Producer IP Address assigned to PLC B.

Send Type: Defines when the exchange will be transmitted. Thisfiedisfixed at
Always.

Producer Period: PLC A will produce the data every 50 milliseconds.
Reply Rate: Not used.

Status Word: A reference address for status memory |ocation where the status word
is stored. The status word can signify when an error has occurred.

Details of Consuming PLC B

7-40

The details of the exchange that PLC B consumes are defined in the Consumed Exchanges
tab of the Ethernet Global Data dialog box:

Local Producer: Usesthe IP address of the network interface card closest to the
CPU of PLCB

Exchange I D: Identifies the packet of data that will be received.

Net Address Name: The name assigned to the network adapter within this PLC
system that will be consuming the exchange.

Producer ID: The Local Producer IP Address assigned to PLC A.

Group I1D: Used when more than one device is consuming the same exchanges from
one producer. Value 0 means only one device is consuming the information.

Consumed Period: The CPU of PLC B will scan thelocal network adapter for new
data and/or status updates every 25 milliseconds.

Update Timeout: The network adapter will set a status error to signal arefresh error
if dataisnot received within 2000 milliseconds.

VersaPro™ Programming Software User's Guide — November 2004 GFK-1670D



[~

e StatusWord: A reference address for the memory location wherethe status word is
stored. The status word can signify when an error has occurred.

e Time Stamp: A reference address for the memory location where thetime stamp is
stored. Thetime stamp can be checked to verify if the datarecelved is anew sample
rather than a duplicate of a previously received sample.

Restoring EGD and Name Resolution

Y ou cannot load EGD or Name Resol ution from the CPU364. When you initiate the Load
configuration process, the confirmation dialog box presents the option of backing up the
EGD and Name Resolution configuration.

To restore these configuration components to your folder, go to the HWC File menu and
select Restore EGD and Name Resolution. A browser window will open to enable you to
navigate to the backup file.

Advanced User Parameters for EGD (CPUEO05)

The Ethernet firmware maintains default values for all advanced user parameters. These
default values satisfy the needs of most applications. Under special circumstances, some
users may need to modify some of these parameters. Advanced user parameters can be
modified using an Advanced User Parameters file, which can be created using an ASCII
text editor. Thisfile contains the name and value of all non-default advanced user
parameters. (The Ethernet firmware assigns the proper default value to every advanced
user parameter not specified in the Advanced User ParametersFile.

All advanced user parameter data for a single Ethernet interface must be provided in a
singlefile.

The Advanced User Parameter fileis named AUP_0_0.apf, where 0_0 specifies the rack
and dot location of the embedded Ethernet interface within the CPUEQS. Thisfileis
placed in the folder containing the PLC configuration. During a Configuration Store
operation, the VersaPro programmer storesthe Advanced User Parameter fileinto the
PLC aong with the PLC Configuration.
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Advanced User Parameter File Format
AUP_r_s
<parameter name> = <parameter value>
<parameter name> = <parameter value>
<parameter name> = <parameter value>
e  One parameter may be specified per line.
e Each parameter islisted by name and value, separated by an equalssign (=).
o All parameter names must be entered in lower case.

e Parameter values are converted to lowercase unless enclosed in apair of double
guotes (" "). The enclosing quotes are removed and the parameter valueis not
converted to lowercase.

e The parameter value data format depends upon the parameter. Numeric parameters
are entered in decimal or hexadecimal format. Hexadecimal values must be
terminated with an "h" or "H" character.

e |Paddress parameters must be entered in standard dotted decimal format. (Example:
10.0.0.1)

e Thesemicolon character delimits comments. All charactersin thelinefollowing a
semicolon areignored.

e Blanklinesareignored.

Sample Advanced User Parameter File

AUP 0O

stpasswd = "system"
g01_udp = 4741H
g01_addr = 224.0.7.121
g02_udp = 4742H
g01_addr =224.0.7.122
; Thisisa comment

The CPUEOQ5 advanced user parameters are Smilar to CPU364 advanced user parameters.
Additional information for the CPU364 is provided in the TCP/IP Ethernet
Communications for the Series 90 PLC, GFK-1541. For the CPUEQ5, refer to the
VersaMax Sation Manager Manual, GFK-1873.
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Configuring VersaMax Nano and Micro PLCs

A VersaMax Micro PLC system consists of a main module and up to four optional
Expanson Units. (The VersaMax Nano PLC does not support Expansion Units.)

The main module contains CPU, 1/0, and HSC/PWM/PTO functions. Expansion Units
provide /O functions only. The compact, lightweight units are designed for 35mm DIN
rail or panel mounting.

The sample system shown bel ow has a main modul e (required) and one Expansion Unit.

il vMMicro *

UDROOS!
o040

(IC200UEXDT1/012 -8 IN, 6 OUT AC(UEXD11), DC(UEXD2)/DC/Relay  |Local Rack |NotSaved 4

Rack/Module Operations

GFK-1670D

To replace a main module (IC200UDR005/010 isthe default), select Replace Module or
Replace CPU from the context-sensitive menu or select Replace CPU from the Edit, Rack
Operations submenu.

To add an Expanson Unit to the system, select Add Module from the context-sensitive
menu or from the Edit, Module Operations submenu. The Expansion Unit is added to the
end of the chain.

To replace an Expansion Unit, select the Expansion Unit and choose Replace Module
from the context-sensitive menu or from the Edit, Modul e Operations submenu.

To remove an Expansion Unit from the system, select Delete Modul e from the context-
sensitive menu or from the Edit, Modul e Operations submenu. Only the last expansion
unit in the chain can be deleted.

Note: The main modul e cannot be deleted from the system.

To remove al Expansion Units from the system, select Clear Rack from the context-
sensitive menu or from the Edit, Rack Operations submenu.

When you add or replace amodule, the Parameter Editor window will appear.
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Counter, Pulse Width Modulation, and Pulse Train Output

To configure the High Speed Counter, Pulse Width Modulation, and/or Pulse Train Output
functions, go to the Edit menu and select Module Operations, Configure Parameters,
HSC/PWM/PTO. Y ou can aso choose Configure Parameters, HSC/PWM/PTO from the
context-sensitive menu. A Parameter Editor window similar to the one shown below will
appear (Nano PLCs have only three counter tabs.) For details on configuring these
functions, choose Module Help from the Help menu.

HEC/PW/FTO Settings | Channel 1 | Channel 2 | Channel 3 | Channel 4 |
Parameters Yalues ﬂ
Cimiar Tlans 4 Type A
Dutput Stop Made: Marmal
Feference Address: 2210459
Length: 24
Feference Address: 7010453 |
[HEC/ P/ PTO 4

PWM Frequency and Duty Cycle

The frequency and duty cycle of the PWM output are specified from the application
program. Pulse Train Output frequency is also controlled from the application program
(duty cycle is nominaly 50%).

For details on configuring and using these features, refer to Chapter 10 of the VersaMax
Micro PLCs and Nano PLCs User’s Manual, GFK-1645.

Configuring Averaging Filter for Analog Input Potentiometers

7-44

VersaMax Micro PLCs have two potentiometers, located bel ow the Run/Stop switch, that
can be used to manually set input valuesthat are stored in %A116 and %AI117.

The number of samples to be averaged can be controlled by the application program. By
default, 16 samples will be averaged.

For details on configuring and using thisfeature, refer to Chapter 9 of the VersaMax
Micro PLCs and Nano PLCs User’s Manual, GFK-1645.
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Configuring Series 90 Micro PLCs

A Series 90 Micro PLC is a self-contained module that provides CPU, 1/0, and
HSC/PWM/PTO functions. The 23 and 28-point Micro PLCs support up to four optional
Expanson Unitsthat provide I/O functions only. The compact, lightweight unitsare
designed for 35mm DIN rail or panel mounting.

The sample system shown bel ow has a main modul e (required) and one Expansion Unit.

I S90Micro *

[ICE93UERT /012 - & IN, 6 OUT AC{UEXD11), DC{UEXD12)/DC/Relay [Local Back [MatSaved 7

Rack/Module Operations

GFK-1670D

To replace amain module (IC693UDR005/010 isthe default), select Replace Module or
Replace CPU from the context-sensitive menu or select Replace CPU from the Edit, Rack
Operations submenu.

To add an Expanson Unit to the system, select Add Module from the context-sensitive
menu or from the Edit, Module Operations submenu. The Expansion Unit is added to the
end of the chain.

To replace an Expansion Unit, select the Expansion Unit and choose Replace Module
from the context-sensitive menu or from the Edit, Modul e Operations submenu.

To remove an Expansion Unit from the system, select Delete Modul e from the context-
sensitive menu or from the Edit, Modul e Operations submenu. Only the last Expansion
Unit in the chain can be deleted.

Note: The main module cannot be deleted from the system.

To remove al Expansion Units from the system, select Clear Rack from the context-
sensitive menu or from the Edit, Rack Operations submenu.

When you add or replace amodule, the Parameter Editor window will appear.
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Counter, Pulse Width Modulation, and Pulse Train Output

To configure the High Speed Counter, Pulse Width Modulation, and/or Pulse Train Output
functions, go to the Edit menu and select Module Operations, Configure Parameters,
HSC/PWM/PTO. Y ou can aso choose Configure Parameters, HSC/PWM/PTO from the
context-sensitive menu. A Parameter Editor window similar to the one shown below will
appear (Nano PLCs have only three counter tabs.) For details on configuring these
functions, choose Module Help from the Help menu.

HEC/PW/FTO Settings | Channel 1 | Channel 2 | Channel 3 | Channel 4 |
Parameters Yalues ﬂ
Cimiar Tlans 4 Type A
Dutput Stop Made: Marmal
Feference Address: 2210459
Length: 24
Feference Address: 7010453 |
[HEC/ P/ PTO 4

PWM Frequency and Duty Cycle

The frequency and duty cycle of the PWM output are specified from the application
program. Pulse Train Output frequency is also controlled from the application program
(duty cycle is nominaly 50%).

For details on configuring and using these features, refer to Chapter 5 of the Series 90
Micro PLC User’s Manual, GFK-1065.

Configuring Averaging Filter for Analog Input Potentiometers

7-46

VersaMax Micro PLCs have two potentiometers, located bel ow the Run/Stop switch, that
can be used to manually set input valuesthat are stored in %A116 and %AI117.

The number of samples to be averaged can be controlled by the application program. By
default, 16 samples will be averaged.

For details on configuring and using thisfeature, refer to Chapter 8 of the Series 90 Micro
PLC User’s Manual, GFK-1065.
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Hardware Configuration Reference View

HWC Reference View provides information about references all ocated when modules are
added to therack system. Thisview is updated each time an 1/0 or specialty moduleis
added to or deleted from the system.

The Reference View is a dockable view, which meansthat you can select it with your
mouse and move it anywhere in the HWC main window. Y ou can control display of the
reference view. To display or hide the reference view, seect the View menu and click
Reference View.

The reference view maintains a separate tab for each reference type used in HWC (%l
%Q, %AIl, %AQ, %G, %M, %R, ...). To view reference information for a specific
reference type, click the tab that corresponds to that reference type.

%A %80 %G % %M %0 |%R %S |%sa |%sB |wsc |%T |
Overlap | Starn End Addr hem Type Catalog #

0001 0080 0.1 Consurmed | ICB93CPU364

0081 0144 0.2 Consured  |ICB93DSM302

0145 0208 0.3 Consurned | ICE93DSM302

0209 0272 04 Consured | ICB93DSM302

Total %I 0272 Highest 0272 Limit: 2048

Each row provides reference point assignments for a specific module. The columns are
configured as follows:

e Overlap: By default, non-fatal overlaps are identified in blue text and fatal overlaps
areidentified in red text.

e Start: Displaysthe starting reference point assignment for the module.

e End: Displaysthe ending reference point assignment for the module.

e Addr: Displaysthe module' s Rack/Slot address in theform R.Swhere:
O Risthereativerack number (Oindicatesfirst, or main, rack)

O Sisthereative dot number within the assigned rack (0 indicates the leftmost
dot)

e Mem Type: Identifies whether the module produces or consumes data in the
allocated memory area.

e Catalog #: Display’sthe modul€ s catal og number.
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Hardware Configuration Log View

HWC offers alogging facility which records and maintains a history of HWC events and
status information. The datais saved in a separate log file on the PC hard disk, and may be
accessed through multiple edit sessions. The default size of thelog file default isIMB. If
the log data exceeds this size, the oldest log information is overwritten with new log data.

Mar 04, 1333 05:52:21 - HWC Opened ;I
kar 04, 1999 05:52:24 -V alidating Hardware Confiquration - chkfinal_vmas

kar 04, 1333 05:52:24 -V alidating Hardware Configuration completed. Emors
Mar 04, 1933 05:54:4E - Edit Module I[C200PWwWRO0T at [0.CPU] - chkfinal_wr
bar 04, 1993 05:54:46 - Replace Module IC200PWwWRO0T at [0.CPUY with Mo
kar 04, 1933 05:55:17 - &dd Baze [C200CHS003 at (0.1] - chkfinal_wmax

Mar 04, 1999 05:55:32 - Edit Module GEMERIC_AIM at [0.1] - chkfinal_wmax
bar 04, 1333 05:55:32 - Add Module GEMERIC_AIM at [0.1] - chkfinal_vmas
kar 04, 1933 05:55:59 - Validating Hardware Configuration - chkfinal_wmas

bar 04, 1993 05:55:55 - Validating Hardware Configuration completed. Emors —l
kar 04, 1933 05:56:00 - Save A acksvztern C:\Program FilezshGE Fanuc .-'-‘-.ut_u:urILI
4] 3

HWC provides two modes for recording log data:

e Exception Only Mode: Only warnings and exception conditions are recorded in the
log.

e Audit Trail Mode (default mode): Informational messages (such as module deletes,
adds, etc.) arerecorded in the log, in addition to warnings and exception conditions.

To change the setting for the log file, select the Tools menu and choose Options. The
Options dialog box will display, alowing you to set Audit Trail Mode and adjust the
default log file size.

The Log View is a dockable view, which meansthat you can select it with your mouse
and move it anywhere in the HWC main window. Y ou can control display of thelog
view. To display or hidethelog view, sdect the View menu and click Log View.
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Hardware Configuration Power Consumption View

The Power view displays current power consumption statistics for the power supply that is
providing power to the currently selected module. These statistics are provided to assist
you in monitoring the power requirements of the 1/0O modules you are configuring in the
individual racks.

To enable or disable docking, choose Dock from the popup menu. To change the color
scheme, see Error Notification.

Following isa summary description of the power consumption statistics displayed:

e Thebar graph shows the percentage of power used for each voltage and the total The
bar graphs show the percentage of power used for each voltage and, for Series 90-30
racks, the percentage of total system power used.

e For VersaMax racks, Used and Supplied power statistics are shown in Amps.
e  For Series 90-30 racks, Used, Supplied power statistics are shown in Watts.

e AVL Ext (available externdly) displays the external power available at each voltage
and the total available externa power in Watts. (Series 90-30 systems only)

Power Consumption Limit Calculations

The Power view displays graphs showing amount of consumption for the various voltages
produced by the power supply. In addition, for Series 90-30 racks, the graph shows a
system Total graph bar, which represents the percentage of overall total power supply
capacity that is currently used. Please note that the system total istypically not a
summation of all the voltages produced by the power supply, but rather, alesser value.

The 90-30 power supplies are power limited, and therefore display units are Watts.
Conversely, the VersaMax power supplies are current limited, and therefore display units
are Amps.

GFK-1670D Chapter 7 Configuring PLC Hardware 7-49



7-50

e ez Popup Menu
am Veltags vetage ¥ Allow docking
Hide
TE
=1
+E.o +3.2
100 el 3 St a g
ZE
o
Usad
SEuppl
Normal Range
¥Waming Range
Usad 1.1ZE
Eupplked 1.550 o250
Exceeded Range

Capacity, in amps

VersaMax Power View

+SV0OC + 24 00C 24 00C Total

100 Relay lzolated System

¥faming Range
Exceeded Range

11.250 15000 F6.750

Uzed v.200
capac“y in watts ,—[Supplied 15.000 15.000 20,000 30,000
' Ayl Ext 0.000 0.000 -E.750 0.000

Series 90-30 Power View
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Components of the Power Consumption View

Power Supply Whose Statistics are Displayed

Thisis always the most immediate leftmost power supply to the selected module. For a
90-30 System, the Power Supply will always bein dot 0, sincethereis only asingle
Power Supply per rack. For aVersaMax System, which supports multiple Power
Supplies, the power supply can bein any slot and isthe first one encountered traveling left
from the selected module.

Normal Range

Power Consumption percentage bars representing less than 75% consumption are
displayed in the Power Normal color (default is green).

Warning Range

Power Consumption percentage bars representing more than 75% to 100% consumption
are displayed in the Power Warning color (default is yellow).

Exceeded Range

Power Consumption percentage bars representing greater than 100% consumption are
displayed in the Power Error color (default isred). Notethat if consumption is exceeded,
the labdl at the bottom of the graph displays the actual amount used, but the percentage bar
does not show greater than 100%.

Note: To change thenormal, warning, and error colorsin the Power View
display, choose Options from the Tools menu.
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Converting Rack Systems

The default hardware configuration is VersaMax. If thisisnot the type you plan to work
with, the type can be changed using the following steps:

1. From HWC, sdlect the File Menu and choose Convert To.

2. Seect the PLC typethat isavailablein thelid.

3. A message box will appear, warning that 1/0 modules will not be carried over to the
new rack system. Please note that this operation cannot be undone.

4. To continue with the conversion, click Yes. To abort the conversion and keep the
existing hardware configuration, click No.

Note: To change the default hardware configuration, go to the Tools menuin

the VersaPro window and select Options. On the General tab, change
the Default Hardware Configuration to the type that you will be using.

Printing Hardware Configuration

You can print your Rack configuration by going to the File menu and choosing Print. To
set print options, click the Range button in the Print dialog box. The following print
options are available:

e You can chooseto print hardware configuration information for the entirerack, or for
arange of modules (selected by rack:dot).

e Youcan sdect to print overview or detal for the configuration:

O
O
O

Overview: Printsthe Rack as shown on the screen.
Detail: Printsthe parameter information for each module in the Rack.

Ethernet Global Data: If your CPU is configured to participate in EGD
exchanges, select this box to print EGD configuration for the CPU.

Reference Details. Prints atable showing start and end memory locations, rack
dot addresses, and other reference data.

Name Resolution: For Series 90-30 CPU364 configurations usng Name
Resol ution, check this box to print the Name Resolution configuration
information.

If you want to change your target printer or paper size or orientation, click the Setup
button in the Print dialog box.
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Using Reference and Variable View Tables

VersaPro provides two View Tables for monitoring the real-time values and states of
elementsin the PLC:

e TheVariable View Tableallows you to group important variablesinto a window for
online viewing.

e TheReference View Tables allows you to group important references into a window
for online viewing.

Multiple View Tables may be open at once.

Chapter Contents
e Overview of Reference View Tables (RVT) and Variable View Tables (VVT)

¢ Information on creating and managing data in the view tables.

81



Variable View Tables— Overview

Variable View Tables (VVTs) alow you to monitor the states of variables. A folder may
have zero or more mixed-type VVTs. VVTsand VVT entries can be cut and copied, and
dragged and dropped between folders.

An example of aVVT is shown below.

Scope:
Shows variable

Address: scope: Global or
Displays PLC Local:block.
Name: reference address

Displays variable name, | for each variable.
which may be user-
defined or match the
Reference Address.

Value:

Displays PLC online
value if you are
connected to the PLC,

with logic equal, and
monitoring active.

onorngacive. |

L r—

cope aluz
2el00081 2100081 Glohal
2aR00216 |22R00216 Glohal
2eR00217
2eR00216 |22R00216 Global
2R00217
25410005 |22AT0005 Glohal

Only the Name column may be edited. All other columns are read-only.

The Vaue column is blank until the Folder is on-line and equal. The value cdll displays
“xx%%" for variables that have no assigned reference address.

If the cell istoo narrow to display the online value, the cell will display ###H.
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Reference View Tables— Overview

Reference View Tables (RVTs) contain alist of references that can be monitored and
updated in real-time. A folder can have zero or more reference tables. RV Ts can be cut
and copied and dragged and dropped between Folders. More than one Reference Area can

be entered into asingle RVT.

The number of entries contained in an RVT does not affect the performance of the RVT.
Performance is affected only by the number of entries that are displayed and have to be

updated in the view.

Example RVTs are shown below.

Format of selected |

address Selected address

Starting address

[SignedTrecimal - 000000000000000010011100010000=R00216  [AddPss

goooooon o1oooono ooooonoo 00100001 00100001 00000000, 00000000 2100081

-15536 #0307 +16, +1 205,

) 0.0=R00202

+0 +2EIDDIJI 0 AT +0,

+1000, +0,

-15536(>RO0210

gooooooo oooooono oooooo0o oooooooo 00000000 00000000, D0 100000T00037

Display format can

be selected for

individual cells 00100000

[22100018 | [Addrass

: IIJIEIDIJIJII IJLILILIUUUUI TTTTUTTT TT0TrrTTy

LR 1L|U|U|U l.lI

128) 22100009

goooooon oioboono oooooooo 00100001 00100001 00000000, Doo00000

Za100081

L T T T T T M 3

>2Al000%

+|]I +[|I +|:|I +|]I +[|I +|:|I +|]I +[|I +4

FRAI007Y

All Reference Addresses are displayed that begin with the closest byte offset smaller than
or equal to the starting address you enter and finish eight columnslater (Ten columns of
data are displayed for %R, %Al, and %AQ reference addresses.) The amount of data

displayed in the columns depends on the format.

Note:

Upon opening a folder created with VersaPro 1.00, the Reference View

Tables will be converted to the new format. However, table format

selections will be reset to the defaults.

GFK-1670D Chapter 8 Using Reference and Variable View Tables
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Creating New Reference and Variable View Tables

8-4

New Variable View Tables and Reference View Tables are created from the fol der
browser CSM or the File menu. Y ou can have multiple view tablesin your folder.
To create a new Reference View Table:

1. From the Folder Browser, click the right mouse button and choose New, View Table,
Reference View Table (or select the File menu and choose New, View Table,
Reference View Table). The New Reference View Table dialog box will appear:

Mew Reference Yiew Table |

M arme;

|| Cancel |

2. Enter anamefor the RVT. Click OK to accept.

3. Thenew RVT iscreated and displaysin the folder window. The new RVT iconis
added to the Folder Browser with the RVT name.

Note: Offsets columns are not populated until you are connected to the PLC
and have enabled Monitoring.

To create a Variable View Table:

1. From the Folder Browser, click the right mouse button and choose New, View Table,
Variable View Table (or select the File menu and choose New, View Table, Variable
View Table). The New Variable View Table dialog box will appear:

Mew Yariable Yiew Table

]
M arme;

I Cancel

2. Enter anamefor the VVT. Click OK to accept.

3. Thenew VVT iscreated and displays in the folder window. Thenew VVT iconis
added to the Folder Browser with the VVT name.
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Customizing View Table Display
Y ou can customize font selection and color for VVTsand RVTs. Perform the following
steps to customize the display:

4. From the Folder Browser, click the Tools menu and select Options. The Options
dialog box will appear. Select the Display tab.

General Display |Ladder| Cammunicationsl MPE/LL Editarsl

Category: —Colors

Local Logic
kaotion Program

Ad|
Eont: ICDurierNew j
see o 3 [ 1
Sample:
LaBhY¥yiz

QK I Cancel Help

5. You can change the font selection and change the color used for the display of online
values.

e Tomodify the settings for the RV T, set the Category to RVT and make the
desired changes. Click OK to accept.

e Tomodify the settings for the VVT, set the Category to VVT and make the
desired changes. Click OK to accept.
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Changing Reference View Table Display Format

Y our selections of Byte, Word, or Dword governs how much datais displayed in each
cell. Formatting for an RVT occurs on atable, not arow, basis. Perform these stepsto
change the display format for aRVT:

1. OpentheRVT.

2. Select the View menu and choose Format View Table. The Format Display dialog
box will appear.

Format Display | %]
Display Type: Display Format:
Bte Binary 0
Unsigned Decimal

Dhard Signed Decimal

Lok |
Cancel |

Octal

| I A e = i =

3. Sdlect the Grouping and Display Format which suits your application needs:
e Grouping Fied
O Byte(each cel contains 8 hits)
O Word (each cell contains 16 hits)
O Dword (each cell contains 32 hits)
e Display Format
O Binay
Hex
Octad
Unsigned Decimal
Signed Decimal
Real (Only available when Dword is selected)
O Scientific Notation (Only available when Dword is sel ected).

O O 0o o O

Y ou can change the display format of an individua cell by selecting the cell and choosing
Display Format from the context-sensitive menu.
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Customizing Variable View Table Display Format

Y ou can customize the value display format for Variable View Tables. To changethe
display format for online values, perform the following steps:

1. OpentheVVT. Sdect row containing the variable where you want to change the

display format.
2. Click the right mouse button and select Display Format from the CSM..
Binary Ctrl+Shift+B
Dctal Ctrl+Shift+0
Hex Ctrl+Shift+H

Unsigned Decimal  Ctrl+Shift+L
[ Signed Decimal Ctrl+=hift+D
Eeal (=it
SEentiicRetehicn Etrlshiies

3. Changethe display to suit your application requirements. The format is changed for
the variable selected.

Note: If the value displays ####, increase the width of the value column to
seethe online value.
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Adding Elementsto a View Table

Y ou can add logic elements (references or variables) to aView Table for online
monitoring.

Y ou may be either off-line or on-line when you add anew entry to a Variable View Table.
If you are on-line and equal to the PLC, the new variabl€e' s data updates automatically.

Adding an Element by Direct Entry to a VVT

1. From the Folder Browser, open aVVT.
2. Select the Namefield on ablank lineinthe VVT.

3. Sdect avariable using the Name field’s drop-down list, or typein avalid variable
name.

4. PressEnter, or select another field. The entered variable and corresponding columns
(address and scope) are displayed in the VVT.

Valid VVT Variable Entries

Valid variable entries may consist of any of the following:
e name

e address (If only an address istyped into the Name field, that address will appear in
both the Name and Addressfields.)

e name, address (The Scope will default to global.)
e name, g (The scope will be assigned as Global .)
e address, g

e name, address, g

e name, local: scope (Scopeisthe block to which the variable should be locally
assigned. For example, to assign a variable with the name "A" locally to a block
named "B", type "A,local:B" in the Namefield.)

e address, local: scope
e name, address, local: scope

The length of avariablein aView Tablereflects the length that was entered into the
Variable Declaration Table. Changes to length may only be made through the VDT.
Information may not be entered directly into the Address or Scope fields.
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Adding an Address to a Reference View Table

1. From the Folder Browser, open an RVT.

2. Onablank line, sdlect the Reference Address column. Type areference address in
one of the following formats (%100001 , 11)

3. PressEnter, or select another field. Thereference and corresponding columns are
displayed in the RVT.

Valid RVT Entries

e  Word Memory areas (R, Al, AQ) begin with the address you enter.
e Thesamereference address may be entered and displayed more than once.

o Ifavalueistoolargeto display in the current cell width, “####" s appear until you
increase the column width so that the entire value can be displayed.

e Valid offsets range from 0-99999. If an entered offset exceeds the maximum, an error
message appears informing you of the maximum value and the fact that it has been
exceeded. Monitoring within an RVT can not take place until all offsets are
determined to be within the limits of the PLC.

o If an offsetisvalid, but dataisnot available, a 0 displays. If the offset isnot valid, the
cell remains blank.

Adding a Range to a Reference View Table

1. Openan RVT by double-clicking on it in the Folder Browser.
2. Onablank line, sdlect the Reference Address column .

3. Enter thefirst addressin therange, a comma, and then the last addressin therange.
Multiple reference addresses must be separated by commas. Entering an invalid
multiple range Reference Addressresultsin an error.

e Thesamereference address range may be entered and displayed more than once.

e Valid offsets range from 0-99999. If an entered offset exceeds the maximum, an error
message appears informing you of the maximum value and the fact that it has been
exceeded. Monitoring within an RVT can not take place until all offsets are
determined to be within the limits of the PLC.

o If an offset isvalid, but dataisnot available, a 0 displays. If the offset isnot valid, the
cell remains blank.
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Modifying Information in a View Table

VersaPro allows you to edit the variables contained in a View Table by changing the
Name of avariable. Changing the Namein aView Table sedlects a different variable from
the VDT, and replaces the existing variable in the View Table. True changesto a Name
must be madein the VDT.

Towriteavalue to areference, select the cell corresponding to thereferenceinthe VVT
or RVT, and type the new value. (Y ou can aso place the view table in edit mode by
double clicking in the cell, pressing F10 or choosing Write from the PLC menu.)
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Editing Operationsin View Tables

Using cut, copy, paste in a VVT

Open the VVT from which you wish to cut a variable entry or entries.
Select at least one cdll within each row that you wish to cut.
Bo
Choose Cut or Copy from the Edit menu, click the Cut or Copy button, or
press Ctrl + X to cut or Ctrl + C to copy.

All rows entirely selected are removed from the VVT and placed on the clipboard in
VersaPro lig format (not astext), and other rows shift to fill the cut space.

If you want to insert the variabl es between existing variables on the destination VVT,

rather than overwrite exigting variables, select any cell in the row beneath the desired
insertion point.

If you want to overwrite existing variables, select therows that you wish to overwrite.

Choose Paste from the Context-Sensitive or Edit menu, click the Paste button = or
press Cirl + V. If the variables are inserted, they appear in a new row above the row
in which acell is selected, and are appended to any other affected tableg(s). If the

variables overwrite previous y-existing variables, they appear in the position of those
variables.

Details on Cutting and Copying

GFK-1670D

Variables cut or copied from aVVT can be pasted only in the same or another view
table. They can also be pasted between view tablesin different folders.

Cutting or copying avariablein aVVT does not affect the VDT.
Variables can be cut or copied during monitoring.

Text can be pasted into the name field only when it isin edit mode.

Note: Only entire rows may be cut. Selecting any cell in arow, and then
cutting, resultsin cutting the entire row.
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Details on Pasting

If more variables reside on the clipboard than have been sdlected to be overwritten,
the selected variables are overwritten and the remaining clipboard variables are
inserted into the table.

If fewer variablesreside on the clipboard than have been selected to be overwritten,
as many of the selected variables as possible are overwritten, and therest are deleted.

When you paste to a second instance of aVV T, anew variable is crested in the VDT.

If callisions occur when creating variables in the VDT, an error message appears
describing the problem.

Click OK. A dialog appears alowing you to correct the problem.

Correct the problem. Row validation continues for other variables. If you cancel, the
entire pasteis cancelled.

To drag and drop-cutina VVT:

o o M W Dd PRF

Open the VVT from which you wish to cut a variable entry or entries.
Select at least one cdll within each row that you wish to cut.

Position the mouse arrow over the selected row.

Press and hold the primary mouse button.

Move the variable or cell to the appropriate area.

A graphical representation of the selected areaisdisplayed to indicate asdection is
being dragged. Thisrepresentation changes dynamically when you drag between two
instances of the VVT which have different cell dimensions.

To drop the selection, release the mouse button. If it isvalid in the new location, the
selected variable or cell isremoved from the original position and placed in the new
position. If itisnot valid, the drag and drop operation is cancelled.

To drag and drop-copy in a VVT:

8-12

o o A~ w Dd P

Open the VVT from which you wish to cut a variable entry or entries.
Select at least one cdll within each row that you wish to cut.

Position the mouse over the selected variable or cell.

Press and hold the Ctrl key.

Press and hold down the primary mouse button.

Move the variable or cell to the appropriate area.
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7. A graphical representation of the selected areais displayed to indicate a selection is

being dragged. Thisrepresentation changes dynamically when you drag between two
instances of the VVT which have different cell dimensions.

To drop the selection, release the mouse button. If it isvalid in the new location, the
selected variable or cell is copied from the original position and placed in the new
position. If itisnot valid, the drag and drop operation is cancelled.

Details on Dragging and Dropping ina VVT

Selections may be dropped on any part of arow.

If asection is dropped on the last row of the VVT that would go beyond the last row
of thetable, new rows are created to accommodate the drop.

Variables can be entered more than once withinaVVT.

If a selection is dropped that would go beyond the last row of the VVT, new rows are
created to accommodate the drop.

When a selection is dropped, it overwrites the existing cells.
VersaPro does not allow dragging and dropping a discontinuous set of cells.
When you drop to asecond instance of aVVT, anew variableis created inthe VDT.

If callisions occur when creating variables in the VDT, an error message appears
describing the problem.

Click OK. A dialog appears alowing you to correct the problem.

Correct the problem. Row validation continues for other variables. If you cancel, the
entire pasteis cancelled.

Saving View Tables

GFK-1670D

It isimportant to save changes to both RVT and VV Tswhen editing. This section
describes how to save View Tables.

Online values are not saved with view tables. Online values are maintained in the PLC
and are displayed in the view tables.

To save changes when editing a view table, Select the File menu and choose Save, or click

the Save toolbar button.
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Online Viewing

To view online values for view tables, the folder must be open and you must be connected
with the PLC. In addition, the View Table window must be monitoring PLC data. To set
the View Table to monitoring, click the Monitor All or Monitor Active tool bar buttons.

This section provides detail s about window behavior when working online and describes
how to change values online.

Details about Online Viewing

If thevalueistoo largeto display in the current Value column cell width, "###"
displays until the column width is altered.

Override status is displayed as an underlined value (as in both editors).
Overriding and toggling variables is done through the right mouse menu.

Array Variables (variables with alength greater than 1) display the address, scope,
and value on subsequent lines under the first entry.

To Toggle or Override a Reference in an RVT

8-14

Towork onlinein the RVT, connect to the PLC and perform the following steps to toggle
and override references.

1

Open the RVT. Sdect the View menu and choose Monitoring -> All or Monitoring -
> Active Window.

Place the cursor on an offset of the reference that you want to toggle or override.
Select the PLC menu and choose Toggle, pressthe F12 key or click the Toggle
button. ﬂl The RVT Override/Toggle Bit dialog box will appear.

To override, pressthe F11 key or click the Override button. The appropriate reference
istoggled or overridden.
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To Write a Value to a Reference in an RVT
1. OpentheRVT. Select the View menu and choose Monitoring -> All or Monitoring -
> Active Window.
2. Placethe cursor on an offset of the reference that you want to change.
3. Sdlect the PLC menu and choose Write Reference Value, or click the Write Reference

Value button. @

4. Enter thevalue. Click the OK button to accept. The value iswritten to thereference
addressinthe PLC.

GFK-1670D Chapter 8 Using Reference and Variable View Tables 8-15



Chapter | Motion Programming

The Motion Mate DSM314 is a high performance, easy-to-use, multi-axis motion control
module that ishighly integrated with the Series 90-30 PLC logic solving and
communications functions. VersaPro provides the following capabilities:

e DSM314 Configuration. Allows you to select module settings and default
operationa parameters using SAHWC.

e Motion Editor. Used to create and modify Motion programs. A Motion program
consists of a series of motion command statements that are stored to and executed in
the DSM314. Up to 10 Motion programs and 40 subroutines are all owed.

e Local Logic Editor. Used to create and modify Local Logic programs, which run
synchronously with the Motion program, independently of the PLC’'s CPU scan. This
allows the DSM314 to interact much more quickly with motion I/O signalsthan if the
logic for these signals was handled in the main ladder program running in the PLC.

e Cam Editor. A separately ingtalled utility used to create, edit, and manage Cam
profiles. A Cam profile specifies the response of a dave servo (follower) to a master
position index and isreferenced by name in the associated Motion program. A Cam
block is downloaded to the DSM 314 modul e via the PLC by specifying the Cam
block name in the DSM 314 hardware configuration.

The Moation, Local Logic, and Cam editors are accessed from the Folder Browser.
Motion, Local Logic, and Cam blocks can be dragged, cut, copied, etc. within the Folder
Browser the same as other program blocks, as described in chapter 3. Once created and
saved, Motion, Local Logic, and Cam programs become part of the hardware
configuration and are Stored to the PLC with the other configuration information. For
additional information about configuring and programming the DSM314, refer to the
Motion Mate DSM314 for Series 90-30 PLCs User’s Manual, GFK-1742.
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Chapter Contents

e  Setting Motion Program/Local Logic Editor Options
e Using the Motion Program Editor

e UsingtheLocal Logic Editor

e UsingtheLoca Logic Variable Table (LLVT)

e Saving Moation/Local Logic Programs

e Printing Motion/Local Logic Programs

e  Storing Motion Programs and Subroutines to the PLC
e Restoring Motion and Local Logic Blocks

e Using the Cam Editor

Setting Motion ProgranyLocal Logic Editor Options

1. Choose Options from the Tools menu, or from the Editor CSM.
2. TheOptionsdialog box appears.
3. Seect the MP/LL Editors Tab.

Generall Displayl Ladderl Communications  MP/LL Editars |

Tabs Auta Indent

Tahb Size: Iﬂi " Mone

& Inser Spaces & Default

" Keep Tabs ' Use Previous Line

0K, I Cancel Help

4. Select thetab and auto-indent options you want and click OK.
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Using the Motion Program Editor

To Open the Motion Program Editor

e Click File on the menu bar, select New, Motion, Motion Program.
e The Create New Motion Program dialog box will appear.

Create New Motion Program E3

Mame: QK |
Cancel |

IMDtiDm

Description:

A new Motion program

Help

Motion Module Type: |

e Typethe motion program Name and Description. If more than one motion module
type is available in the drop-down listbox, select the motion modul e type that
indicates the modul e type on which this program will be run. Then click the OK
button. The Nameisrequired. The Description isoptional. A Motion Editor window
for the new motion program block will open. The motion program name appears as
thetitle of the Motion Editor window and an icon for the new motion program
appearsin the Folder Browser window.

e Thetext-based motion programs and subroutines are created in the Motion Editor
window, as shown in the following figure. Ten motion programs and forty
subroutines, maximum, separated by their identifying headers (such as “PROGRAM
1 MULTI-AXIS"), can be programmed in the same editor window and are stored in
the same motion program block.

5 Motion1.blk _ (O] x|
ROGRAM 1 MULTI-2¥IZ -
ACCEL &XT=1 500000
VELOCZ AXIZ1 5000
1: CALL 2
CMOVE AXISZ2 -100000, ABS, LINEAR
DWELL &XIS2 &000
JUMP CTL31, 1

CALL P255 -
1| | »
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Creating Motion Program Logic

The DSM 314 supports 10 motion programs, 40 subroutines, and a maximum total of 1000
motion program statements. Comments and white space are not considered motion
program statements.

Basic Requirements

9-4

Format
e Motion programs and subroutines are written using ASCI| text.

e  Only one motion language statement is permitted per line, and a motion language
statement may not span more than one line. Normal comments may span multiple
lines.

¢ White space and blank lines may be used to improve readability and to separate
certain items.

e The Motion Editor is not case sensitive.

e All motion programs and subroutines must be contained in a single, motion program
block.

Single axis and multi-axis programs and subroutines

A given single axis program mugt be able to run on any one axis specified in the Program
definition statement. Therefore, motion language commandsin single axis programs and
subroutines will not specify an axis. Rather, the axis specified in the PROGRAM
statement is used for all motion commands and subroutines called in the program. Multi-
axis programs and subroutines can only call multi-axis subroutines. Likewise, singleaxis
programs and subroutines can only call single axis subroutines. A multi-axis motion
programisvalid only for axis 1 and axis 2. Axis3 and 4 if enabled in configuration must
be programmed as single axis programs only.

Note: CAM ingructionsarenot valid in Multi-Axis programs.

Program and subroutine definition statements

The Motion Editor requires “Program” and “ Subroutineg” statements that specify
program/subroutine number and axis configuration (PROGRAM 1 MULTIAXIS or
SUBROUTINE 2 MULTIAXIS). These statements are placed on thefirst line of the
program or subroutine. Programs are terminated with an ENDPROG statement,
subroutines are terminated with an ENDSUB statement.  These statements serve as
separators between programs and subroutines, identify the program and subroutine
numbers, and indicate the type of program (single axis or multi-axis).
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Block numbers and sync blocks

Block numbers will be suffixed with a colon (10: for example). Block numbers may
appear adone on aline or preceding a motion command on the same line.

Sync blocks (blocks containing a SYNC instruction) are identified by a line with a block
number followed by the SYNC command (20: SYNC for example).

The SYNC (synchronize block) command is used in multi-axis programming to
synchronize two axes at designated points. For additional information, refer to the Motion
Mate DSMVI314 for Series 90-30 PLCs User’s Manual, GFK-1742.
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Using the Local Logic Editor

To Open the Local Logic Editor

e Click File on the menu bar, select New, Mation, Local Logic Program.
e TheCreate New Local Logic Program dialog box will appear.

e TypetheLocal Logic program Name and Description, select the module type, then
click the OK button. The Name isrequired, the description isoptional. A Local
Logic Editor window for the new program block will open. The program name
appears asthetitle of the Local Logic Editor window and an icon for the new
program appearsin the Folder Browser window.

Local Logic Commands

9-6

Thelocal logic language uses free-format text based constructs derived from the IEC 1131
structured text standard.

Thelocal logic syntax is easy to learn and provides arich feature set that allows you to
accomplish the programming task. For details about Local Logic programming, refer to
Motion Mate DSM314 for Series 90-30 PLCs User’s Manual, GFK-1742.
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Using the Local Logic Variable Table

Local Logic accesses the DSM 314 motion controller variables and parameter registers
using pre-defined variable names. The Local Logic Variable Table (LLVT) displays these
variables, which are organized into six tabs: Axis 1—4, Global, CTL Bits, and Parameter
Registers.

Each set of Axis variables contains Control variables, Status variables and
Faceplate | /0.

Tips for working in the LLVT

e Tochangethewidth of a column, select and drag the divider on theright side of the
column head.

e Tocopy the contents of a selected areainthe LLVT to the Clipboard, press Ctrl + C
or choose Copy from the CSM. To select asingle cell, smply click init. To select a
block of adjacent cells, click and drag, or click, hold the Shift key, and click again.

Y ou can select rows or columns by clicking or clicking and dragging the border at the
top or left side of thetable. Select the entire table by clicking the upper |€eft corner.

e TosorttheLLVT, click in the column you want to sort by, then choose Sort from the
CSM or from the View menu. Choose Ascending or Descending from the submenu
that appesars.

e ToprinttheLLVT, select the LLVT and choose Print from the File menu or press
Ctrl + P.

To open the Local Logic Variable Table

ToopentheLLVT, select Local Logic Variable Table from the View menu, press Alt + 6,
or click the Toggle Local Logic Variable Table button on the toolbar. !l
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Information Provided by the Local Logic Variable Table

The LLVT containsthe following tabs: Axis 1, Axis 2, Axis 3, Axis4, Global, CTL Bits,
Parameter Registers

Each tab provides the following information:

Name

This column contains the variable name, which can be used within alocal logic program.

Type
The data type for this variable.

Attempting to write avalue larger than a given variable size will result in the value being
truncated. For example, if the result of a math operation is 32 bitslong and isassigned to a
16 hit variable only the low 16 bits will be stored. The Parser reportsawarning if aBit
Operand is used as the destination variable in a non-Boolean Math operation (only the
least significant bit of the result would be stored).

Local Logic variables that are less than 32 bitslong are either Signed or Unsigned (except
Bit Operands which are always Unsigned). All Math/Logic operations in the Logic Engine
are signed 32 bit operations (except the 64 bit signed Divide and Modul us operations).
Signed variables that are less than 32 bitslong are automatically sign extended to 32 hits
when they are loaded by the Logic Engine. Unsigned variables are not sign extended.
Thusthe Logic Engine handles all data conversion and limit checking automatically.

Note: The immediate command (%A Q) variables (Torque Limit, Vel ocity
Loop Gain, Follower Ratio, Position Increment, and Position Loop
Time Constant) may have an allowed range that is smaller than the
Local Logic variable size. The modul e reports a warning error code and
rejects any invalid values if the program attempts to write a value
outside the valid range of an immediate command. Refer to the Motion
Mate DSM314 for Series 90-30 PLCs User’s Manual, GFK-1742 for a
description of the allowed range for each immediate command.

Group

Each set of axis-specific variables contains Control variables, Status variables and
Faceplate 1/0. (The Global tab contains only Global variables.)
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Description

This column contains a description of the variable. To view the complete description,
hover the cursor over the cdll, refer to the Motion Mate DSVI314 for Series 90-30 PLCs
User’s Manual, GFK-1742.

R
If this column is checked, the variable can beread by alocal logic program.
W
If this column is checked, the variable can be written to by alocal logic program.
Note: Variables can be Read-Only, Write-Only or Read-Write. The Parser

reports an error if you attempt to write to a Read-Only variable or read
from a Write-Only variable.
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Saving Motion/Local Logic Programs

When ready to save your motion program/subroutinefile to your computer’s hard disk,
either click the Saveicon on thetool bar (looks like afloppy diskette), or click File from
the Menu bar and click Save.

Printing Motion/Local Logic Programs

There are two ways to print amotion program. Y ou can use either the Print function or
the Print Report function. Both of these items may be found on the File menu.

To use the Print function, with the Motion Editor active, click File on the menu bar and
select Print. The Printer dialog box will appear. Make any desired printer setup changes,
then click the OK button.

To print all motion programs as part of areport with other information in the folder, click
File on the menu bar and select Print Report. The Print report dialog box will appear.
Click the Blocks checkbox on the Print Report dialog box. Both motion program and
local logic blocks will be printed as part of this report.

If you want to print only selected motion program blocks, highlight those blocksin the
browser, then click File and select Print Report. Check the Blocks checkbox and then
choose the Selected radio button. Thislimitsthe report to only those blocks that you have
selected.

Soring Motion Programs and Subroutinesto the PLC

9-10

Motion, Local Logic, and Cam programs are stored as part of hardware configuration. To
store motion programming, first put the PLC in STOP mode. Then choose Store from the
PLC menu. In the dialog box, select Store Hardware Configuration and Motion to PLC.

Store Folder to PLC [ ]

¥ iStore hardware configuration and motion ta PLC Cancel |

¥ Store logicio PLC

[ Store stored/overridden values to PLC Help |
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Restoring Motion and Local Logic Blocks

Backup copies of motion and local logic blocks in the open VersaPro folder are
automatically made when you load the PLC configuration, including all motion and |ocal
logic programs from a PLC containing blocks of the samename. VersaPro will only
create these backups if there is a difference between the motion/local logic block stored in
the folder and the block stored on the PLC. A user prompt will ask if you wish to creste
the backups. The backup is one deep. Multiple backups of a single block are not
automatically made. Thisrestore mechanism provides a method of recovering modified
motion program blocks from the PLC without the loss of comments stored in the VersaPro
folder. Commentsare not stored to the PLC and are available only if the VersaPro folder
containing the commentsis available.

TorestoreaMotion (*.mbk) or Local Logic (*.Ibk) block:
1. Choose Restore Motion Blocks from the Folder menu.

2. TheRestore Blocks dialog box will be displayed. The Available Blocks list contains
alist of al backups of the motion and local logic blocks found in that folder. You can
select one or more blocks to restore. If the PLC and VersaPro folder motion blocks
are the same during the load from PLC process, motion backups will not be made and
thelist will be empty. However, if thisisnot afirst timeload and there were motion
block differences between the PLC and the VersaPro folder, those backups will be
displayed in thelist. In other words, when you restore a backed up motion block, the
backup remainsin the folder and will be displayed in thelist unless you physically
remove it.

3. Torestoreasingle motion block, highlight the block and click the Add button.

4. Torestoremultiple blocks, either select the Add All button, or press the Ctrl or Shift
key and use the mouse to select blocks or sections of the list. Then, click the Add
button.

5. If you want to remove a block from the Blocks to Restore List, select the block and
click the Remove Button.

6. Toremove al blocks from thelist, click the Remove All button.

7. Toremove aset of selected blocks, press Ctrl or Shift key and click to select the
blocks and then click the Remove button.
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8. When you are satisfied with theligt, click the OK button. The blocks in the folder

(that have been loaded from the PLC) will be replaced with the backups (from the
VersaPro folder) you selected.

9. Tocancd thereplace operation, click the Cancel button.

Note: When the block isrestored, the backup is not deleted. If you are
running out of disk space and don't want to keep backups, you must use
the MS-Explorer or My Computer to navigate to the folder and
manually delete the backup. Backups have an .mbk (motion) or .Ibk
(local logic) extension.
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Using the Cam Editor

The Cam editor provides a meansto create, edit and manage el ectronic Cam profiles for
DSM 314 motion modules. Each Cam profile specifies the response of a slave servo
(follower) to amaster position index. Cam profiles are referenced by namein the
associated motion program.

Cam profiles are grouped into Cam blocks; each block isintended for download to the
DSM314 module viaa PLC contraller. A block can contain up to 40 profiles.

Installing the Cam Editor

Note: Y ou must have Internet Explorer 5.0 ingtalled on your computer to
ingtall the Cam editor.

The CAM editor isingalled as a separate tool.

1. Itisrecommended that you close all applications including virus checking, Internet
Explorer, and CIMPLICITY HMI software that might be running in the background.
Y ou may need to check the task manager to determine if other applicationsare
running.

Put the Cam Editor CD in the CD-ROM Drive.
Select the CD drive from Windows Explorer.

Run setup.exe to start the installation process

o &~ w D

Follow the user prompts to complete the installation.
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Starting the Cam Editor

9-14

Y ou can open the Cam Editor by adding a new Cam block to the folder or double
clicking an existing Cam block. Y ou can also open the Cam Editor by choosing Cam

Editor from the Tools menu.

Master

Fosition Faosition

w @< 1009 psition |

1000

Curve Fit Order

Coordinates of Selected Point
Slave Position [ axig)

Master Position [X axis]

|—\r’elncity Accel  —.Jark
D04 T S T
Ll beoees Lol
0.02 | immeee- e bemmm o
0.01 4 SR R o
° A
0074 ----- R Boomeey
500 o 500 1.0

F1244,1 [

Sample Cam Profile
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Adding a Cam Block to the VersaPro Folder

To add a Cam block to your VersaPro folder, click File on the menu bar, select New,
Moation, then Cam Program. The Create a New Cam Program dialog box will appear.

Create New Cam Program [X]
Mame: lTl
I Cancel |
Description:

Help |
Iotion Module Type: IDSM 314 j

Type aname and a description for the Cam block and click OK. The Cam Editor will open
and an icon for the new Cam block will appear in the folder browser. ~f Example - CAM

Note: If the Cam Editor is already open, you can also create anew block in
the Cam Editor project browser. The new block will automatically
appear in the VersaPro folder browser.

Opening an Existing Cam Block

To open a Cam block, double click itsicon in the Folder Browser. ~f¥ Example - CAM

The Cam Editor window will appear. Refer to the FrameworX InfoViewer for details on
developing profiles and creating links to profiles in Cam blocks.

Deleting a Cam Block

To delete a Cam block from the VersaPro folder, select the block in the folder browser and
press the Delete key, or choose Delete from the Edit menu or CSM.

Duplicating a Cam Block

To duplicate a Cam block, select it in the folder browser and choose Copy (Ctrl + C) from
the Edit menu or CSM. Y ou can paste (Ctrl + P) the block into the same folder or a
different folder. If you pasteit into the same folder, you will be asked to provide a new
name. (Each component in the folder must have a unique name.)
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Viewing and Editing Cam Block Properties

To view the name, description, and modul e type for a Cam block, select Properties from
the Edit menu or the CSM. The Name and Description can be edited at any time. DSM314
is the only module that supports Cam blocks.

Renaming a Cam Block

To rename a Cam block, select the block, then choose Properties from the Edit menu or
CSM, or press Alt + Enter. Type a new name in the Cam tab of the Properties dialog box.

Using Cam Profiles in a Motion Program

9-16

Cam profiles are referenced by namein the associated Motion program. Cam profiles are
grouped into Cam blocks which are downloaded to the DSM 314 module with the
hardware configuration, viathe PLC.

For a Cam profile to function in a Motion program, the following conditions must be met:

The specified profile must be defined in the Cam Library and linked to a Cam block
(using the Cam Editor). To execute the profile on a DSM 314, this must be the Cam
block specified in the hardware configuration.

A Cam block that contains the profile must be defined in the VersaPro equipment
folder. This can be done in the Cam Editor or in VersaPro (go to the File menu and
choose New Mation, Cam Program).

The Cam block containing the profile must be specified in the DSM314 hardware
configuration and stored to the PLC.

The profile name referenced in the Motion program must match the name defined in
the Cam Library.

For details on using Cam profilesin a Motion program, refer to the user
documentation for the DSM314.

Three instructions are available for programming Cam motion: CAM, CAM-LOAD,
and CAM-PHASE.

Note: CAM ingructionsarenot valid in Multi-Axis programs.
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Communicating with the PLC

Communicating with the PLC is necessary to perform such operations as storing and
loading programs or viewing reference or PLC statusinformation. This chapter describes
how to connect to the PLC and perform basic online operations.

Chapter Contents

This chapter provides the following information:

How to connect your computer to the PLC using the Communication Configuration
Utility (CCU)

How to transfer Foldersto and from the PLC

How to clear Folder data from the PLC and verify PC/PLC Folder information
How to read/write/verify flash memory

How to read/write/verify the EZ Program Store device (VersaMax CPUS)
How to view PLC status information

How to place the PLC in Run or Stop mode

Monitoring logic execution

10-1
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CCU Overview

Many communication issues can be resolved by properly setting the communications
timing parameters which may have been altered from previous programmer sessions on
the same PC. The CCU allows you to view and change your settings for the PLCs that you
connect to over Ethernet, seria line, or modem.

Note: The Associated Device feature provided by the CCU cannot be used
with VersaPro.

Opening the CCU

To open the CCU from VersaPro or Hardware Configuration (HWC), select Tools,
Communications Setup.

To open the CCU from a command line (within an MS-DOS box or from Start -> Run),
type GEFCCU32.EXE. Thisapplication isinstalled in the Windows root directory
(usually C:\Windows for Windows 95 or Windows 98, and C:\WIinNT for Windows NT).
Since thislocation isdways in your path, you do not need to specify the path when
invoking the CCU.

Password

10-2

If a password has been defined for the CCU, you will be presented with a dialog box
asking for a password. If you only want to look at your communications parameters (not
make changes), click the View Only button to view the parametersin Read-Only mode.
To change the password, click the Change Password button on the Password dial og box.

To define or change a password for the CCU, go to the File menu and choose Password.

CCU settings are stored in the GEF_CFG.INI file, located in the same directory as the
GEF_CFG32.EXE application file. If you have lost the password and need to remove it,
open GEF_CFG.INI in atext editor, such as Notepad. Go to the [Global_Parameters)
section near the end of the file and del ete the line that contains
"PASSWORD=XXXXXXXX" where XX XXXXXX isastring of characters representing
the encrypted password.
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Modem Turnaround Time

If you are not using amodem to communicate with a PLC, the Modem Turnaround Time
in the CCU Port tab mugt be set to 0. (A non-zero value for this parameter requiresaCTS
signal from the modem before data can be sent.)

The Modem Turnaround Time parameter in the CPU hardware configuration can be non-
zero even if no modem is present. However, thiswill slow performance and is not
recommended.

Because turnaround timeis added to every communications request, and several requests
are usually required for an operation, the turnaround time is multiplied, requiring longer
times for the timeout parameters. Therefore, if anonzero Modem Turnaround Timeis
used, you should increase the Connect Timeout and Request Timeout values in the CPU
hardware configuration accordingly.
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Connectingtoa PLC

Y ou can connect to aPLC from VersaPro over aseria, Ethernet, or modem connection,
depending on the capabilities of the PLC. Connections are made by identifying a device
and selecting aport. The device specifies information necessary to successfully connect
including the default PC communication port, target PLC type, PLC SNP addressand PLC
IP address. The port identifies the PC port used to initiate communicationsto the PLC.

This section describes the various ways to connect to the PLC: Direct Serial Port,
Multidrop, Modem, and TCIF/IP.

Direct Serial Port Connection

10-4

The simplest method of communicating with the PLC isadirect SNP connection. To
makeit easy to use a direct SNP connection, a preconfigured device name, DEFAULT, is
provided. DEFAULT isdesigned to be used for adirect connection from COM1 on the PC
to the built-in SNP port on the PLC. This device will work for any SNP direct connection
using default protocol settings (19200, odd parity, 1 stop bit).

To connect directly from COM1 on your PC, follow these steps:

1. Connect the serial cable from COM1 on your PC to the RS-232/RS-485 converter on
your PLC.

2. Select the PLC menu and choose Connect. The Connect dialog box will appear. This
dialog box is used to select a device and port to initiate communication with the PLC.

Connect

- Device Screen
= TCRAP = SMP Serial Connect

& |ist &ll Devices

il

Cancel
DE-"‘\"iCE ..................................
DEFALULT
E90-30 el
E 3070

MOTPROG_DEWICE

MOTPROG_FORT
port_1

™ Automatic

morh s2lechion

3. Sdect Device "DEFAULT" and Port "COM1". Click the Connect button to establish
communi cations.
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Serial Parameter Settings

If you have used Control software version 1.00 and earlier, your communications
configuration may contain invalid settings for some of the SNP timers (SNPisthe

GE Fanuc proprietary protocol used to communicate to PLCs over aserid ling). VersaPro
can inherit these settings since it uses the same communications driver. If you encounter
communications difficulties, it isrecommended that you check the settingsin the Port tab
of the CCU for the serial COM port that you are using.

1. Openthe CCU and select the Portstab. Select the SNP port. (COM 1 istheinitially
configured port for the DEFAULT device.)

2. Sdlect the Display Advanced Parameters checkbox.
3. If you need to make changes, click the Edit button. The Edit Port dial og box appears.
4. Todisplay timer values, Click the Advanced button.

—Font Selection —FPon Settings ok |
Mame ICOM] Stophits Iﬁ e
Type [FNPseraL o] | | T 0DD = _credt |
Fhysical Port ICOM1 j Bleelreiiz I1 5200 'l ﬂl

- Hel |
Time Romey o JI = —
— NP Timers in millisecaonds ———— PN .
SMP_T1 0 todem I :l
SNP_T2 3000
SNP_T3 10000 — Timeouts in milliseconds

i ctTi t
SNP_ T3P e annect Timeou Imggg
SHP_T3PF £R000 Reguest Timeout |1BDDD

SNF_T4 50

(=]

T

SHP_TS 10000 —PFort supports Multisession

SMNF_TEF 10100 Multisession YES -

ShP_TEFFP 10750
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5. Edit the settings as required for your application. The following settings are

recommended:
Par ameter Recommended Value

Request Timeout | 20000 or higher (units are in milliseconds, highest valid vaue is 63000).

SNP_T3 At least 250 greater than Request Timeout. For example, if your Request Timeout
parameter is 20000, set SNP_T3 to 20250 or more.

SNP_T3P At least 250 greater than the SNP_T3 parameter. For example, if your SNP_T3
parameter is 20250, set your SNP_T3P parameter to 20500 or more.

SNP_T3PP At least 250 greater than the SNP_T3P parameter. For example, if your SNP_T3P

parameter is 20500, set your SNP_T3PP parameter to 20750 or more.

6. Tosave your changes, click OK on the Edit Port dialog box and on the main CCU
screen.
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Multidrop Connections

If a Multidrop configuration has never been defined for a device, or your PLC hardware
configuration has not been set to support these connections, follow the instructions bel ow.

The physical connection from PC to PLC will depend on your application; see Appendix
B, “Communications Cabling,” for details about cables and connectors.

Configuring Your Device and PLC CPU

GFK-1670D

If your application requires that you change the default serial port settings from the SNP
default (19200, ODD, 8 DataBits, 1 Stop Bit) or set an SNP ID, do the following:

1. Openthe HWC filefor your application and double-click the PLC CPU.
2. Inthe Parameter Editor, select the Settingstab.

3. Makethe appropriate changesto the serial port settings and/or SNP ID. Close the
Parameter Editor and save the hardware configuration.

I Example (0.1) IC693CPU364 |- [O] x|

Seftings |Scan | Memuryl PuwerCDnsumptiDnl Ethernetl RS-232 Port (Station Manager)l RS-232 Part (EM 4 | "l
Parameters Yalues ;l

Checksum Wards: g

Data Rate (bps): 19200

Farity: Odd

Stop Bits: 1

todem Tumaround Time (01 Sec/ C 0

Idle Time (Sec): 10

Timer Faults: Dizabled

SHPID:

Key Switch Run/Stop: Disabled |

temaony Protect: Disabled

Ignore Fatal Faults: Disabled A4
|Series 80-30 CPU Model 364 | y

4. Storethe hardware configuration changes to the PLC.
5. Repeat this process for every CPU in the multidrop system.

Once you have made necessary changesto the SNP default settings for the PLC CPU, you
need to change the settings for the PC port. Follow these steps to modify port
configuration for the PC.

1. From the Tools menu, choose Communications Setup. (If apassword has been
defined for the CCU, the Password dialog box will appear. Enter your password and
click OK to continue.) The main screen of the CCU will appear.
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2. Toadd anew device, click the New button. The Add New Device dialog box will
appear.

Device Mame -Selected Device Parameter Settings ————————————————

‘ Device Model I vl

Default Port I vI
Associated I vI

taocem

Associated I ,I

Device

I

LCancel

dl

Help

Device Address

SNPID I(NULL)
IP Address I _ _

Enter 1 or more addresses

3. Set the Default Port to match the PC port you will be using (COM 1 through COM4)
and enter the SNP ID for the PLC, if one exigts. (SNP ID is used only for multidrop
configuration.) Click OK to add the device.

4. To change default seria port settings, click the Portstab, highlight the PC port you
want to modify (COM1 through COM4) and click Edit. The Edit Port dialog box will
appear. Customize the port configuration to suit your application. (To access SNP
timers, click the Advanced button. For details on SNP timers, see page 10-5.) Click
OK to save changes for the port.

— Fort Selection -Fort Settings 0K
MName I(_;OW Stophits I1 v] - :
Cance
T Farity ooD -
ype [sHP_sERIAL

Baudrate |1 8200 v| Default
todern Turmarounc Ig ﬂ Help
Time (10ms) -

Advanced »»
Associated I v|
tModem

Fhysical Port

[k
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Connecting to the PLC

To connect to the PLC:

1. InVersaPro, select the PLC menu and choose Connect (or click the Connect button
g
_“[ on the PLC toolbar ).

2. Select the Device and Port configured in the CCU. Click the Connect button to
establish communications.

3. When the connection is made, the status information at the bottom of the screen will
change to Connected.

TCP/IP Ethernet Connection

If a TCP/IP Ethernet configuration has never been defined for a device, or your PLC
Ethernet Interface has not been configured, follow the instructionsin “ Configuring Y our
PLC and PLC Hardware.”

Configuring Your PC and PLC Hardware

Before connecting via TCP/IP Ethernet, you must set the |P addressin your PLC Ethernet
Interface. Perform these stepsto configurethe PLC |P address:

1. From HWC, add an Ethernet module (CMM742, CPU364, or CPUEO5) to the rack
system.

2. SetthelP Address for the module. Store the hardware configuration to the PLC CPU.

Once you have configured the | P address for the PLC CPU, you need to change the
settings for the PC port. Follow these steps to modify port configuration for the PC.

1. Connect your PLC and PC to the Ethernet network.

2. From the Tools menu, choose Communication Setup. (If a password has been
defined for the CCU, the Password dialog box will appear. Enter your password and
press OK to continue.) The main screen of the CCU will appear.
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3. Toadd anew device, click the New button in the Devices tab. The Add New Device
dialog box will appear.

Add New Device

-

4. Set the Default Port to ENET and enter an IP Address that matches the |P Address
configured for the Ethernet Interface in HWC. Click OK to add the device.

5. Tocustomize global timeouts, click the Portstab, select ENET, and click Edit. Click
Advanced to access global timeout parameters.
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Connecting to the PLC

To connect to the PLC:
1. Sdect the PLC menu and choose

Connect (or click the Connect !

o} ~ Device Screen
button _“[ on the PLC toolbar). .
) ) &+ TCRAP " SMP Serial -Eonnect
The Connect dialog box will £ List All Devicss -
appear. Select the Device Name Cancel |
and Port (ENET) for Ethernet - Device - Part
communication. Click the CLEAM ROOM COM1
] CLEAM RO Hel
Connect button to establish E g DHSHLT Egmg _MELJ
communications. E30-70 oM
EMET
MOTPROG_PORT
L t1
2. When the connection is made, the Parf- I~ Automatic:
status information at the bottom of POk SElEstion
the screen will changeto
Connected.

GFK-1670D Chapter 10 Communicating with the PLC 10-11



10

Modem Connections

If a Modem configuration has never been defined for a device, or your PLC hardware
configuration has not been set to support these connections, follow the instructions bel ow.
Y ou will need to configure modem settings in the Windows Control Panel and in the
Communication Configuration Utility (CCU).

When setting up VersaPro to communicate with the PLC viamodem, you should ensure
that the settingsin the PLC match those of the modem.

Note:

Changes made to Modem Properties through the CCU arenot
saved in the operating system modem settings. To retain these
changes, you must edit the Modem Propertiesin the Windows
Control Panel.

Modem Configuration and Cabling

10-12

Refer to the setup documents (cabling, AT commands, general setup) for your modem at:

http://www.gefanuc.com/support/plc/modems.htm.

or on our FaxLink system (804-978-5824):

FaxLink Document Modem
2302 Hayes Optima
2303 Practical Peripherals
2304 Motorola V3225 4-wire leased line
2305 Data-Linc dialup/leased line
2307 MultiTech 1932ZDX
2308 BocaModem V.34 28.8, V.32 14.4 Model M14EW
2310 USRobotics 56K
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Configure the PLC

1. In HWC, configure the desired CPU with the desired datarate, no parity, 1 stop hit,
and a modem turnaround time of 1 (if necessary).

I Example (0.1) IC693CPU364 |- [O] x|
Seftings |Scan | Memuryl PuwerCDnsumptiDnl Ethernetl RS-232 Port (Station Manager)l RS-232 Part (EM 4 | "l
Parameters Yalues ;l
Checksum Wards: g
Data Rate (bps): 19200
Farity: Odd
Stop Bits: 1
todem Tumaround Time (01 Sec/ C 0
Idle Time (Sec): 10
Timer Faults: Dizabled
SHPID:
Key Switch Run/Stop: Disabled |
temaony Protect: Disabled
Ignore Fatal Faults: Disabled A4
|Series 80-30 CPU Model 364 | y

2. Storethis configuration to the PLC.

Configure a Modem in Windows

The programmer's PC port must be set up through the Windows operating system. Select
Start, Settings, Control Panel and then select the Modemsicon. The Modems Properties
diaog box will appear. The Modem Properties should be set to match the PLC's
configuration for number of hits, parity and stop hits.

1. Fromthe Start menu, select Settings, and Control Panel, then double click the
Modemsicon.

2. Inthe Modems Properties dialog box, click the Add button and ingall a standard
modem. The Standard Modem uses a generic communications and configuration
driver.
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***|f a Standard Modem cannot be added (which may be the case for PCMCIA modems
because of the tight integration with Windows), follow steps 3 through 6, paying close
attention to the notes that start with "***". A modem that is not a Standard Modem will
have a name that corresponds to the make and model of the actual modem being used.
Because the Windows communi cations strategy uses TAPI (Telephone Application
Program Interface), anon-generic driver will re-configure the modem and reset user-

Modems Properties HE
General | Diagnostics |
29y
The following modems are set up on this computer:
<# tegahertz Telephony 3Cxk55E6 Maodem
% Standard 9600 bps Modem
#:standard 19200 bps kodem
Adld... I EErrEE PIOREEfES
—Dialing Preferences
Dialing fram:  Default Locatian
Ize Dialing Properies to modify how your calls are
dialed.
Dialing Froperties |
Clase | ISarEE]

edited parametersin the modem upon dialing.

3.

5.

***|f the modem is not a Standard Modem, the Use Error Control checkbox may be
selected. This option should not be selected. The Extra Settings textbox must be popul ated
with the AT commands from the modem configuration settings documentation provided.

6. Click OK and Closeto exit the Modems Properties dialog box.

VersaPro™ Programming Software User's Guide — November 2004

With the standard modem selected, click the Properties button. Under the maximum
speed for that modem, choose the desired baud rate if it is not already selected.

On the Connection tab, Data bits should be 8, Parity should be None, and Stop bits
should be 1.

Click the Advanced... button, and deselect the Use Flow Control checkbox.
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Set up Modem Communications using the CCU

Note: Changes made to Modem Properties through CCU are not
saved in the operating system modem settings. To retain these
changes, you must edit the Modem Propertiesin the Windows
Control Pand (select Control Panel, then Settings).

Note: Do not use the same name for a modem, port, and device in the
CCU. That will cause problems when saving the information to
theinitialization file.

1. Under the Tools menu select Communications Setup. Select the Modems tab.
2. Click New to add anew modem to theligt.

Add New Modem HE

todem MName I

—where ta Dial:
Country Code: IUnited States of America (1) j
Area Code: Igg4

Ehane Mumber; I

—Howe to Dial:
¥ Use Country Code and Area Code

Xour Location: IDefauIt Lacation j

Calling Card: Mane (Direct Dial)

Dialing Properies... |

—Connect Using:

TAPILInE:  [Stancard 9600 bps Moder =
i
(i Configure Line... |
—FPhone NMumbers:
Canonical:
Dialakle:

Displayable: Mo Fhone Number

] | | Cancel
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10.

Give the modem aname and enter the area code and phone number. Click OK to
accept the modem. Do not click the " Configure Line..." button because any
changes made will not be saved.

After amodem has been created, a " Send Break" checkbox will appear in the Selected
Modem Parameter Settings on the Modems tab. If this box is checked, the
programmer will send the break signal to the remote PLC. If theremote CPU has
break-free SNP, thisbox does not need to be checked.

In the CCU, click the Portstab. Click New to add anew port to thelist.

e  Typethe name of the port.

o For Type, select SNP_SERIAL.

e For Physical Port, select the COM port used by the modem on your computer.

e  Set the Port Settingsto be equal with those configured for the PLC CPU.

e For Associated Modem, select the modem that was created in steps 1 through 4.

Click the Advanced button. For Connect Timeout, enter a value (in milliseconds) of
approximately 40000 (40 seconds). Thistime may be longer or shorter depending on
how long it takes for the modem to establish communications.

Edit the Request Timeout and SNP Timer values as required by your application.
Click OK to accept the port.
In the CCU, select the Devices tab. Click New to add anew deviceto thelist.
e For Device Name, type the desired name for the device.
e For Device Moddl, select the type of CPU to communicate with.
e For Default Port, select the port that was created in step 5.
e For Associated Modem, select the modem that was created in steps 1 through 4.

Click OK to accept the Modem. Click OK in the CCU to accept the configuration
changes.

Connecting to the PLC

10-16

1.
2.

In VersaPro, go to the PLC menu, select Connect.

In the Connect dialog box, select the Device and Port that are configured for the
modem.

Click Connect to initiate communi cations. The modem will dial and communications
will beinitiaized. If the modem hangs up approximately 10 seconds after the Connect
button has been pressed, the Connect Timeout parameter has not been changed from
the default setting (see step 6 above).
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Transferring Folders

After you have established a connection to the PLC, you can transfer Folders between
your computer and the PLC. This section covers the following:

e Storing afolder from your PCtothe PLC

e Loading afolder from the PLC to the PC

e Verifying that afolder matches the one currently running in the PLC
e Clearingitemsinthe PLC

e  Performing read/write operations on PLC flash memory

Storing a Folder to the PLC )

Y ou can store hardware configuration, logic or stored/overridden values to the PLC.

In most cases, before storing to the PLC you will need to place the PLC in Stop mode.
Y ou can perform a Run mode store only when you are storing certain program changes
and the folder nickname matches the PLC nickname.

To place the PLC in Stop mode, click the Stop toolbar button _'J or go tothe PLC menu
and choose Stop PLC.

To store the current Folder from your computer to the connected PLC, follow these steps:

1. Confirm that you are connected the PLC. (The VersaPro status bar should indicate
“Connected.” If the status bar isnot visible, press Ctrl + 0.)

2. Click the Store Button '8 (or select the PLC menu and choose Store). The Store
Folder to PLC diaog box will appear.

Store Folder to PLC '

—Options

[ Store hardware configuration and motion to PLC Cancel |

I+ Stare logicto PLC

[~ Store stored/overridden values ta PLC

Help I
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3. Sdlect the folder components you want to storeto the PLC: hardware configuration
and mation, logic and stored/overridden values. (Motion programs for the Motion
Mate DSM 314 module are stored as part of hardware configuration.)

4. VersaProwill gore the selected componentsto the PLC. If the store is successful, a

message box will appear. The Information Window will provide additional details
about the store operation.

CPU Model Checking

When a configuration is Stored, all VersaMax (modular and micro) models reject
configuration for a different model.

Version 8.00 and later 350 and above 90-30 CPUs do not check the CPU modd type
when a configuration is stored (they will accept configuration for a different model).
Versions earlier than 8.00 do have this check (they will rgject configuration for a different
model).

Word for Word Changes in LD

10-18

Word for word changes may be performed on Series 90-30, Series 90 Micro and
VersaMax modular PLCs. (VersaMax Nano/Micro PLCs do not support word for word
changes.)

Changesto the program that do not modify the size of the program are considered word-
for-word changes. Examples include changing the type of contact or coil, or changing a
reference address used for an existing function block.

VersaPro Goes Unequal After Check All or Verify

If the following conditions exist when making a Word for Word reference address change:
e Thereference isthe highest reference used in the program

e Theaddressis changed to alower value (for example from 500 to 499)

e Thereferenceisonly used in onelocation in the program

VersaPro will go unequal with the PLC after a Check All or a Verify because VersaPro
does not update the PLC to the new highest reference used in order to minimize thetime
to make a Word for Word change. To gain equality, you must store the program to the
PLC.

VersaPro™ Programming Software User's Guide — November 2004 GFK-1670D



[0

Loading a folder to Your Computer "2
Y ou can load hardware configuration, logic or stored/overridden values from the PLC to
your PC.
Toload a folder from the PLC to your computer, follow these steps:

1. Confirm that you are connected to the PLC. (The VersaPro status bar should indicate
“Connected.” If the status bar isnot visible, press Ctrl + 0.)

2. Click the Load button e (or select the PLC menu and choose Load). The Load
Folder from PLC dialog box will appear:

Load Folder from PLC

— Ophions

™ Load hardware configuration fram PLC Cancel I

¥ Load logic fram PLC

[T Load overiddenstored walues from PLC

Help |

3. Sdlect the componentsthat you want to load. Choose from hardware configuration
and motion, logic and stored/overridden values.

4. To begin the load procedure, click the Load button.

5. The sdected information will be loaded from the PLC. The Information Window will

display the results of theload operation. If theload is successful, a message box will
display "Load from PLC Completed."

Note: Y ou cannot load Ethernet Global Data or Name Resolution from a
CPU364. When you initiate the Load configuration process, the
confirmation dialog box presents the option of backing up the EGD and
Name Resolution configuration. To restore these configuration
componentsto your folder, go to the HWC File menu and sel ect
Restore EGD and Name Resolution. A browser window will open to
enable you to navigate to the backup file.
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Clearing the PLC

Y ou can clear Hardware Configuration, Logic, stored/overridden values and PLC and 1/0O
Fault Tablesin the PLC.

To clear selected program items from the PLC, follow these steps:

1. Confirm that you are connected to the PLC. (The VersaPro status bar should indicate
“Connected.” If the status bar isnot visible, press Ctrl + 0.)

2. Select the PLC menu and choose Clear. The Clear PLC dialog box will appear.

Clear PLC E3
— Components

[ IHardware Configuration and kotian

v|Program Logic Cancel |
[]Stored Walues

Ciwverridden Yalues
[IPLC Fault Tahle
10 Fault Tahle

Select Al |

Help |

3. Sdlect theitemsyou want to clear inthe PLC. Componentsthat have a check mark
next to them will be cleared. Y ou can select and deselect individua components by
clicking them.

4. Toclear theitems, click the OK button.

5. When the clear operation is complete, a message box will display "Clear Completed
Successfully".
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Verifying Folder Data

GFK-1670D

To verify that the Folder matches what is currently running in the PLC, follow the steps
bel ow. Y ou can verify hardware configuration, logic or overridden/stored values with the
PLC.

1. Confirm that you are connected to the PLC. (The VersaPro status bar should indicate
“Connected.” If the status bar isnot visible, press Ctrl + 0.)

2. From the PLC menu, choose Verify, or click the Verify with PLC button. |;'f=1‘|

3. TheVerify Folder with PLC dialog box will appear.

Werify Folder with PLC

—Optians

[ “erify hardware configuration and motion with PLC Cancel |

¥ “Yarify |ogic with FLC

[ “arify overidden,stored values with FLC

Help |

4. Components that have a check mark next to them will be verified. Y ou can select and
deselect individual components by clicking them.

5. To begin the verify procedure, click the OK button.

6. A message box will confirm that the verify operation iscomplete. The Information
Window will contain details about the Verify operation.
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Reading/Writing/Verifying Flash Memory

10-22

Certain CPU model's support a flash memory option that allows you to store Folder datato

the flash memory device located on the PLC.

To perform read, write, or verify operations on the PLC's Flash memory, follow these

steps:
1. Connect tothePLC.

2. Select the PLC menu and choose Flash/EEPROM. The Read/Write/Verify Flash

Memory dialog box will appear.

Read/{WritefVerify Flash Memory E

— oelect items for operation:
™ Hardware Configuration
¥ Logic

™ Stored/Cwverridden Walues

—Mermony type:
& Flash/EEFPROM

) B2 Prograng Stere

Bead
Write

Werify

Close

e |
|
|

ﬂelp

3. Sdect thefolder components you want for the flash operation. Y ou can select

individual components by clicking on them.

4. Under Memory Type, select Flash/EEPROM.

5. Select the flash operation by clicking the appropriate button :

e Toread from Flash memory to the CPU, click the Read button.

e Towrite from the CPU to Flash memory, click the Write button.

e Toverify that the program datain Flash memory matches that in the CPU, click

the Verify button.

6. When the operation is complete, a message box will indicated success or error.
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Reading/Writing/Verifying the EZ Program Store Device

The VersaMax EZ Program Store device stores configuration and logic and provides the
ability to update configuration and logic in a PLC without the need for a programmer. An
end user can update a PLC by connecting the EZ Program Store device to the RS-485 port
on the PLC and pressing the momentary-contact switch on the device (PLC must not be
scanning 1/0). The user can specify whether the datais written only to the PLC'sRAM or
also to flash memory.

To perform read, write, or verify operations on the EZ Program Store device, follow these
steps:
1. ConnecttothePLC.

2. Select the PLC menu and choose Flash/EEPROM. The Read/Write/Verify Flash
Memory dialog box will appear.

Read/{WritefVerify Flash Memory E
— oelect items for operation: Bead

™ Hardware Configuration ;
Write
¥ Logic
Werify
™ Stored/Cwverridden Walues

g

—Mermony type:
¥ Flash/EEFROM Close
) B2 Prograng Stere ﬂelp

3. Sdect thefolder components you want for the flash operation. Y ou can select
individual components by clicking on them.

4. Under Memory Type, select EZ Program Store.

5. Select the flash operation by clicking the appropriate button :
e Toread from the EZ Program Store device to the CPU, click the Read button.
e Towrite from the CPU to the EZ Program Store device, click the Write button.

e Toverify that the program datain the EZ Program Store device matches that in
the CPU, click the Verify button.

6. When the operation is complete, a message box will indicated success or error.
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Viewing PLC Satus Information

10-24

Once VersaProis connected with the PLC, you can view PLC status information through
the status line at the bottom of the window and through the Status Window dia og box.

When you connect to a PLC, the status line at the bottom of the folder window provides a
summary display of statusinformation.

|FunEnabled | Connected | 1.8 mzec |Equal
Tells whether the Confirms that Shows sweep time
PLCisin Stop or you are and logic equality
Run mode and connected to status.
whether outputs the PLC
are enabled or
disabled

More detailed information is available through the status information dia og box. To view
thisinformation select the PLC menu and choose Status Info, or press F4.

The tabs of the Target Communications Window contain the following information:

e Memory: Supplies CPU deviceinformation, the currently stored program’s name,
and CPU memory usage

o Date: Allowsyou to view, change, or synchronize date and time

e Reference: Displayssizesfor al reference tablesin the PLC CPU aswell asthe
status of all point fault references

e Protection: Displays access level and OEM protection gatus. Allows you to set
access passwords and OEM key.

e  Sweep: Displays sweep modes and times. When VersaPro is connected, you can set
the Sweep Mode and Constant Sweep Time while the PLC isin RUN mode. This
change will only affect the PLC until it is transitioned to STOP. When the PLC is
returned to RUN mode, the default sweep mode takes effect.

Note: Settings for thistab are stored in the PLC, not in the program folder.
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Viewing and Changing Date and Time
To view the current PLC time and date, select the Date tab.

Program: AOH_PLC  PLC State: Run Enabled !

CPU Hiozt
kar 15, 1939 - 02:56:51 P Mar 15,1999 - 08:57:13 PM

Synchronize CPU to Host

Set CPU Date _Time

NEW Date_ .................. | :_NEW T"TIE
P ADD A | i HH:kM:55
[ & [

Ok I Cancel | Spply | Help |

If the CPU’s date and time do not match the host computer’s, you can synchronize to the
CPU clock, or set the CPU date and time.

e Synchronize CPU toHost: Click the Synchronize CPU to Host button.

e Set CPU Date& Time: Typethe month, day, and year (optional) in the New Date
field and type the time in hours, minutes, and seconds (optiond) in the New Time
field. Click the Apply button to accept the changes.

Chapter 10 Communicating with the PLC 10-25



10

Placing the PLC in Run or Sop Mode

Y ou can manually set the PLC for Run or Stop mode. In Run mode, you can choose to
have Outputs enabled or disabled. In Stop mode, you can choose to enable or disable the
1/0 Scan.

To Place the PLC in Run Mode

1. Confirm that you are connected to the PLC.

2. Click the Run PLC button - (or choose Run from the PLC menu).
To Place the PLC in Stop Mode

1. Confirm that you are connected to the PLC.

2. Click the Stop button = (or choose Stop from the PLC menu).

3. Inthe Stop Execution dialog box, choose to enable or disable outputs then click the
OK button.
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Monitoring Logic Execution

VersaPro allows you to view the value or state of an element or operand from the
Reference View Table, the Variable View Table, the Ladder Editor, or the Instruction List
Editor during logic execution. This can provide you with an opportunity to test the
execution of logic, to trigger an event within an executing folder, or to remove an element
from logic execution. Y ou can also monitor multiple blocks simultaneoudly. In order to
monitor values online, the logic must be running on the PLC, and VersaPro must be
logically connected to the PLC.

Turning Monitoring On and Off

1. Connect to the PLC whose executing logic you wish to monitor.

2. Make surethat thelogic in the current folder is equal to that on the PLC.
3. Choose Monitor from the View menu.
4.

From the submenu that appears, choose Active Window or All to determine whether
elementsin only the active window, or al windows, should be updated in rea-time.

If you choose Active Window, the active window is updated with data from logic
execution.

If you choose All, al active windows are updated with data from logic execution.
e IL, LD, VVT,and RVT arethe only active windows that can be monitored.

e A singleactive window updates at roughly 10 times a second over a TCP/IP
connection.

e  When “All” is selected and more than one window is open, the active window
always updates more often than the others. However, each additional open
window dlows this active window’ s updating speed by roughly 1 time per second.

¢ Once monitoring has been turned on, it remains on until specifically turned off.
5. Toturn monitoring off, choose Monitoring from the View menu.

6. From the submenu that appears, choose Off.
Note: In order to view real time updates, |ogic needs to be executing. If you

stop executing logic, the latest values remain displaying until
monitoring isturned off.
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Changing the Display Format of Monitored Logic

Connect to the PLC whose executing logic you wish to monitor.
Make sure that the logic in the current folder is equal to that on the PLC.
Select onevariableintheIL or LD Editor.

Choose Display Format from the Context-Sensitive or View menu.

o &~ NP

From the submenu that appears, choose the format in which you wish datato display.
Y ou can choose:

Octal

Binary

Hex

Real (Only available for the Real datatype)

Scientific Notation (Only available for the Rea datatype)

Signed Decimal

Unsigned Decimal

The display format you select is applied to the selected variables.

Update in progress or unavailable - Press F1 for Help

10-28

The"* Update in progress or unavailable — Press F1 for Help *" message is placed on the
window title bar while VersaPro is waiting for real time data from the PLC. This message
may appear on the Reference View Table, Logic, and Variable View Table windows. This
message will appear momentarily under normal operation whilereal time updates (RTU)
are active.

If this message remains on the window title bar for an extended amount of time, it isan
indication that you have more windows open for RTU than can be supported by the PLC.
In this situation, you should place VersaPro in "Monitor Active' mode using the View
menu or tool bar; or reduce the number of windows open for RTU. The following table
lists maximum number of open windows that can be monitored for each PLC model.

VersaPro™ Programming Software User's Guide — November 2004 GFK-1670D



[0

Maximum Number of Windows and Applications Supported

Target Windows Applications*
VersaMax Nano 2 2
VersaMax Micro 2 4
VersaMax modular 16 serid N/A
8 Ethernet
Series 90-30, Series 90-70 16 serid N/A
8 Ethernet
Series 90 Micro 16 N/A

* Example: VersaPro and the Fault Table count as two applications.

* Example: VersaPro and the Fault Table count as two applications.

Searching for Overrides

When the VersaPro folder is connected to a PLC, you can search the PLC logic for

variables that have overrides. To use this feature, select Search for Overrides from the

PLC menu. Variables that are overridden will be listed in the Information Window.

GFK-1670D Chapter 10 Communicating with the PLC
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Working with Fault Tables

The PLC and I/O Fault Tables display fault information logged by the CPU or modulesin
the PLC. Thisinformation is used to determineif there are problems with the PLC
hardware or software running in the PLC CPU.

You can view, sort, print and clear faults with the Fault system.

Note: The Fault Table system is a separate application from VersaPro with its
own menu bar and toolbar. The Fault Table when minimized is
reduced to a button on the Windows taskbar and does not appear in the
Equipment Workbench window.

Chapter Contents

How to view PLC and I/O Fault Tables
How to obtain details about individual faults
Sorting faults

Saving fault information

Clearing the Fault Table

11-1
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Working with the PLC and I/O Fault Tables

To view the PLC and I/O Fault Tables, your PC must be connected to and online with the
PLC. You can connect to the PLC before opening the Fault Tables. If VersaPro isnot
connected to a PLC, and you open the Fault Table window, then click the PLC or 10
button, the Connect dialog box will appear. (For details, refer to “ConnectingtoaPLC” in
chapter 10.)

Note: Some CPUs do not support multiple connections, so both the
VersaPro main application and the Fault Table cannot be
connected at the sametime. Y ou should disconnect VersaPro from
the PLC and then launch the Fault Table. When you need to
reconnect to the PLC with VersaPro, you should first close the
Fault Table.

Viewing the PLC and I/O Fault Tables

11-2

To view the Fault Table from VersaPro, go to the Tools menu, and choose Fault Table. If
you arein the PLC Fault Table, click the 10 toolbar button to access the I/O Fault Table:

File Edit “iew Comm ‘window Help = |ﬁ' |5|
[rc 10| S| 2] |
CURRENT TABLE: PLC COMMUHICATIONS STATUS: Connected
TOP FAULT DISPLAYED: 0 TABLE LAST CLEARED: 10-02-96 16:06:03
TOTAL FAULTS: 6 EHTRIES OVERFLOWED: 0
PLC DATETIME: 10-04-96 11:12:28
FAULT FAULT DATE TIME
L OCATION DESCRIPTION MM-DD-YY HHMM:SS:mm
0.1 Hull eystemn configuration for run mode 10-03-96 09:09:30.00
0.1 Hull gystemn configuration for run mode 10-03-96 06:48:00.00
0.2 LAHN data memory exhausted - check parms; resuming 10-03-96 06:30:46.00
0.2 User application fault 10-02-96 16:24:12.00
0.1 Hull systemn configuration for run mode 10-02-96 16:17:49.00
0.1 Hull system configuration for run mode 10-02-96 16:07:07.00
For Help, press F1 ONLIME [11:1248 |OWR MUK 5
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To view the I/O Fault Table from VersaPro, click the 1O toolbar button:

File Edit View Comm ‘window Help = =]
rcfio & 2]
CURRENT TAELE: 10 COMMUHICATIONS STATUS: Connected
TOP FAULT DISPLAYED: 0 TABLE LAST CLEARED: 07-05-96 08:57:57
TOTAL FAULTS: 0 ENTRIES OVERFLOWED: 0
FAULT DESCRIPTION: H/A PLC DATETIME:  10-04-96 11:32:36
FAULT CIRC REFEREHCE FAULT FAULT DATE TIME
LOCATION  HO. ADDR CATEGORY TYPE MM-DD-¥Y HH:MM:S5.mm
For Help, press F1 OMLINE [11:324M |OVR MNUM G

Viewing Fault Details

The fault table provides a summary description of each fault. Additional information
describing the fault can be accessed in one of the following ways:

e Toobtain additional information for a specific fault, double-click the fault, or select

the fault and choose Fault Details (Ctrl + F) from the Edit menu. The Fault Detail
dialog box will appear.

MicroTest PLC Detail

IPasswu:urd access failed

Fault Attributes Help |

Adtribute | Walue -

Long/Short 0

Rack 1] Fault Selectar
Slot 1 N

Task Num 4364

Group 132 >

Action 2 =

| R e n

| | ]
Fault Extra Data Baw Data Format
IDDDDDDDDDDDDDDDDﬁﬁﬁﬁﬂﬁﬁﬁﬁﬁﬂﬁﬁﬁﬁﬁ IElyte j

e Tolistdl faults and expanded fault data, select the File menu and choose Save (or
Save As). Once you have saved this information, you can then use atext editor to
view or print thetext file created by the Save operation.

GFK-1670D Chapter 11 Working with Fault Tables
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Sorting Faults

Faults are displayed in the order they are logged (based on date and time). However, you
can select for faultsto be ordered by fault location or grouped by fault description.

To change the order of display, select the View menu, choose Sort and select the key field
for the sorted display.

For the PLC Fault Table, the sorting choices are as follows:

Location

Description

Date/Time

For the I/O Fault Table, the sorting choices are asfollows:
Location

Circuit Number

Reference Address

Category

Type

Date/Time

Note: Torestorethelist to the original dated order, select the View menu and
choose Sort Ascending.

Saving Fault Information

11-4

Y ou can save fault information to atext file to help you document or troubleshoot a
problem. When you save to afile, both the fault table entry and the fault details are saved
tofile.

Perform these steps to save the fault data:

1
2.

Select the PLC or 1/0 Fault Table.

Select the File menu and choose Save or click the Save button Bl within the Fault
Table window.

In the Save As dialog box type the file name for the fault data. (If you previoudy
saved fault information, the new datawill be saved to the same file name))
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Clearing the Fault Table

Y ou can clear the entire fault table by pressing F9 or selecting Clear Table from the Edit
menu. Clearing faults aso clearslatched fault indicationsin all connected logged-in
Genius blocks.

If you select Clear Tableto clear the fault table, the fault bit inthe PLC isreset, and you
can put the PLC back into run mode. If you sdect Clear Entry, the fault bit isNOT reset,
and you cannot place the PLC in run mode.

Caution

Clearing thefault table removesthe faults. However, it does
not fix the underlying problem that generated the fault.
Clearing thefault table will allow the PLC to be put in Run
mode, even though the fault condition may still exist. If the
condition that caused thefault still exists, the fault may be
reported again after storing the configuration, cycling power to
the PLC, or during a Stop-to-Run transition.

Note: Clearing the fault table does clear fault conditionsin the block at the
same time the 1/O fault tableis cleared. Unlike Genius circuit faults, an
I/O fault isnot logged if it persists after the fault table is cleared. After
clearing afault table, it is possible to place the PLC in RUN mode with
an active fault condition that is configured to be fatal. To avoid this
condition, aways clear the fault tables before storing the program and
configuration to the PLC.

Opening Other Fault Tables
Itis possibleto view fault tables in other PLCs, if the port/device assignment has been
established using the Communi cations Setup option found in the Comm menul.
Perform these steps to open other fault tables:

1. Fromthe File menu, select New 1/0O Table or New PLC Table. The Connect dialog
box will appear.

2. Sdlect the Device Name that matches the PLC containing the fault table you want to
open.

3. Sdect the Port that matches the communication link to the PLC.
4. Click the OK button.
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Changing Fonts
Y ou can change the font for the Fault Tables by selecting the Edit menu and choosing Set

Font. The Font dialog box will appear alowing you to change the font type, style, and
size

Note: The font changes will affect only the fault tables, not the other areas
of VersaPro.

Printing Fault Tables

To print the active Fault Table, select the File menu and choose Print or click the Print
button on the tool bar.
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Appendix| VersaPro Menus and Toolbars

A

This appendix shows the menu bars and toolbars used in VersaPro programming software
and the Stand Alone Hardware Configuration tool.

VersaPro Menus

File Menu

The file menu includes standard file and print operations for VersaPro components.

Option

Button

Action

New

Submenu for creating a new folder object.

Save (Ctrl + S)

Saves the selected item.

Save All (Shift + Ctrl +A)

Saves the entire folder.

Close (Ctrl + F4)

Closes the sd ected window.

New Folder (Ctrl + N)

Creates a new folder, or imports an existing folder.

Open Folder (Ctrl + O)

e |@]s

Opens an existing folder.

Close Folder Closes the open folder.

Print % Printsthe selected item.

Print Report Allows you to define which components and blocks should be
included in areport, then print the report.

Page Setup Allows you to specify page parameters.

<MRU list> Lets you open arecently used folder from alist of Most Recently
Used (MRU) folders

Exit (Alt + F4) Closes VersaPro software.
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File Menu, New Submenu

Option Button Action
Subrouting(Ctrl + B) st Creates a Ladder Diagram or Instruction List subroutine.
Externd Creates an externa C block.
Motion Createsa Local Logic program, Motion program, or CAM
program.
View Table Creates a Reference View Table or aVariable View Table.
Edit Menu
Option Button Action

Undo <action> (Ctrl + Z)

Reverses the previous action. The previous action (for example,
Drop or Delete) appears instead of "<action>".

Redo <action> (Ctrl +Y)

Reverses the previous undo action. The previous action (for
example, Drop or Delete) appearsinstead of "<action>".

Cut (Ctrl + X)

Removes the selected item and placesit on the Clipboard.

Copy (Ctrl +C)

7= [i2 |15

Copies the selected item to the Clipboard.

Copy As Copiesthe selected element(s) as either a bitmap image or as text
to the Clipboard.

Paste (Ctrl +V) E Pastes the Clipboard contentsto the selected area.

Delete (Del) Deletes sdlected item(s).

Select All (Ctrl + A)

Selects all items

Find/Replace (Ctrl + F3)

Allows you to Find and Replace a variable Name or Address, a
Call to a Subroutine, or a Jump/Labd or MCR/END_MCR pair

inlogic

Find Next (F3) Finds next item of defined search criteria.

Find In Blocks Finds a particular global or system variable by Name or Address,
(Ctrl + F10) or a Call to a Subroutinein blocks.

Goto (Ctrl + G) AllowsyoutogotoarowinIL logicor arungin LD logic.
Goto Variable Allows you to got to avariablein the VDT.

(Ctrl + F11)

Goto Next Cail (Alt + F3)

In the LD editor, moves the cursor to the next coil with the same
name as the sel ected reference

Properties (Alt + Enter)

Submenu of options related to Properties.
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Edit, Properties Submenu

Option Button Action

Block (Alt + Enter) Allows you to edit the properties of the selected Ladder Diagram,
Instruction Logic subroutine, C program, Motion program, Local
Logic program, or Cam program block. (Properties depend on the
type of block.)

Folder (Alt + Enter) Allows you to view folder properties. Y ou can edit folder

description and nickname and specify a header and/or footer for
the folder printout.

Variable Table (Alt + Allows you to specify temporary and conversion variables for
Enter) converting LD subroutinesto IL and vice versa.
View Menu
Option Button Action
Toolbars (Ctrl +T) Shows or hides tool bars.
Function Toolbars Allows you to expand or compact function toolbars
Status Bar (Alt + O) Shows or hides the Status bar.

Folder Browser (Alt + 1) Opens or closes the Folder Browser window.

Information Window Opens or closes the Information window.

(Alt +2)

Variable Declaration Opens or closes the Variable Declaration Table Window
Table (Alt + 3)

Hardware Configuration Opens the Hardware Configuration window.

(Alt + F4)

MAIN block (Alt + F5) Opensthe _MAIN block.

(8= (8] [@] &[]

Local Logic Variable Opensor closesthe Local Logic Variable Table, if the folder
Table (Alt + 6) containsalLocal Logic program.

Sort Allows you to sort specific columns of the VDT in ascending or
descending order.

Monitor El Allows you to disable or enable rea-timelogic execution on the
PLC in all windows or in the active window.

Display Format Allows you to change the display format of monitored logic.

Format View Table Allows you to determine how datais displayed in the selected

Variable View Table row, Reference View Tablerow, or entire
Reference View Table.

Makes view larger.

Zoom In (Ctrl +"=")

Makes view smdller.

|2

Zoom Out (Ctrl +"-")
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Insert Menu
Option Button Action
Object Allows you to insert an object into the Folder Browser.
Block Allows you to insert ablock into the Folder Browser.
Row (Ins) Inserts arow above the selected row in the IL editor, LD editor,
VDT, or aView Table.
Comment Allows you to insert a comment.
Folder Menu
Option Button Action

Check Selected Block(s)
(Ctrl + F7)

Checks the selected block(s) for syntactic correctness. If no block
is sdlected, this menu option reads "Check Block_Main" and
selecting it resultsin checking the _Main block for syntactic
correctness.

Check All (F7) @ Checks all blocks for syntactic correctness.
Lock/Unlock Locks or unlocks the open folder.
Backup (F8) Backs up afolder.

Restore (Ctrl + F8)

Restores afolder.

Restore Motion Blocks

Allows you to restore individua Motion blocks that have been
backed up during a Load operation.

Find Unused Variables Finds unused variables. The unused variables are listed in the
Information window by Name, Scope, and Address.
Compact Reduces the size of the folder by removing edit history

information from the VDT.
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PLC Menu

Option Button Action

Connect (F9) Connectstothe PLC

Disconnect (Ctrl + F9) Disconnects from the PLC

Store (Alt + F2) Stores the contents of afolder tothe PLC

SEEB

Load (Ctrl + F2) L oads the contents of afolder from the PLC

Verify (F4) Verifies the equality of the current folder and the connected PLC.

Clear Clears the memory of the PLC.

Flash/EEPROM Allows you to read, write, or verify Flash memory.

Search for Overrides When VersaPro is connected to a PLC, searchesthe PLC logic
for variable overrides.

Run (F5) Runsthelogic resdent inthe PLC

Stop (Ctrl + F5) Stopsthelogic resdent inthe PLC

Toggle (F12) Allows you to toggle areference.

FYLEA

Override (F11) Allows you to override areference.

F]

Write (F10) Allows you to write a value to the selected referenceinthe LD

editor, IL editor, VVT or RVT..

[

Tuning Parameters Allows you to tune PID Instructions.

Status Info (Shift + F4) Allows you to view the status of the PLC.

Stops a communi cations action.

E

Abort! (Ctrl + Break)
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Tools Menu
Option Action
Fault table Opens afault table.
Communications Setup Allows you to define communi cations parameters
Cam Editor Opens the Cam Editor, which is used for creating Cam profiles and blocks for

Moation programming.

Import Variables

Allows you to import avariable.

Export Variables Allows you to export avariable.
View Online Cross Displays, in the information window, alist of all variables used in the selected
Reference block by reference type.

View Online Use Tables

Provides atable for each reference type used in the folder. The table identifies
reference addresses used as explicit, implicit, or both. Results are displayed in
the Reports tab of the Information Window.

Convert Block Converts sdlected block from LD to IL or IL to LD.
Non-Nested to Nested Converts non-nested MCR, ENDMCR, JUMP, and LABEL instructions to the
Conversion nested version.

Options (Ctrl + E)

Allows you to set General (language—related), Display (colors, fonts), Ladder
(show fidds, cell width), Motion/Local Logic editor, and Communications
options.

Window Menu
Option Action
Cascade (Alt + 6) Arranges all open block windows so thet all title bars are visible and the active

window isin front.

Tile Horizontally
(Alt +F7)

Resizes and horizontally arranges all open block windows so that al of them are
visible.

Tile Verticaly (Alt + F8)

Resizes and vertically arranges all open block windows so that all of them are
visible.

Arrange Icons (Alt + F9)

Aligns al minimized block windows.

Close All (Alt + F10)

Closes al open block windows.

Next Window (F6)

Moves focus among the active editor window and the dockabl e windows that
are open. (In the editor window, goes to the selected row or cell, which may be
out of view.)

Previous Window
(Shift + F6)

Moves focus among the active editor window and the dockabl e windows that
are open. (In the editor window, goes to the selected row or cell, which may be
out of view.)

[Current Window]

Displays the name of the active window.
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Help Menu
Option Action
Contents and Index Displays VersaPro Help.
About VersaPro Displays information about this version of VersaPro, including serial number.
Also displays free disk space.
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VersaPro Toolbars

VersaPro has six toolbars: the Standard toolbar, the Ladder toolbar, the View toolbar,
the Folder toolbar, the PLC toolbar, and the Function toolbar. Y ou may hide any or
all toolbarsto provide more space to work. Unavailable toolbar buttons appear in

dim gray.
Standard Toolbar

W2 S| E %= 2lcx| 8 el 9

The Standard toolbar is displayed by default, although you can hideit. The Standard
toolbar buttons provide common functions, such as opening folders, saving folders
and blocks, cutting, copying and pasting, and undo and redo.

Function

Creates a new folder.

Creates a new block.

Opens an existing folder.

Saves the selected block.

Savesthe entire folder.

Removes the selected item and places it on the Clipboard.

Copies the selected item to the Clipboard.

Pastes the Clipboard contentsto the selected area.

Reverses the previous action.

Reverses the previous undo action.

Deletes selected item(s).

Sendsthe selected item to a printer.

Displays context-sensitive help.

Aborts a communi cations action.

e EEXEEEEEEEwEE
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Ladder Toolbar

(% 1] olo|o|o|e|e] -G All PLCs

ie e [ o ||

90-70 PLCs only
Use the Ladder tool bar to create ladder logic using "click and drop."

Function
Selects the normal pointer; disables"click and drop™

Normally open contact

Normally closed contact

Normally open coail

Normally closed coil

= hs~ - 03]
ElEleEE= g
=
o
5

Positive transition coil

L Negative trangition coil
= Set cail
Reset coil

Vertical or horizontal wire

CALL ingtruction

Comment row

S REE

Fault contact (90-70 only)

-
il
-

No fault contact (90-70 only)

=
=il

High darm contact (90-70 only)

-4
E
-

Low alarm contact (90-70 only)

ALt
1 Positive transition contact (90-70 only)
m Negative trangition contact (90-70 only)
Note: Pressing the Escape key disables drop mode and makes the pointer

active again.
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View Toolbar

IEEFF E == E

Use the View tool bar to show or hide windows, to open the _MAIN block, or to
magnify or reduce a window's contents. Buttons not related to the current task are not
available.

Function

Shows or hides the Folder Browser

Shows or hides the Variable Declaration Table

Shows or hides the Information Window

EEE:
o
=]

Opens the Hardware Configuration window

Opensthe _MAIN block

[&]

Opensthe Local Logic Variable Table

Monitors al windows.

Monitors the active window.

& |

Turns monitoring off.

Zooms In on (magnifies) the active window's contents

Zooms Out from (reduces) the active window's contents

|2

Folder Toolbar

||

Use the Folder toolbar to check syntax.

Button Function
@ Checks all blocks for syntactic correctness.
Checks selected block(s) for syntactic
correctness.
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PLC Toolbar

o[ sl [~ n] se]

Use the PLC toolbar to connect to a PLC, and to perform operationsinvolving a
connected PLC, like storing and loading, or running and stopping logic.

Button

Function

Connectsto the PLC.

Disconnects from the PLC.

Stores this folder to the PLC.

Loads afolder from the PLC.

Verifies equality between the current folder and
elements present on the PLC.

Runsthe PLC.

Stopsthe PLC.

s EE EE)e

Toggles areference.

F]

Overrides areference.

[

Writes avalueto areference.

H 0
=

Shows the status of the PLC.

Function Toolbar

Use the Function toolbarsto select function block types while programming in the

LD editor. Function groups are listed in a phabetic order.

The Function toolbars can be configured to display in expanded or compact mode.
To change the mode, select the View menu, choose Function Toolbars, then select
Expanded or Compact.

[l Function Grou ] [acos =] =
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HWC Menus
File Menu
Option Action
New (Ctrl + N) Creates a new Hardware Configuration Folder.
Open (Ctrl +0) Opens an existing Hardware Configuration Folder.
Close Closes an opened Hardware Configuration Folder.
Import Stand-Alone Imports an existing HWC Hardware Configuration Folder (.hwcfg) into the current
HWC File Rack System Edit window.

Import Hardware
Configuration Folder

Imports an IOCFG.CFG file (and optional CPUCFG.CFG file), that was produced by
either LM90 or CC90, into a designated new HWC Hardware Folder.

Import from EGD Tool

Imports EGD configuration created by the stand-aone EGD Tool. The EGD Tool
provides a globa view of the EGD exchanges, alows you to easily keep track of
produced, consumed exchanges and provides error and consistency checking.

Restore EGD and Name
Resolution

Restores EGD and Name Resolution configuration from a backup file created during
configuration Load.

Save (Ctrl + §)

Saves an opened document using the same file name.

Save As

Saves an opened document to a specified file name.

Convert To

Converts the current Rack System configuration to a default Rack System configuration
of the type selected:

Series 9030

VersaMax

VersaMax Nano/Micro
Series 90 Micro

(You can only convert a Rack System configuration to a different type of Rack System.
If you want to create the same type of Rack configuration as the current one, use Save
As))

Print (Ctrl + P)

Printsdl or portions of the current Rack System Hardware Configuration.

Print Preview

Displays all, or portions, of the current Rack System Hardware Configuration on the
screen as it would appear when printed.

Print Setup

Selects a printer and printer connection.

Exit

Exits HWC.
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Edit Menu
Option Action
Undo (Ctrl +2) Reverse previous Module operation. Up to 16 levels of Undo are supported.
Redo (Ctrl +Y) Reverses previous Undo operation. Up to 16 levels of Redo are supported
Cut (Ctrl + X) Deletes the selected Module from the Rack System and moves it to the clipboard.
Delete (Del) Deletes the currently selected Module from the Rack System and revertsit to ablank slot
Copy (Ctrl +C) Copies sdlected Module from the Rack System to the clipboard.
Paste (Ctrl +V) Pastes the previously cut or copied Module from the clipboard into the selected dot of the

Rack System.

Expansion Rack System

Submenu of edit operations that are specific to VersaMax Rack Systems.

Expansion Receiver

Submenu of edit operations that are specific to VersaMax Expansion Rack Systems.

Rack Operations

Submenu of edit operations that are specific to the Rack System.

Modul e Operations

Submenu of edit operations that are specific to the selected Module.

Edit menu, Expansion Rack System Submenu

The Expansion Rack System submenu of the Edit menu allows you to select the type
of VersaMax system. Y ou can switch from one VersaMax system type to ancther,
however resulting changes to the configuration cannot be undone.

Option Action
None Thisisthe default VersaMax system, which is created when you select New from the
File menu. It includes only the Main VersaMax 1/O station (no Expansion).
Local Single Rack Includes the Main VersaMax 1/O station and one Expansion I/O Station (Rack). The

Main VersaMax system does not contain a Transmitter. The Expansion 1/0 Station
contains aNon Isolated Receiver and Power Supply Integrated Unit (IC200ERM002).

Multiple Remote Rack

Allows you to configure up to seven Expansion I/O Stations (seven Rack tabs are

always shown). The Main VersaMax rack contains a Transmitter (IC200ETMQ01).
Each Expansion I/O Station contains a Power Supply and Receiver Integrated Unit. The
Non Isolated Receiver (IC200ERM002), which is configured by default, can be
replaced by an Isolated Receiver (IC200ERM001).

Note:

The Transmitter module cannot be selected from the modul e catal og.
The only way to add this module to arack configuration isto choose
the appropriate configuration type. Also, you cannot deletea
Transmitter module from arack configuration except by changing the
rack configuration type.
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Edit menu, Expansion Receiver Submenu

The Expansion Recelver submenu of the Edit menu allows you to select the receiver
for aVersaMax Local Single Rack or Multiple Remote Rack system.

Option

Action

None

Deactivates the Receiver. Thisisthe default selection if no carrier/baseis configured.
Thisoption is not availableif thereis at least one carrier/base configured in the
expansion rack.

Non-Isolated Receiver Unit

Selects the Non Isolated Receiver and Power Supply Integrated Unit (IC200ERM002).
Thisisthe only receiver type allowed for Local Single Rack systems.

Isolated Receiver Unit

Selects the Non Isolated Receiver (IC200ERM002). This option is available only for
Multiple Remote Rack systems.

Edit menu, Rack Operations Submenu

Option Action
Change Rack Type Displays the 90-30 Change Rack Type Dialog. This menu item is not available for
VersaMax systems.
Clear Rack Deletes all modules, excluding the Power Supply and CPU, for the selected Rack.

Configure CPU Parameters

Displays the Module Parameter Dial og, which dlows editing of the configuration
parameters for the Rack System CPU.

Replace CPU

Displays the Module Selection Diaog, which allows for the selection of areplacement
Rack System CPU.

Name Resol ution and Routing

Displays the 90-30 Ethernet Adapter Name Resolution Didog, which alows for the
specification of Ethernet Adapter Naming and Routing Tables. Thismenu itemis not
available for VersaMax systems.

Ethernet Globd Data

Displays the 90-30 Ethernet Global Data Didog, which alows for the definition of
Ethernet Exchange Ids. This menu itemis not available for VersaMax systems.

Add Base/Carrier Displays the VersaMax Add Base/Carrier Dialog, and extends the selected rack with the
selected Base/Carrier. This menu itemis not available for 90-30 systems.
Delete Base/Carrier Deletes the currently selected Base/Carrier in aVersaMax rack. This menuitem is not

available for 90-30 systems.

Insert Base/Carrier

Displays the VersaMax Insert Base/Carrier Didog, and inserts the sel ected Base/Carrier
in front of the sdlected slot of the VersaMax rack. This menuitemis not available for
90-30 systems.

Replace Base/Carrier

Displays the VersaMax Replace Base/Carrier Dialog, and replaces the selected
Base/Carrier inthe selected dot of the VersaMax rack. This menu itemis not available
for 90-30 systems.

Configure Receiver Parameters

Displays the power consumption tab for the VersaMax expansion rack receiver, which
has no configurable parameters. This menu item is available only when the receiver
unit, located in the first dot of the expansion rack, is selected.

A-14

VersaPro™ Programming Software User's Guide — November 2004

GFK-1670D




[«

Option

Action

Copy Redundant Bus

a Destination bus using the default settings for this operation:

Set dl GBC's SBA

GBC modulesin the rack system.

Edit menu, Module Operations Submenu

Option

Action

Configure Parameters
(Ctrl + E)

Displays the Module Parameter Dial og, which dlows for the editing of the configuration
parameters for the selected Module.

Add Module Displays the Module Selection Diaog, which allows for the selection and configuration
of anew Modulein the selected empty rack dot (or Carrier/Basein aVersaMax modular
system).

Replace Module Displays the Module Selection Didog, which allows for the selection and configuration
of areplacement Module for the selected Module.

Delete Module Deletes the selected Modul e from the Rack system.

Expand Bus For a90-70 rack configuration that contains a BEM 731 GBC, opensthe Genius bus

configuration tool. Available when the GBC is selected.

Parameter Menu

Option Action
DataEntry Tool (F2) | Opensthe Data Entry Tool for a selected, editable parameter.
Reset Parameter Resets a single parameter to the Start of Edit Session value or to the Factory Original
Value
Reset Tab Resets all the parameters on the tab to the Start of Edit Session value or to the Factory

Origina value.

Cancel Edit Session

Closes the active parameter edit window without saving changes.

Insert

Inserts arow with default va ues above the sd ected row in certain tabs, such as the
Profibus Slave Information tab.

Delete Deletes the selected row in certain tabs such as the Profibus Save Information tab and
adds a default row to the end of the matrix.
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View Menu
Option Action

Toolbar Shows or hides the tool bar.

Status Bar Shows or hides the status bar.

Log View Shows or hides the on-line HWC Log View.

Reference View Shows or hides the on-line Rack System Reference View

Power Consumption | Shows or hides the Power View window.

Parameter Edit Displays a submenu that alows you to change the Parameter Editor display format.
These options are available only when a Parameter Editor window for amoduleis
open.

View Menu, Parameter Edit Submenu

Note:

These settings are not saved when you close the Parameter Editor. To
set the default display mode for the Parameter Editor, go to the Tools
menu, choose Options and select the Parameter Edit tab in the Options

diaog box.
Option Action

Singlerow Tab Displays the Parameter Editor window in atabbed format. If you resize the window so
that it istoo narrow to display all the tabs, a scroll bar is provided to accesstabsthat are
not visible.

Multirow Tab Displays the Parameter Editor window in atabbed format. If you resize the window so
that it istoo narrow to display the tabsin asingle row, the tabs will be stacked.

Spreadsheet Displays the Parameter Editor window in a spreadsheet format. Tab headings are
displayed in bold, underlined text.

Error Status Displays the Parameter Editor Error List, which identifies parameter errors and alows
you to correct them before closing the window. This option is available only when the
current Parameter Editor window contains errors.

Tools Menu

Option Action

Hardware Configuration
DataView

Displays the PLC Configuration Datain atabbed dial og, alowing for both text and
binary formatted presentation of the contained information.

Options

Displays an Options dial og, which alows you to adjust certain application behavior
such as Log size and Parameter Editor view.

Communications Setup

Opens the CCU. Allows you to define communications parameters.

Load/Store/Verify

If an NIU is configured in therack system, allows you to load, store, verify, or clear the
hardware configuration.
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Redundancy Menu

Option Action
Wizard Opens the Redundancy Wizard window, which can be used to configure redundant 90-
70 CPU and Genius systems. The Wizard automatically creates the 90-70 rack and
Geni us bus configuration according to the selections you provide.
Window Menu
Option Action
Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arrangesicons of closed windows.
Window 1, 2, ... Goes to specified window.
Help Menu
Option Action
Contents Displays a structured Help Table of Contents from which you can get help.
Help Index Offers you an index to topics on which you can get help.
Module Help Provides parameter-specific help for the selected Parameter Editor window.
How to UseHelp | Enumerates the different types of Help availablein HWC and describes how each can
be applied to assist you in learning and using the program.
About HWC Displays the version number of this application.
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HWC Toolbar

A-18

ol e i) T2 ol

Button

Function

Opens Parameter Editor window for CPU.

Opens Parameter Editor window for selected module.

=

[t

Opens the Module Catd og, from which you can select a
modul e to be configured.

i Opens the Module Catd og, from which you can select a
CPU to be configured.
iz Opens the Module Catd og, from which you can select a

modul e to be configured in place of the selected module.

Wl

Re

7

Displays or hides the Reference View, which listsreferences
configured for the rack system.

g

Displays or hides the Log View, which displays a history of
significant events and status relative to your hardware
configuration editing activities.

5

Displays or hides the Power View, which shows the power
consumed by the modulesin the system.
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Appendix| Serial Connections

This appendix describes the serial port, converter, and cables used to connect to Series 90
and VersaMax PLCs for Series 90 Protocol (SNP) aswell asthe Miniconverter Kit. This
information isincluded for reference and for those users who have applications that
require cable lengths different than the factory-supplied cables.
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Serial Port and Cables

RS-422 Interface

B-2

The Series 90-30, Series 90 Micro, and VersaMax PLC products are compatible with EIA
RS-422 specifications. RS-422 drivers and receivers are utilized to accomplish

communi cations between several system components using multiple driver/receiver
combinations on a single cable with five twisted pairs. Thetotal cable length cannot
exceed 4000 feet.

A multi-drop system of eight drivers and receivers can be configured. The maximum
common mode voltage between each additional drop isthe RS-422 standard of +7 Voltsto
—7 Volts. Thedriver output must be capable of £ 2 V minimum into 100 ohms. The
driver output impedance must be at least 120 K ohmsin the high impedance state. The
receiver input resistance is 12 K ohms or greater. Receiver sengtivity is + 200 millivolt.

Caution

Caremust be taken that common mode voltage specifications
aremet. Common mode conditions that exceed those specified
will result in errorsin transmission and/or damage to
components.
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Cable and Connector Specifications

The cable assembly presents one of the most common causes of communication failure.
For best performance construct the cable assemblies according to the recommended
connector parts and specifications.

Item Description

PLC: Seria (RS-422) port with metric hardware

Connector: 15-pin male, D-Subminiature Type, Cannon DA15S (solder pot) Hood: AMP
207470-1 connector shell
Hardware Kit: AMP 207871-1 Kit includes 2 metric screws and 2 screw clips

IBM-AT/XT: Seria (RS-232) port with standard RS-232 connector

Mating Connector: 9-pin female, D-Subminiature Type, Cannon DESS (solder pot) with
Connectors: | DE110963-31 hood or equivalent (standard RS-232 connector)

RS-232/RS-485 Converter: one 15-pin male, and one 25-pin male
connector

15-pin male connector requires metric hardware (same connector, hood, and hardware as
for Series 90 PLC listed above)

25-pin male D-Subminiature Type, Cannon DA25S (solder pot) with DB110963-3 hood
or equivalent (standard RS-232 connector)

Computer grade, 24 AWG (.22 mm2), minimum with overall shield
Catalog Numbers: Belden 9505, Belden 9306, Belden 9832

Cable These cables provide acceptable operation for data rates up to 19.2 Kbps

asfollows:
RS-232: 50 feet (15 meters) maximum cable length
RS-422/RS-422: 4000 feet (1200 meters) maximum length. Must not exceed the
maximum RS-422 Common M ode specification of +7V to -7V. Isolation at the remote
end may be used to reduce or iminate Common M ode voltages.

At shorter distances under 50 feet (15 meters), aimaost any twisted pair or shielded twisted
pair cable will work, as long as the wire pairs are connected correctly

When using RS-422/RS-422, the twisted pairs should be matched so that both transmit
signals make up one twisted pair and both receive signals make up the other twisted pair.
If thisisignored, cross-talk resulting from the mismatching will affect the performance of
the communications system.

When routing communication cables outdoors, transient suppression devices can be used
to reduce the possibility of damage due to lightning or static discharge.

Care should be exercised to ensure that all connected devices are grounded to a common
point. Failure to do so could result in damage to the equipment.
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PLC Serial Port

The Series 90 and VersaMax PLC serial port is compatible with RS-422. An RS-232 to
RS-422 converter isrequired to interface to systems that provide RS-232 compatible
interfaces.

The PLC RS-422 serial port provides the physical connection for SNP communication.

The figure below shows the seria port orientation and connector layout for the PLC port.

a43621

©)

00000000

The table below shows the pin numbering and signal assignment:

Pin Number Signal Name Description
1 Shield
2 No Connection
3 No Connection
4 ATCH * Hand-Held Programmer attach signal
5 +5V * +5V Power for: HHP and RS-232/485 Converter
6 RTS(A) Request To Send
7 Signal Ground Signal Ground, OV
8 CTS(B') Clear To Send
9 RT * Terminating Resistor for RD **
10 RD (A") Receive Data
11 RD (B") Receive Data
12 SD (A) Send Data
13 SD (B) Send Data
14 RTS (B) Request To Send
15 CTS(A") Clear To Send

* Signals available at the Connector but are not included in the RS-422 specification.
SD (Send Data) and RD (Receive Data) are the same as TXD and RXD (used in the Series Six PLC).
(A) and (B) arethesameas-and + . A and B denote outputs, and A’ and B’ denote inputs.

B-4
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IBM-AT/XT Serial Port

The IBM-AT, IBM-XT or compatible computer’s RS-232 serial port isa 9-pin D-type
male connector as shown in the figure below.

a44523

IBM-AT/XT
)

O

PIN

10O

—

The following table shows the serid port pin-out:

IBM- IBM-
AT Signal Description XT Signal Description
Pin No. Pin No.
1 DCD |DataCarrier Detect 1 NC
2 RD Receive Data 2 TD Transmit Data
3 TD Transmit Data 3 RD Receive Data
4 DTR |DataTerminal 4 RTS |Request to Send
Ready
5 GND | Signa Ground 5 CTS |Clear to Send
6 NC 6 NC
7 RTS [Request to Send 7 GND |Signa Ground
8 CTS |Clear to Send 8 DCD |DataCarrier Detect
9 NC 9 DTR |DataTerminal
Ready

NC = Not Connected

RS-232/RS-485 Converter

The RS-232/RS-485 Converter (IC690ACC900) can be used to convert from RS-232 to
RS-422/RS-485 communications. The converter has one 15-pin female D-type port, and
one 25-pin female D-type port.

This converter unit can be purchased from GE Fanuc Automation. Please contact any GE
Fanuc Automation sales office or field service representative.

GFK-1670D Appendix B Serial Connections B-5



B

Serial Cable Diagrams

This section shows two serial port connections for Series 90 and VersaMax PLCs.
Cabling may vary, depending on the devices and converter used in your application.

In the point-to-point configuration only two devices can be connected to the same
communication line. The communication line can be directly connected usng RS-232 (50
feet, 15 meters maximum) or RS-485 (4000 feet, 1200 meters maximum). Modems can
be used for longer distances.

RS-232 Point-to-Point Connection

IC690CBL702 OR EQUIVALENT
RS-232
SHIELDED PAIRS

RS-232/RS-422

CONVERTER

(IC690ACC900)

(COMPATIBLE)

RS-232
PORT

[uouune

cococooo
cecocococeoo

MALE

RS-422

TWISTED SHIELDED

PAIRS

244507

connection must be external source.

~
RD 2 2 |10 — (" 0? — bpco(Aa) | 2 2 = (o 0
™ 3 3 |RD =4 0" 00 < pcop (B) 3 ~ ~ 3 — 0‘)
= [,0 0| = = |,0
cTs 8 20 [oR [ 1) 0 0| = ro(E) 11 13 |sD(B) Sl 0
:l 11 = 0 [ 0 0 =1 — 0 0 SERIES
1 — 0 q 0 0 — — 0 0 | 90PLC
T = 0 q 0 0 — — 1 | I**_ == 0 0
[ = o 0y | =ets(a) |15 1 T o |RIs(a) 2|0 | R4
o =, 0| SHersee 8 T T 14 |RTS(B) = |0
FEMALE Vo Sl 04| S risa) 6 ] 1 15 [cts(a) |, 0
1 = |os il 1 T, = |oe
[ 0 0 [ [ 0
= ¢ 0| = ov | 7 * 7 |ov =4
l.L 1 |sHD = ! Q 0 ¢ = U U — ! 0
25-PIN 25-PIN 15-PIN 15-PIN 15-PIN 15-PIN
MALE FEMALE FEMALE MALE MALE FEMALE
PORT PORT
*Power source for point-to-point connection 10 feet (3 meters) only. Converter power source beyond 10 feet (3 meters) and for multidrop
*% . . . . . . .
Termination resistance for the receive data (RD) signal needs to be connected only on units at the end of the lines.
Series 90 PLC products by connecting a jumper between pin 9 and pin 10 inside the 15-pin D-shell with the following exception. For Series 90-70 PLCs,
catalog numbers IC697CPU731 and IC697CPU771, the termination for RD at the PLC is implemented by a jumper between pin 9 and pin 11.
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Multidrop Connections

In the multidrop configuration, the host device is configured as the master and one or

more PLCs are configured as slaves. This method can be used when the maximum

distance between the master and any slave does not exceed 4000 feet (1200 meters). This
figure assumes good quality cables and amoderately noisy environment. A maximum of
8 slaves can be connected using RS-422 in adaisy chain or multidrop configuration. The
RS-422 line must include handshaking and use wire type as specified in the “ Cable and
Connector Specifications’ section.

1C690CBL702 OR EQUIVALENT RS-232/RS-422 RS-422 a44513
RS-232 SHIELDED PAIRS CONVERTER MAKE CONNECTIONS
(IC690ACCI00) INSIDE D-CONNECTORS SLAVE
PIN PIN IN IN TATION
A ~
= (0] ™2 2l B (0 0} <Joco (a) 2 2 = (0
IBMAT =0 rRD| 3 slro B, 0 * o | =<Joco (&) 3 ~ 3 = |,°
(COMPATIBLE) = |4 ° | RTS| 4 5(cts =, Yo| = ro(aA) |10 e 12 |sD(A) | o0 | seriEs
= lo°| cts| 5 20 [DTR = |40 "y| = ro(B) |11 13 |SD(B) |4 9070
RS-232 = |o°| e | 8 :I 1 8 (DcD = |40 Yo| = sp(a) |12 4 10 [RD(A) = |,°
PORT o0 | DR 9 [ =0 'y| =4 so(B) |13 u [rRo(B) P [o%] cpu
)N | 7 1 7 (oD |0 "ol RT| 9 1 9 [RD P 10° | rRs-422
[ = e Yo| otS(A) |18 X TT 6 |RTS(A) = |0° | poRT
f,iz'LNE Fgeﬁﬁe v = | Z : o| ScTs(e) 8 X TT 14 |RTS(B) = |, Z
= ] =
[ 0 ) RTS (A) 6 ] 15 | CTS (A) 0
N e O Y e LT B X5 o= E ey
Vi =0 INES v | s 1 5 [ +5v = |,°
=0 NS o | 7 * 7 7 ov =0
‘OL 1 |SHLD 0 ' = sHp| 1 1 [ SHLD AW
25-PIN 25-PIN 15-PIN 15- PIN 15- PIN 15- PIN
MALE FEMALE FEMALE MALE MALE FEMALE
RS-232 RS-422
PORT PORT LAST
IN TATION
POWER +5V 2 = (0
SOURCE ~ 3 = |o°
'WHEN WIRING RS-422 /485 MULTIDROP CABLES REFLECTIONS ON FOR 12 [SD(A) — 0 o SERIES
TRANSMISSION LINE CAN BE REDUCED BY CONFIGURING THE CONVERTER ov 13 [SD(B) — 0 o 90-30
10 |[RD(A) P [0
MASTER CONVERTER SLAVE LAST STATION 1 |RD(B) | z cPU
[l 9 |RD = [o? ] rsa22
PLC 15-PIN CONNECTOR T 6 |rRrs(a) = |00 | porr
SERIES 90-30 LOCATED T 14 |RTS(B) = |0
q R] u ON POWER SUPPLY 15 |cTs(A) = |0
SERIES 90-70 LOCATED L 8|cts(e) P |,°
R a— ON THE CPU BOARD : : 5 | +5v = z 0
ALSO IT IS RECOMMENDED TO MAKE ANY NECESSARY 7 |ov — 0 o
NSIDE THE CABLE CONNECTOR TO BE MOUNTED ON THE PLC. IT IS L 1 | SHLD = 0o
RECOMMENDED TO USE TERMINAL STRIPS TO OTHER TYPES N J
CONNECTORS ALONG THE LENGTH OF THE TRANSMISSION 15- PIN 15- PIN
TO OTHER PLC's MALE FEMALE
Termination resistance for the receive data (RD) signal needs to be connected only on units at the end of the lines. this termination is made on the
Series 90 PLC products by connecting a jumper between pin 9 and pin 10 inside the 15-pin D-shell with the following exception. For Series 90-70 PLCs,
catalog numbers IC697CPU731 and IC697CPU771, The termination for RD at the PLC is implemented by a jumper between pin 9 and pin 11.
Ground Potential: multiple units, not connected to the same power source, must have common ground potentials
proper operation of this system.
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Miniconverter Kit

This section describes the Miniconverter Kit for use with Series 90 and VersaMax PLCs.

Description of Miniconverter

The Miniconverter Kit (IC690ACC901) consists of an RS-422 (SNP) to RS-232
Miniconverter, a6 foot (2 meter) serial extension cable, and a 9-pin to 25-pin Converter
Plug assembly. The 15-pin SNP port connector on the Miniconverter plugs directly into
the serial port connector on the Series 90-30 and VersaMax PLCs. The 9-pin RS-232 port
connector on the Miniconverter connects to an RS-232 compatible device.

] ' a44985
]

RS-422 RS-232
PORT PORT

o [

When used with an IBM PC-AT, or compatible computer, one end of the extension cable
plugs into the Miniconverter's 9-pin serial port connector, the other end plugsinto the 9-
pin seria port of the computer. The Converter plug (supplied with kit) isrequired to
convert the 9-pin seria port connector on the Miniconverter to the 25-pin serid port
connector on the IBM PC-XT or PS/2 Personal Computer.
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Pin Assignments, RS-232 Port

The pinout of the Miniconverter is shown in the following two tables. Thefirst table
shows the pinout for the RS-232 port. Thedirection of signal flow is with respect to the

Miniconverter.
Pin Signal Name Direction
2 | SD - Send Data Output
3 |RD - Receive Data Input
5 |GND - Ground n‘a
7 |CTS-Clear To Send Input
8 |RTS- Request To Send Output

The pinouts were chosen to allow direct connection (usng a straight through, or 1to 1
cable (as provided with kit) to the IBM PC-AT. Most IBM compatible computers
equipped with an RS-232 port will provide a pinout compatible with the one shown above.

Pin Assignments, RS-422 Port

The following table shows the pinout for the Miniconverter's RS-422 serial port. The
direction of signal flow is also with respect to the Miniconverter.

Pin Signal Name Direction

1 |SHLD - Shidd n/a

5 |+5VDC - Power Input

6 |CTS(A") - Clear To Send Input

7 [GND - Ground n/a

8 | RTS(B) - Request To Send Output

9 | RT - Receive Termination Output
10 | SD(A) - Send Data Output
11 | SD(B) - Send Data Output
12 |RD(A") - Receive Data Input
13 | RD(B') - Receive Data Input
14 | CTS(B") Clear To Send Input
15 |RTS(A) - Reguest To Send Output
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System Configurations

The Miniconverter can be used in a point-to-point configuration as described above, or in
amultidrop configuration with the host device configured as the master and one or more
PLCs configured as daves.

The multidrop configuration requires a straight through (1 to 1) cable from the
Miniconverter's RS-422 port to the first slave PLC's SNP port. Other daves will requirea
daisy chain connection between slaves. A maximum of eight devices can be connected in
an RS-422 multidrop configuration. All of the devices must have a common ground. If
ground isolation is required, you can use the GE Fanuc |solated Repeater/Converter
(IC655CCM590) in place of the Miniconverter.

When using the Miniconverter with amodem connection, it may be necessary to jumper
RTSto CTS (consult the user’s manual for your modem).

Cable Diagrams (Point-To-Point)

When connecting the Miniconverter to IBM PC and compatible computers with hardware
handshaking, the following cable connections should be used:

a44982

PIN PIN

TXD| 2 2 | RXD
RXD| 3 3 | TXD
CTS| 7 7 | RTS
RTS| 8 8 | CTS
GND| 5 5 | GND
1 | DCD

E 6 | DSR

4 | DTR

MINICONVERTER IBM PC-AT
RS-232 PORT 9-PIN
9-PIN CONNECTOR

CONNECTOR
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Miniconverter Specifications

M echanical:
RS-422

RS-232

Electrical and General:

Voltage Supply
Typical Current

Operating Temperature
Baud Rate

Confor mance

Ground Isolation

15-pin D shell male for direct mounting to Series 90 or
VersaMax seria port.

9-pin D shell mae for connection to RS-232 serid port
of aWorkmaster 1| computer or Personal Computer.

+5 VDC (supplied by PLC power supply)

Version A (IC690ACC901A) - 150 mA

Version B (IC690ACC901B) - 100 mA

0to70° C (32t0158° F)

38.4K Baud maximum

ElIA-422 (Balanced Line) or EIA-423 (Unbalanced Line)
Not provided
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Appendix

Use this procedure to transfer your license from one computer to another. Usually, a

VersaPro License Transfer Procedure

floppy disk is used to transfer alicense but anetwork shared directory (write-able by both

machines) can also be used. Inthisexample, afloppy disk isassumed. The floppy disk
does not need to be reformatted.

Step 1. Register Machine (performed on the unlicensed machine)

To start the Register Now! Program, go to the Windows Start menu and choose Programs,

GE Fanuc Software, VersaPro, RegisterNow! Click the Next button on the Wel come
diaog.

GFK-1670D

Welcome ta the VersaPro Register Mowl program,
Thiz program will licenze YerzaPro [Professional
i Edition)] on your computer.

It iz strongly recommended that pow exit &l Windows programs
befare running thiz Setup progran.

Click Cancel to quit Setup and then cloze any programs pou
have mnning. Click Mest o continue with the Setup program.

WARNIMG: Thiz program is protected by copyright law and
international treaties.

Unauthorized reproduction or distibution of this program, or any
portion of it, may rezult in severe civil and criminal penalties, and
will be prozecuted to the masimum extent poszible under law.

Catcel
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C-2

Click the Y es button on the Software License Agreement dialog.

Software License Agreement

“rou can alzo find the license in the file icense. bt

Read theze terms and conditions carefully. Scroll bo make all of the text vizsible,

GE Farnuc Automnation North America, [nc.
YerzaPro Programming Software End User License Agresment

r'ou. as the Customer, agree as follows:

1. DEFINITIONS

partners.

=

“tpplication Software” shall mean the YerzaPro Programming software portion of the
Lizenzed Software. in object code form only, and any other portions of the Licenzed
Saftware, in abject code form only, created by GE Fanuc in azzociation with other

"Designated Computers” shall mean up to two (2] computers upon which customer may
inztall the Licenszed Saoftware provided that the software iz not run an mare than ohe ;_i

Enter es' if pow, on behalf of your company, agres to the terms and conditions of the
Software License Agreement. If not, enter ‘Mo’ and the WerzaPro Register Mol prograrn will

terminate.
< Back Yes

Ho |

Click the Transfer In License button on the License VersaPro dialog.

Licenze VerzaPro

Before you can permanently use YerzaPro, pou

muist license pour system with GE Fanue. 1f you ; 1
hawe newver licensed WersaPro with GE Fanuc, SR

you must proceed with the "Wew License” button,

If you hawve YergaPro already icensed on another
machire, pou can also transfer its licenze to this
machine, However, the ather machine will loze
itz icense. To transfer in an existing YersaPro
license, uze the "Tranzfer In License" button,

<-Back 1

LCancel i
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Click the Register Floppy for Transfer In button on the Transfer In License dialog.

Transzfer In Licenze M= B

‘fou may autharize this system by transfering in the license from an alieady licensed

syztem. After transferring in the license, the donar swstem will be granted a 4 daw trial
licensze.

To transfer in a licenze, follow in sequence the steps below.

1. Reagizter a floppy for transfer in by inzerting a formatted floppy into this system and
selecting "Feqister Floppy for Transfer In'',

Beaqister Floppy for Transfer In I

2. Tranzfer out the licenze to floppy by running Register Mow! o the licensed system,
zelecting "'Transfer Out Licenze", inzerting the registered floppy, and selecting
"Tranzfer Licetse Out to Floppy'. [Dccurs on the licenzed sypztem.]

3. Transzter in the licenze from floppy by inzerting the registered floppy inta the this
systemn and selecting "'Transfer License In from Floppy'.

Tranzfer Autharization In by Floppy I

<-Back I LCancel |

Enter a floppy disk into the floppy drive and click the OK button. (The floppy disk
doesn’t have to be clean.)

Select Path for Register Floppy !

Choose a path to register for license transfer.

Fath:

E Browsze. .. !
Ok, I Cancel !

The following message will appear when the floppy is successfully registered.

Information E3

@ The floppy was successfully registered far licensze transfer.

Mo inzert the tranzter flappy into the licetzed machine and transfer out the license.

The Transfer In License dialog will remain. Do not click any buttons. Proceed to the
licensed machine to perform “ Step 2 — Transfer Out.”
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Step 2. Transfer Out (performed on the licensed machine)

Startup the Register Now! program found under Start->Programs->GE Fanuc Software-
>VersaPro->RegisterNow! Click the Next button on the Welcome dial og.

Welcome

Wielcome to the VersaPro Register Mowl program,
Thiz program will licenze YerzaPro [Standard E dition)
On Your computer,

It iz strongly recommended that pow exit &l Windows programs
befare running this Setup progran.

Click Cancel to quit Setup and then cloze any programs pou
have mnning. Click Mest o continue with the Setup program.

WARNIMG: Thiz program is protected by copyright law and
international treaties.

Unauthorized reproduction or distibution of this program, or any
portion of it, may rezult in severe civil and criminal penalties, and
will be prozecuted to the masimum extent poszible under law.

Catcel |

Click the Transfer License Out by Floppy button on the Transfer Out License dial og.
Transfer Dut License M= B

AVersaPro license already exists on this spstem.

You may autharize an unlicensed system by transferring out this system's license via floppy.
After ransferring out the licenze, thiz system will be granted a 4 day tial license,

T hransfer out a licenze, YersaPro must already be installed on the target syztemn. When
ready, follow in zequence the steps below.

1. Beaizter a floppy for transfer in by running Begister Mow! on the unlicensed system,
zelecting 'Tranzfer In Licenza", inzerting a formatted floppy, and selecting "R egister
Floppy for Transfer In", [Qzcurs on the unlicenszed spstem.)

2. Tranzter out the licenze to floppy by inserting the regizterad floppy inta this spstem
and szelecting ' Tranzfer License Out to Floppy'.

Transfer License Out by Floppy

3. Transfer in the license from floppy by inserting the registered floppy into the
unlicenzed spstem and selecting "'Transfer Licenze In from Floppy". [Decurs on the
unlicenszed system.
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Since we are transferring via a floppy disk, insert the registered floppy disk into the floppy
and click the OK button.

Select Path for License Transfer Dut |
Jg Choosze the path for icense transter.
Path:

IE Browsze... |
] I Cahcel |

Y ou should see one of the following two messages reflecting a successful license transfer
out. Click the OK button.

(Message 1) This message appears when the licensed machine carries only one
license. Thisisthe more common of thetwo. Since the machine' sonly licenseis
transferred out, a4 day trial license is assigned to the machine.
Information E
@ The YerzaPra [Standard Edition] licenze was successfully transferred out to floppy.  This system haz been granted a 4 day tal license.

T'ou have 4 daps to enjoy your new YerzaPro [Standard Edition] product. After the 4 day tial period, pleasze uze the Regizter Mowl tool found
in the GE Fanuc Software'ersaPra progran group ta register and fully license WerzaPro [Standard Edition).

Moy inzert the tranzfer floppy into the unlicensed machine and transfer in the icense,

or

(Message 2) This message appears when the licensed machine contains multiple
licenses and shows how many licenses remain.

Information
@ The WerzaP'ro [Standard Edition] license was successfully transtered out to floppy. [Thiz system haz 49 remaining licenzes. |

Mowe inzert the transfer floppy into the unlicensed maching and transfer in the license.

You arefinished using this machine. Return to the unlicensed machine with the licensed
floppy disk to proceed with “Step 3 — Transfer In.”
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Step 3. Transfer In (performed on the unlicensed machine)

The Transfer In License dialog should till be visible. Click the Transfer Authorization In
by Floppy button.

Transzfer In Licenze M= B

‘fou may autharize this system by transfering in the license from an alieady licensed

syztem. After transferring in the license, the donar swstem will be granted a 4 daw trial
licensze.

To transfer in a licenze, follow in sequence the steps below.

1. Reagizter a floppy for transfer in by inzerting a formatted floppy into this system and
selecting "Feqister Floppy for Transfer In'',

Reagister Floppy for Transfer In

2. Tranzter out the licenze to floppy by running Register Mow! on the licensed system,
zelecting 'Transfer Out Licenze", inzerting the registered floppy, and selecting
"Tranzfer License Out to Floppy”. [Dccurs on the licenzed sypstem.]

3. Tranzter in the licenze from floppy by inzerting the registered floppy inta the this
systemn and selecting "'Transfer License In from Floppy'.

i Transfer Authorization |n by Floppy I

<-Back i LCancel I

Insert the licensed floppy disk into the floppy drive and click the OK button.

Select Path for Register Floppy !
. Choose a path to register for license transfer.
v T
Fath:

E Browsze. .. !
Ok, I Cancel !

The following message indicates a successful license transfer. Click the OK button to exit
the Register Now! program. You are now ready to run your licensed VersaPro product.

Information
C ; 2 ;
1 YerzaPro [Profeszional Edition] has been succeszsfully icenzed.
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Appendix| VersaPro Keyboard Quick Reference Guide

The quick reference card on the next page contains alisting of keyboard shortcuts for
VersaPro commands, as well as other programming tips.
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Cut here

VersaPro™ Programming Software

Quick Reference

To launch/exit VersaPro

CTRL+ALT+V

ALT+F4

CTRL+ALT+R

Launch VersaPro from Windows; Bring
VersaPro into focus.

Exit VersaPro.

Launch Remote 10 Manager (Stand Alone

Hardware Config) from Windows; Bring
Remote I/0O Manager into focus.

To modify the VersaPro wor kspace

F6
SHIFT+F6

ALT+0
ALT+1
ALT+2
ALT+3
ALT+6

ALT+F6
ALT+F7

ALT+F8

ALT+F9
CTRL+T
CTRL+E
CTRL+TAB

CTRL+SHIFT+TAB

To perform folder

Move focus to next bl ock/dockable window.

Move focus to previous block/dockable
window.

Show or hide the status bar.
Show or hide the Folder Browser.

Show or hide the Information Window.

Show or hide the Variable Declaration Table.

Show or hide the Loca Logic Variable
Table.

Arrange windows so they overlap.

Arrange windows as horizonta non-
overlapping tiles.

Arrange windows as vertical non-
overlapping tiles.

Arrange icons a the bottom of the window.
Display the toolbar dialog.

Display the options diaog.

Display next tab/window to the right.
Display next tab/window to the left.

oper ations

CTRL+N
CTRL+O
CTRL+SHIFT+A
F8

CTRL+F8
CTRL+B

ALT+5

ALT+F10
CTRL+F7
F7
ALT+4

Create anew Folder.

Open an existing Folder.

Save an entire Folder.

Backup aFolder to (*.flb).

Restore a Folder from backup (*.flb).
Create anew Ladder/Instruction List block.

Open_MAIN Block; Bring _MAIN into
focus.

Close al open Blocks.

Check selected Block(s).
Check dl Blocks in the Fol der.
Open Hardware Configuration.

To perform general operations

Esc
CTRL+BREAK
DELETE

F1

INSERT
PcUP

PGDN

HoME

END

ALT+BACKSPACE

ALT+ENTER

CTRL+A
CTRL+C
CTRL+INSERT
CTRL+V
CTRL+F3
CTRL+G
CTRL+P
CTRL+S
CTRL+Y
CTRL+Z
SHIFT+DELETE
SHIFT+F1

SHIFT+INSERT

Abort the current operation.

Abort.

Delete the selection.

Display help for the item with focus.
Inserts a row.

Move up apagein the selected editor or
table.

Move down a page in the selected editor or
table.

Move to the top of the selected editor or table.

Move to the bottom of the selected editor or
table.

Undo the last action.

Display properties diaog for selected block
or folder.

Select the entire block or table.
Copy the selection to the Clipboard.
Copy the selection to the Clipboard.
Insert Clipboard contents.
Find/replace the specified item.
Moves to aspecified location.

Print the block that has focus.

Save the block or table that has focus.
Redo the previously undone action.
Undo the | ast action.

Cut the selection to the Clipboard.

Display help for clicked on buttons, menus
and windows.

Insert Clipboard contents.

To perform operationsin the LD editor

CTRL+-
CTRL++
CTRL+=
ALT+F3
CTRL+¢
CTRL+—
CTRL+T
CTRL+

Decrease font size.

Increase font size.

Increase font size.

Navigeate to the next coil.

Draw/erase horizonta shunt to the left.
Draw horizonta shunt to the right.
Draw vertica shunt up.

Draw vertica shunt down.

Click right mouse button and drag to target location

Connect two cells with awire.



Toperform operationsinthe LD and IL editors

F2 Toggle edit mode off/on.

F3 Find next item of defined search criteria
CTRL+F10 Find specified item in blocksin fol der.
CTRL+F11 Gotovariablein Variable Declaration Table.
« Move left by cell.

- Move right by cell.

T Move up by cell.

I Move down by cell.

SHIFT+¢ Increase/decrease selection areato |eft.
SHIFT+T Increase/decrease selection areato right.
SHIFT+— Increase/decrease selection area up.
SHIFT+H Increase/decrease selection area down.
HoMmE If edit mode s off, focus movesto the current row's first

cell the first time Home s pressed. Pressing Home again
moves focus and to the entire rung.

If edit mode is oninthe current cell, the cursor movesto
theleft of the first character in the field.

END If edit mode s off, focus moves to the current row's last
occupied cell the first time End is pressed. Pressing End
again, moves focus to the row's | ast cell.

If edit mode is oninthe current cell, the cursor movesto
theright of thelast character in the field.

CTRL+HOME Moveto the first row's first cell.
CTRL+END Movesto the last row's first cell.
TAB Moveto right one cell.
SHIFT+TAB Moveto left one cell.

ENTER on an empty cell
The Instruction dropdown list is activated. As you type
the instruction mnemonic, VersaPro sorts the possible
instructions for the specified | ocation.

ENTER on acell that contains an instruction or operand
The Variable dropdown list is activated. As you type the
Variable name, VersaPro sorts the possible vari ables that
arevalid for this context. If theinstructionis acomment,
itis placed in Edit mode.

SHIFT+ENTER on acell that contains an instruction or operand
The Instruction dropdown list is activated. As you type
the instruction mnemonic, VersaPro sorts the possible
instructions for the specified | ocation.

SPACEBAR Toggle selection on/off.

CTRL+SPACEBAR Toggle selection on/off.

DELETE Delete the selection.

CTRL+ENTER Exits acomment that has been placed in Edit

mode.

<Instruction Mnemonic>, <Variable Name>
Enter an instruction and variable name at the same time.
i.e. “NOCON , DiscreteVarOne.”

<Instruction Mnemonic>, <Variable Name>, <Reference Address>
Enter an instruction and define a variable name a the
sametime. i.e. “NOCON , DiscreteVarTwo, %l 12"

<Instruction Mnemonic>, <Variable Name>, <Reference
Address>, <Scope>
Enter an instruction and define a variable name a the
sametime, including variable scope (G = Globd, L =
Locd). i.e. “NOCON , DiscreteVarTwo, %l 12, G

% <Reference Type>  Specify the next available PLC reference
address. i.e. “%M”

To change a selected variabl€ s on-line value
in LD Editor, IL Editor, RVT, and VVT

F10 Write avalueto avariable.

F11 Override adiscrete variable or reference
address.

F12 Toggle adiscrete variable or reference
address.

To perform operations with the connected PLC

F9 Connect to a specific PLC.
CTRL+F9 Disconnect from PLC.
ALT+F2 Store this folder to PLC.
CTRL+F2 Load from PLC into this folder.
F4 Verify this folder with PLC.
F5 Place the PLC in Run Mode.
CTRL+F5 Place the PLC in Stop Mode.
SHIFT+F4 View PLC status.

ALT+V, ALT+N, ALT+L
Set Monitor Active for All Blocks.

ALT+V, ALT+N, ALT+A
Set Monitor Active for Active Block.

ALT+V, ALT+N, ALT+O
Set Monitor Off.

To change a selected variabl€ s data display for mat
in LD Editor, IL Editor, RVT, or VVT

CTRL+SHIFT+B

Display the value in binary format.

CTRL+SHIFT+D Display the value in signed decimal format.

CTRL+SHIFT+H Display the value in hex format.

CTRL+SHIFT+O Display the valuein octd format.

CTRL+SHIFT+R Display the valuein red format.

CTRL+SHIFT+S Display the value in scientific notation

format.

CTRL+SHIFT+U Display the valuein decima format.
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#

HHHHE
view tables[8-2]8-3]

_MAIN,[3-1]
9

90-30 Rack
configuring,[7-8]

90-70 Rack
configuring,[7-8]

A
Abbreviations[1-4]

Accessing Hardware
Configuration,[7-2]
Adding elementsto a View
Table[8-8]
Address
completingi nditor,
completingin LD Editor,{4-9 |
Advanced User Parameters,

EGD (CPUEO5)

format,|7-41 |
Associated device[10-2 |
Audit Trail mode

configuring log view[7-48 ]

setti ng,
Auto Backup o)

setting number of,
Auto Correct,[7-6 |
Autoconnect options

setti ng,

B

Backing up afolder [2-18 ]
Bases (VersaMax

configuring,
power supply booster,[7-21 |

Bitmap
copy as,
GFK-1670D

Block language
setting default,[1-6 ]
Block logic
converting[3-21]3-22 |
Block properti-$
viewing,
Block size, maximum,[3-7]
Blocks
_MAIN,[31]
arranging in browser [3-8]
changing order,[3-9]
dosing,
copying between folders[3-5]
deleting,[3-12 |
inserting,
| ocating names, addresses, or
cal| statements[3-17 |
opening,|3-6
saving{3-13 |
Bool ean expressions
nesting,5-17
Browser [2-13
Built-in functions

IL editor[5-13]

Cable and connections for
serial port,[B-3]
Cable diagrams, seria
connection,[B-6 |
Cam blocks
creating,|9-15
deleting,|9-15

renamin
Cam Editor,
ingdling,
Cam profiles

example,;
using in a Motion program,

Carriers (VersaMax
configuring,|7-21 |
deleting[7-23

power supply booster[7-21 |
Catalog numbers, converters

1C655CCM590) B-10
IC690ACC900,|B-5

Index-1
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IC690ACC901,[B-8]
CCU. . See Communications

Configuration Utility
Changing rack type,
Checking Blocks,
Clearing the rack

Series 90-30/90-70[7-11 |
VersaMax [7-23 ]
Clearing the Variable

Declaration Table[6-13
Closing blocks[3-13]
Comment column

IL editor,[5-2]
Comments

setting full or brief,[1-6 ]
Communications

connecting to aPLC|10-4 |
modem connection, 10-12
multidrop connection,{10-7

RIO rack,[7-29 |
serid direct|10-4 |
TCP/IP connection,[10-9 |
Communications
Configuration Utility
opening[10-2 |
overview,|10-2
password,10-2
Compacting the VDT | 6-14 |
Completing function block
parameters[4-11 |
Completing ingtruction
parameters[5-5 |
Configuration
NIU,
Series 90 Micro,
Seri esﬁ% or Series 90-70,
7-8
VersaMax expansion

networks,
VersaMax modular rack,

VersaMax Nano/Micro[7-43 |
VersaMax Remote /O rack,
Configuring VersaMax
Modules[7-22 ]
Connect Timeout
modem communications,
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withM odemaround
Ti me-lo-s
Connecting to aPLC[10-4 |
Congtants
assigning to function block
parameters,
[IL kditor,
rules|4-14 §5-7
Context-sensitive Menu,| 2-15 |
Converters
IC690ACC900,|B-5
IC690ACC901,|B-8
1C690CCM590/)B-10 |

RS-232/RS-485[B5
Converting Blocks|3-21][3-22 |
guidelines) 3-22

Converting logic
90/30VersaM ax to 90-70,
90-70 to 90/30VersaMax,

Converting Rack Systems,

7-52

Copy as bitmap,[4-16 |

CPU firmwarerevision

checking[1-10 |

CPU modd checking

CPU Redundancy,|[7-14 |

CPU, configuring

series 90-30/90-70,
VersaMax,

Creating a New Folder,
based on VersaPro folder,
Creating and modifying
variables,
Cresting New
Reference/Variable View
Tables[8-4]

Cross-reference of variables
creating,|6-14 |
coM[215]
Customizing display
IL editor,
LD editor
view table format,|8-7
Customizing View Tables[8-5 |
Cut, Copy, Paste

IL editor,{5-8 |
LD editor|4-16 |
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using in the variable
declaration table,[6-8]
view tables|8-10 |

D

DATA_INIT functions
properties[4-10 ]
Date and time
viewing and changing[10-25 |
Default rack type,
Deleting
in LD editor,|4-17
Deleting blocks,3-12
Deli ni Carriers (VersaMax),

Deleting rack modules (Series
90-30/90-70),|7-11 |
Deleting rack modules
(VersaMax) [ 7-23 |
Deleting variables6-12 |
Device, CCU
configuring)10-7 |
DEFAULT,|10-4
Differences in language
capability
90-70 vs. 90-30/VersaMax,
Direct serial port connection,
Display format, changin
monitored |ogi c,| 10-28
Reference View Tables,|8-6 |
Variable View Tables,|8-7
Display options

setting[1-7]
Docking,|2-16

E

Editing Ladder Logic,[4-15 ]
EGD. See Ethernet Global
Data
Empty row
inserting,[4-17 |
ENO

usingin[IL fditor [5-18 ]
Error checking
1L pditor,[5-19 |

GFK-1670D Index

Error color
setting,[7-7]
Ethernet Global Data
advanced user parameters,
-7-41
configuration[7-33 |
configuring interface adapter
name|[7-34 |
name resol ution and routing
teble[7-34]

PLC timing considerations,

restoring,
setting aliases|7-34 |
Ethernet interface adapter
name[7-34]
Expans on networks,
VersaMax
configuring[7-23 ]
Expanson Racks (Series 90-
30/90-70)
configuring,
Exporting Variables|6-17 |
EZ Program Store| 10-23 |

F

Fault details|11-3
Fault Tables|11-1
clearing|11-5

Find in blocks|3-17 |

Find/Replace3-18 |

Finding program rung, row or
variable[3-16 |

Firmware revision checking,
[1-10]

Flash memory, 10-22
Folder components,
changing order,
Folders
backing up and restoring,
creating,
creating based on existing
VersaPro fol der,
names[2-11 |
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properties|2-22 |
Font

changing in IL Editor[5-3]
Footer, custom,
Format Reference Table,[8-6
Format switches

custom header/footer,[2-25 |
Function Address,[4-5]

Function block parameters
completi ng,
Function blocks
IL editor|5-12 |
LD edito
Function Data Length,
Function properties,[5-5
Function toolbar
compact,|4-6 |

expanded,
Functions

built-in[5-13 |
IL editor|5-12 |
LD editor,|4-5

Functions properties,|4-9)J4-10 |

G

General options
setting,[1-5]
Genius bus configuration,7-12 |
GoTo,
Go Tovariable
locating variablesin the
VDT,[67]

H

accessi ng,l 7-2 |
converting rack stems,| 7-52 |

reference view,| 7-47
setting options,|7-7
shortcut keys,|7-6

synchronizing VersaPro with,
tool bar,

Header, custom,[2-25 |

High speed counter
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Series 90 Micro[7-46 |
VersaMax Nano/Micro
Highest references used,|6-14 |

/0 Fault Table[11-1 |
IBM-AT/XT serial port,[B-5 |
IL editor
built-in functions[5-13 |
IL Editor
customizing displ ay,
entering instructions,|5-4
nesting Boolean expressions,
i
IL instructions
entering,[5-4]
IL language
overview,[5-9]
Importing Variables|6-15 |
Information window,[ 2-13,|
Inserting an empty row.[4-17 |
Inserting objects,
Ingalling

Cam Editor9-13 |
VersaPro,

Ingtruction column

IL editor,[5-2]
Ingtruction List Editor

overview,[52]
Ingtruction parameters
completingin IL editor,[5-5]
Ingructions
entering in IL Editor,
entering in LD Editor,
parameters,[4-5]
selectingin IL editor [5-4]

K

Keyboard entr
LD editor,

Keyboard shortcuts
HWC,
VersaPro,
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L

Labe column
IL editor,[5-2]
Ladder display options

customizi ng,
Ladder Logic
editing,[4-15 |
Language differences
90-70 vs. 90-30/VersaMax,
LD Editor
customizing options,|4-3
entering ingructions,|4-5
overview,|4-2
LD functions
toolbar,[4-6
LD Functions
toolbar,[4-7]
LD instructions
entering using keyboard,
entering using tool bar,
LD Ingructions
data length,|[4-5 |
entering,
function addr&ss
LD BOOL,

LDN_BOOL |59
Length
completingi nditor,
completingin LD Editor,{4-9 |
License
transferring,[C-1]
Load/Store/Verify RIO
configuration[7-29 |
Loading
folder from PLC
RIO configurati o
VersaMax hardware

configurations) 7-27 |
Local Logic editor,|9-6 |
Local Liic Variable Table,

9-7
Locked blocks
importing from Logicmaster,
23]
Locking
GFK-1670D Index

blocksﬂ
folder,|2-19 |

Log filesize, setting,[7-7]
Log View

hardware configuration,
Logic editor wi ndow,
Logicmaster 90-70, before
release 6

importing a folder,[2-7]

M

Maximum block size[3-7]
Memory

EZ Program Store
flash memory,10-22 |
Menu bar and toolbars|2-13 |

Menus

HWCJA-12 |

VersaPro|A-1
Miniconverter kit

cable diagrams[B-10 |

RS-232 port pin assgnments,

RS-422 (SNP) to RS-232,
RS-422 port pin assgnments,

system configuration
Modem connections) 10-12

Modem Turnaround Time,

10-3[[10-13
Modems

configuration and cabling,
10-12
Modules

Series 90-30/90-70,[7-10 |
VersaMax,| 7-22 |

Monitoring logic
Motion Program editor,
Moation Program/Local Logic
blocks
restori ng,
Motion Program/Local Logic
options-
setting,|9-2 |
Multidrop connections[B-7 |
Multipleinstances of
VersaPro,|1-3
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N

Name Resolution
restoring[7-41 |

Name Resolution and Routing
Table configuration,ﬁ

Nesting Bool ean expressions,

New Reference View Table,
8-4

New Variable View Table,

Next reference assignment,|7-7

NIU
configuring[7-28 ]

O

Objects

inserting,
Online usetables, creating,
Online viewing

view tables|8-14
Opening bl ock
Operand column

IL editor,[5-2]
Operators

validin IL editor,[5-9]
Options

automatic folder backup,

communications[1-8]

display,[1-7]J8-5

generd,[1-5

hardware configuration,

ingruction list,|5-3

|adder, 4-3

Motion Program/Local
Logi

Motion/Local Logic[1-13]

VersaPro,[1-5]

Overridereference

reference view tables,
Overrides

searching for) 10-29
Overwrite warning,
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P

Parameter Editor
editing ti ps,
error color,
using[7-3]
Parameter view
(tabbed/spreadsheet) [7-7
Passwords
folder [2-19]
Paste
LD editor,[4-17 |
PLC
configuring, 7-19)[7-43,]

run/stop mode[10-26 |
PLC communication
connecting,[10-4 |
direct seria port connection,
104
PLC Fault Table|11-1
PLC statusinformation
Point-to-point RS-232
connections|[B-6 |
Power supply
series 90-30/90-70,[7-9]
Power Supply (Series 90-30)
configuring,[7-9]
Power Supply (VersaMax)
configuring[7-22 ]
Power Supply Bases

(VersaMax
adding|7-21 |
Power Supply Booster Bases

configuring[7-21 ]
Printing
custom header/footer [2-25 |
Hardware Configuration,
reports from VersaPro[2-23 |
Program overwrite warning,

Properties

blocks,|3-8
folder,
function,

Pulse train output
Series 90 Micro[7-46 |
VersaMax Nano/Micro[7-44 |
Pulse width modulation
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Series 90 Micro,| 7-46 |
VersaMax Nano/Micro[7-44 |

Q

Quick reference,[D-1]
R

Rack modules (Series 90-

Rack modules (VersaMax)
deleting| 7-23 |

Rack type
default,[1-6]

Rack type (Series 90-30/ 90-
70)
changing,[7-8]

Rack, clearing

Series 90-30/90-70,

VersaMax,?
Real-time updates) 10-27
Red0,| 3-14 |
Redundancy
CPU, basic[7-14
Reference Address column
1L bditor,
Reference View
hardware configuration,
Reference View Tables
adding an address[8-9]
changing display format,[8-6]
conversion,
creating new,
overview,|8-3
Remote ethernet interfaces
setting aliases|[7-34 |
Remote |/O

communications,
configuring,
load/store/verify,

Request Timeout
for serid communications,
modem communications,
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with Modem Turnaround
Time,

Reserved words,
Reset

parameters,[7-5
Restoring
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